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Preface

ABOUT THIS REFERENCE GUIDE

The HAP Quick Reference Guide provides instructional information for users of Carrier’s Hourly
Analysis Program (HAP). It describes how to use key features of the user interface, and how to use the
program to design HVAC systems and estimate annual energy costs. This Guide also contains program
tutorials, example problems and discussions of common applications. The Guide serves as a supplement
to the program's on-line help system which provides additional information including descriptions of all
input items, program reports and program calculation procedures.

ABOUT HAP

Carrier’s Hourly Analysis Program (HAP) is a computer tool which assists engineers in designing HVAC
systems for commercial buildings. HAP is two tools in one. First it is a tool for estimating loads and
designing systems. Second, it is a tool for simulating building energy use and calculating energy costs.
HAP uses the ASHRAE-endorsed transfer function method for load calculations and detailed 8,760 hour-
by-hour simulation techniques for the energy analysis.

This program is released as two separate, but similar products. The “HAP System Design Load” program
provides system design and load estimating features. The full “HAP” program provides the same system
design capabilities plus energy analysis features. This Quick Reference Guide deals with both programs.
Throughout, those features that apply only to the full HAP program will be noted.

WHAT THIS REFERENCE GUIDE CONTAINS
The HAP Quick Reference Guide is divided into six chapters and four appendices:

o Chapter 1 (Getting Started) discusses basic program concepts - how to use HAP to design systems
and run energy analyses, how to operate the program, how to work with projects and perform
common tasks.

o Chapter 2 (HAP Tutorials) provides step-by-step instructions for using the program to design
systems and run energy analyses. These tutorials are designed for readers who are already familiar
with HAP terminology and concepts, as well as operating principles for Windows software.

o Chapters 3 & 4 (Example Problems) contain two simple example problems illustrating how the
software is used to design an HVAC system and how it is used to run an energy analysis.

o Chapters 5 & 6 (“Applications™) provide a series of short discussions on how to use HAP to design
common types of HVAC systems and how to run energy analyses for common equipment types.

o Appendix A (“Performing Common Tasks with HAP”) contains step-by-step procedures for
performing common tasks in HAP such as entering data, editing data and generating reports.

+ Appendix B (“Performing Common Project Management Tasks™) provides short descriptions of
procedures used to work with project data.

« Appendix C (“Index”) contains an index for this manual.
« Appendix D (“Input Sheets”) provides input forms for space data.

All information in this Guide is also available in the HAP on-line help system. The on-line help system
also includes extensive information about program inputs, reports and calculation procedures.
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Chapter 1 Getting Started

The chapter explains what Carrier’s Hourly Analysis Program does, how to use the software to design
HVAC systems and estimate annual energy costs, and how to operate the software. We encourage you to
browse or read this chapter before using HAP.

1.1 WELCOME TO THE HOURLY ANALYSIS PROGRAM

Welcome to HAP. Welcome to Carrier’s Hourly Analysis Program (HAP). HAP is a computer tool
which assists engineers in designing HVAC systems for commercial buildings. HAP is two tools in one.
First it is a tool for estimating loads and designing systems. Second, it is a tool for simulating energy use
and calculating energy costs. HAP uses the ASHRAE-endorsed transfer function method for load
calculations and detailed 8,760 hour-by-hour energy simulation techniques for the energy analysis.

This program is released as two similar, but separate products. The “HAP System Design Load” program
provides the system design and load estimating features. The full “HAP” program provides the same
system design capabilities plus energy analysis features. This Quick Reference Guide deals with both
programs. Throughout, those features that only apply to the full HAP program will be noted.

HAP System Design Features. HAP estimates design cooling and heating loads for commercial
buildings in order to determine required sizes for HVAC system components. Ultimately, the program
provides information needed for selecting and specifying equipment. Specifically, the program performs
the following tasks:

Calculates design cooling and heating loads for spaces, zones, and coils in the HVAC system.
Determines required airflow rates for spaces, zones and the system.

Sizes cooling and heating coils.

Sizes air circulation fans.

Sizes chillers and boilers.

HAP Energy Analysis Features. HAP estimates annual energy use and energy costs for HVAC and
non-HVAC energy consuming systems in a building by simulating building operation for each of the
8,760 hours in a year. Results of the energy analysis are used to compare the energy use and energy costs
of alternate HVAC system designs so the best design can be chosen. Specifically, HAP performs the
following tasks during an energy analysis:

Simulates hour-by-hour operation of all heating and air conditioning systems in the building.
Simulates hour-by-hour operation of all plant equipment in the building.

Simulates hour-by-hour operation of non-HVAC systems including lighting and appliances.

Uses results of the hour-by-hour simulations to calculate total annual energy use and energy costs.
Costs are calculated using actual utility rate features such as stepped, time-of-day and demand
charges, if specified.

o Generates tabular and graphical reports of hourly, daily, monthly and annual data.

If you have questions about the program: In the United States or Canada, please call 1-800-253-1794. In
other countries, please contact your local Carrier sales office or local Carrier distributor.
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1.2 USING HAP TO DESIGN SYSTEMS AND PLANTS

This section briefly describes, in conceptual terms, how to use HAP to design systems and plants.
Application of these concepts will be demonstrated both in the HAP tutorial in Chapter 2 and in the
example problem in Chapter 3. All design work requires the same general five step procedure:

1. Define the Problem. First define the scope and objectives of the design analysis. For example, what
type of building is involved? What type of systems and equipment are required? What special
requirements will influence system features?

2. Gather Data. Before design calculations can be performed, information about the building, its
environment and its HVAC equipment must be gathered. This step involves extracting data from
building plans, evaluating building usage and studying HVAC system needs. Specific types of
information needed include:

o Climate data for the building site.

o Construction material data for walls, roofs, windows, doors, exterior shading devices and floors,
and for interior partitions between conditioned and non-conditioned regions.

o Building size and layout data including wall, roof, window, door and floor areas, exposure
orientations and external shading features.

o Internal load characteristics determined by levels and schedules for occupancy, lighting systems,
office equipment, appliances and machinery within the building.

« Data concerning HVAC equipment, controls and components to be used.

3. Enter Data Into HAP. Next, use HAP to enter climate, building and HVAC equipment data. When
using HAP, your base of operation is the main program window (described in greater detail in Section
1.4). From the main program window, first create a new project or open an existing project. Then
define the following types of data which are needed for system design work:

a. Enter Weather Data. Weather data defines the temperature, humidity and solar radiation
conditions the building encounters during the course of a year. These conditions play an
important role in influencing loads and system operation. To define weather data, a city can be
chosen from the program's weather database, or weather parameters can be directly entered.
Weather data is entered using the weather input form.

b. Enter Space Data. A space is a region of the building comprised of one or more heat flow
elements and served by one or more air distribution terminals. Usually a space represents a single
room. However, the definition of a space is flexible. For some applications, it is more efficient
for a space to represent a group of rooms or even an entire building.

To define a space, all elements which affect heat flow in the space must be described. Elements
include walls, windows, doors, roofs, skylights, floors, occupants, lighting, electrical equipment,
miscellaneous heat sources, infiltration, and partitions.

While defining a space, information about the construction of walls, roofs, windows, doors and
external shading devices is needed, as well as information about the hourly schedules for internal
heat gains. This construction and schedule data can be specified directly from the space input
form (via links to the construction and schedule forms), or alternately can be defined prior to
entering space data.

Space information is stored in the project database and is later linked to zones in an air system.

c. Enter Air System Data. An Air System is the equipment and controls used to provide cooling
and heating to a region of a building. An air system serves one or more zones. Zones are groups
of spaces having a single thermostatic control. Examples of systems include central station air
handlers, packaged rooftop units, packaged vertical units, split systems, packaged DX fan coils,
hydronic fan coils and water source heat pumps. In all cases, the air system also includes
associated ductwork, supply terminals and controls.

To define an air system, the components, controls and zones associated with the system must be
defined as well as the system sizing criteria. This data is entered on the air system input form.
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d. Enter Plant Data. A Plant is the equipment and controls used to provide cooling or heating to
coils in one or more air systems. Examples include chiller plants, hot water boiler plants and
steam boiler plants.

This step is optional; it is only required if you are sizing chiller or boiler plants. To define a plant
for design purposes, the type of plant and the air systems it serves must be defined. This data is
entered on the plant input form.

4. Use HAP to Generate Design Reports. Once weather, space, air system and plant data has been
entered, HAP can be used to generate system and plant design reports.

To generate design reports, go to the main program window and select the desired air systems or
plants. Next choose the “Print/View Design Data” menu bar option, toolbar button, or pop-up menu
option. For systems this displays the System Design Reports form; for plants this displays the Plant
Design Reports form. Select the desired report options on this form. If calculations are needed to
supply data for these reports, the program will automatically run the calculations before generating
the reports. If all the data needed for the reports already exists, reports are generated immediately.

5. Select Equipment. Finally, use data from the reports you generated to select the appropriate cooling
and heating equipment from product catalogs or electronic catalog software. System and plant design
reports provide information necessary to select all the components of your HVAC system including
air handlers, packaged equipment, supply terminals, duct systems, piping systems and plant
equipment.

Carrier can provide a wide variety of electronic catalog computer programs to make selecting
equipment quick and easy. Please contact your local Carrier sales office or Carrier distributor for
details.

1.3 USING HAP TO ESTIMATE ENERGY USE AND COST

This section briefly describes, in conceptual terms, how to use HAP to estimate annual energy use and
energy cost for a building. Application of these concepts will be demonstrated both in the HAP tutorial in
Chapter 2 and in the example problem in Chapter 4. All energy analysis work requires the same general
five step procedure shown below. Note that certain steps are identical or similar to those used for system
design in section 1.2. If a system design has already been performed for a building, all of the data entered
for design can be reused for the energy analysis, and this significantly reduces the effort needed to
complete the energy analysis. Note that energy analysis features are only available in the HAP program
and not in HAP System Design Load.

1. Define the Problem. First define the scope and objectives of the energy analysis. For example, what
type of building is involved? What type of systems and equipment are required? What alternate
designs or energy conservation measures are being compared in the analysis?

2. Gather Data. Before energy simulations can be run, information about the building, its environment,
HVAC and non-HVAC equipment, and its energy prices must be gathered. This step involves
extracting data from building plans, evaluating building usage, studying HVAC system needs and
acquiring utility rate schedules. Specific types of information needed include:

o Climate data for the building site.

o Construction material data for walls, roofs, windows, doors, exterior shading devices and floors,
and for interior partitions between conditioned and non-conditioned regions.

o Building size and layout data including wall, roof, window, door and floor areas, exposure
orientations and external shading features.

o Internal load characteristics determined by levels and schedules for occupancy, lighting systems,

office equipment, appliances and machinery within the building.

Data for HVAC equipment, controls and components to be used.

Data for chilled water, hot water and/or steam plants, if applicable.

Data for non-HVAC energy- consurnmg equipment.

Utility rate information for electric service and any fuel sources used in the building.
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3.

Enter Data Into HAP. Next, use HAP to enter data for the analysis. When using HAP, your base of
operation is the main program window (described in greater detail in Section 1.4). From the main
program window, first create a new project or open an existing project. Then define the following
types of data which are needed for energy analysis work:

a.

Enter Weather Data. Weather data defines the temperature, humidity and solar radiation
conditions the building encounters during the course of a year. These conditions play an
important role in influencing loads and system operation throughout the year. Both design and
simulation weather data are needed. To define design weather data, a city can be chosen from the
program's weather database, or weather parameters can be directly entered. Simulation weather is
selected by loading a simulation weather file from the library provided with the program. This
step is also used to define the calendar for your simulation year. All three types of data are
entered using the weather input form.

Enter Space Data. A space is a region of the building comprised of one or more heat flow
elements and served by one or more air distribution terminals. Usually a space represents a single
room. However, the definition of a space is flexible. For some applications, it is more efficient
for a space to represent a group of rooms or even an entire building.

To define a space, all elements which affect heat flow in the space must be described. Elements
include walls, windows, doors, roofs, skylights, floors, occupants, lighting, electrical equipment,
miscellaneous heat sources, infiltration, and partitions.

While defining a space, information about the construction of walls, roofs, windows, doors and
external shading devices is needed, as well as information about the hourly schedules for internal
heat gains. This construction and schedule data can be specified directly from the space input
form (via links to the construction and schedule forms), or alternately can be defined prior to
entering space data.

Space information is stored in the project database and is later linked to zones in an air system.

Enter Air System Data. An Air System is the equipment and controls used to provide cooling
and heating to a region of a building. An air system serves one or more zones. Zones are groups
of spaces having a single thermostatic control. Examples of systems include central station air
handlers, packaged rooftop units, packaged vertical units, split systems, packaged DX fan coils,
hydronic fan coils and water source heat pumps. In all cases, the air system also includes
associated ductwork, supply terminals and controls. In the case of packaged DX, split DX,
electric resistance heating and combustion heating equipment, the system also encompasses this
DX or heating equipment. For example, when dealing with a gas/electric packaged rooftop unit,
the "air system" includes the DX cooling equipment and the gas heating equipment.

To define an air system, the components, controls and zones associated with the system must be
defined as well as the system sizing criteria. For energy analyses, performance information about
DX cooling equipment and electric and combustion heating equipment must also be defined. All
of this data is entered on the air system input form.

Enter Plant Data. A Plant is the equipment and controls used to provide cooling via chilled
water or heating via hot water or steam to coils in one or more air systems. Examples include
chiller plants, hot water boiler plants, steam boiler plants and remote source cooling and heating
plants.

This step is optional; it is only required if chilled water, hot water or steam plants are used in your
building. To define a plant for energy analysis purposes, the type of plant and the air systems it
serves must be defined along with its configuration, controls and distribution system information.
This data is entered on the plant input form.

When working with chiller plants, the individual chillers and cooling towers (if used) must be
defined prior to entering plant data.

When working with hot water or steam boiler plants, the individual boilers must be defined prior
to entering plant data.

1-4
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e. Enter Utility Rate Data. Utility rate data defines the pricing rules for electrical energy use and
fuel use. An electric rate structure must be defined for all energy studies. One fuel rate for each
non-electric fuel source must also be defined. Electric rate data is entered using the electric rate
form. Fuel rate data is entered using the fuel rate form.

f. Enter Building Data. A Building is simply the container for all energy-consuming equipment
included in a single energy analysis case. One Building is created for each design alternative
being considered in the study. Building data consists of lists of plants and systems included in
the building, utility rates used to determine energy costs and data for non-HVAC energy or fuel
use. Data is entered using the building form.

4. Use HAP to Generate Simulation Reports. Once all input data has been entered, HAP can be used
to generate simulation reports.

To generate building simulation reports, go to the main program window and select the desired
buildings. If data for a single building is being evaluated, select only one building. If energy use and
costs for a number of alternatives is being compared, select a group of buildings. Next choose the
“Print/View Simulation Data” option on the Reports Menu. This displays the Building Simulation
Reports Selection dialog. Choose the desired reports. Then press Preview to display the reports or
press Print to directly print the reports. If system, plant or building calculations are needed to supply
data for your reports, HAP will automatically run these calculations first. Otherwise, if no
calculations are needed the reports will be generated immediately.

Simulation reports for individual air systems and plants included in your analysis can also be
generated. Use the same procedure but select air system or plant items instead. System and plant
simulation reports provide more detailed performance information for individual pieces of equipment.
They are often useful for learning about equipment performance and for troubleshooting unexpected
results.

5. Evaluate Results. Finally, use data from the simulation reports you generated to draw conclusions
about the most favorable design alternative. In many cases energy use and energy cost data will be
used for further study of lifecycle economics.
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1.4 WORKING WITH THE HAP MAIN PROGRAM WINDOW

This section discusses HAP’s main program window which appears when you start the program. Much
of the work you will perform entering data and generating reports is done using features of the main
program window. Key elements and features of the main program window are discussed below.
Appendix A explains how to use these features in greater detail. The HAP tutorials in Chapter 2 and the
example problems in Chapters 3 and 4 also illustrate how features are used when designing systems and

simulating energy use.

#d HAP41 - [Example Problem]

Project Edit  Wiew Reports Help

Title Bar

Menu Bar Toolbar

DEHmERE =X B

= L

m Example Problem Space | Floor Area |
‘Ej eather &l <Mew default Spaces
|} opaces &0 D101 - Typical Classroom 907.5
18] Spstems & D104 - Classroom 307 5
% EEE;QS & D105 - South Vestibule 730
5B Project Libraries 0l D106 - Classroom 907.5
L Sohedules &l 0107 - Classroom 907.5
B Wall &l 0102 - Music Room 1781.0
&5 Flooks fE@ll 0109 - Practice Foom 55.0
..... ] windaws B 0110 - Storage Room 120.0
..... [ Doors gl 0111 - Office 174.0
..... & Shades &l D112 - West Vestibule B8.0
- §8h Chillers &l 0113 - west Coridar 1054.0
% Cooling Towers @ 0114 - South Cormdaor 920.0
----- B Eoilers
----- % Electric Fates
----- ™ Fuel Rates

N

|Ready \

N\

(4122002 [0559PM

Tree View Pane

top to bottom in Figure 1.1:

\— List View Pane Status Bar

Figure 1.1 The HAP Main Program Window

The HAP main program window consists of six components used to operate the program. Working from

1. The Title Bar lists the program name and the name of the current project. If you are running HAP
System Design Load or are running the full HAP but in System Design mode, the program name will

be "HAP System Design Load".

If you are running the full HAP program with energy analysis

features turned on, the program name will simply be "HAP". At the right-hand end of the title bar are
command buttons for minimizing and maximizing the program window and for exiting from the

program.

2. The Menu Bar lies immediately below the title bar. The menu bar contains five pull-down menus
used to perform common program tasks. To use menu options, first click on the menu name to “pull-
down” its list of options. Then click on the name of the desired option. The five pull down menus

are as follows:
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o The Project Menu provides options for manipulating project data. This includes tasks such as
creating, opening, saving, deleting, archiving and retrieving projects. Section 1.7 and Appendix
B discuss projects in greater detail.

o The Edit Menu contains options used to work with individual data items such as spaces, systems,
walls, roofs, etc... Appendix A provides more information about how options on the Edit Menu
are used to perform specific tasks.

o The View Menu offers options used to change the appearance of the main program window.
This includes changing the format of data shown in the list view, turning on or off the toolbar and
status bar, and setting user preferences such as units of measure. For HAP users, an option is also
provided for switching between full HAP and HAP System Design Load modes of program
operation. This feature is used for projects which only require system design. In these cases, it is
sometimes useful to simplify program operation by temporarily turning off the energy analy51s
features.

o The Reports Menu provides options for generating reports containing input data, design results
and energy simulation results (HAP users only). Appendix A describes how these menu options
are used in greater detail.

o The Help Menu contains options used to launch HAP’s on-line help system. Section 1.8
discusses the help system in more detail. Readers should note that on-line help can also be
obtained by pressing F1 at any point during program operation.

3. The Toolbar lies immediately below the menu bar and contains a series of buttons used to perform
common program tasks. Each button contains an icon which represents the task it performs. These
tasks duplicate many of the options found on the pull-down menus.

Qe HEEE =X | Bé& | wesEsE ok

To determine the function of a toolbar button, simply place the mouse cursor over a button. A
“tooltip” will appear listing the function of that button.

The toolbar buttons shown above appear by default when you first run the program. However, you
can customize the toolbar by removing buttons that are not often used or arranging the buttons in a
different order that is more efficient for you to use. To customize the toolbar, double click on the
toolbar. This will cause the “Customize Toolbar” dialog to appear. Options in this dialog are used to
add and delete buttons, and to arrange the order of appearance of the buttons.

4. The Tree View is the left-hand panel in the center of the main program window. It contains a tree
image of the major categories of data used by HAP. The tree view acts as the “control panel” when
working with program data:

« To display a list of items in one of the categories of data, click once on the category name. For
example if you click on the Space category name, a list of spaces you have entered will appear in
the list view panel on the right side of the main program window. Once a list of items appears,
you can click on items in the list view to perform such tasks as creating new data, editing data and
generating reports.

o To display a pop-up menu of options for the category, right-click on the category name. The
“category pop-up menu” will appear. Options on this menu will perform tasks on all items in a
given category. For example, if you right-click on the System category name, the System
category pop-up menu will appear. If you select the Print Input Data option, input data for all
systems in your project will be printed. Because options on the category pop-up menu operate on
all items in a category, you should be careful using these options.

« To display a summary of project contents, click once on the Project category name. A list of the
major data categories (weather, spaces, systems, plants) will appear. If the “details” format is
used for the list view, the quantity of items you have defined for each category will also be
shown. For example, the summary shows the number of spaces and systems which have been
defined.
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o To display a summary of project library contents, click once on the Project Libraries category
name. A list of the library categories (schedules, walls, roofs, windows, doors, shades) will
appear. If the “details” format is used for the list view, the quantity of items you have defined in
each category will be shown. For example, the summary shows the number of wall and roof
assemblies you have defined.

The List View is the right-hand panel in the center of the main program window. It contains a list of
data items in alphabetical order for one of the categories of data in your project. For example, when
the space category is selected, the list view shows a list of spaces you have entered. The list view acts
as the second part of the “control panel” when working with program data. By selecting items in the
list view you can:

o Create new items. Example: Creating a new schedule.

« Edit existing items. Example: Editing a wall assembly you previously defined.

o Duplicate an existing item. Example: Creating a new space using defaults from an existing space.
o Delete existing items. Example: Deleting three systems you previously entered.

o Searching and replacing existing space data. Example: Change lighting W/sqft from 2.0 to 1.8
for 40 spaces all at one time.

« Rotating the orientation of existing spaces. Example: Rotate the orientation of 35 spaces by 45
degrees clockwise all at one time.

o View or print input data. Example: Printing input data for four window assemblies you
previously entered.

» View or print design reports. Example: Viewing design reports for two air systems you defined.

o View or print energy simulation reports (HAP users only). Example: Printing a building
simulation report listing annual energy use and energy costs.

There are usually at least two or three ways of performing each task. For example, after selecting
items in the list view, an option on the Edit or Report Menu can be selected, or a button on the
Toolbar can be pressed, or an item pop-up menu can be displayed by right-clicking on the selected
items. Appendix A provides specific procedures for performing all these common operating tasks.

The Status Bar is the final component of the main program window and appears at the bottom of the
window. The current date and time appear at the right-hand end of the status bar. Pertinent messages
appear at the left-hand end of the status bar.

Further information on program operation can be found in separate sections of this guide dealing with
input forms, project management, and basic Windows program operating principles. Appendix A also
provides detailed information on using main program window features to enter data and generate reports.
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1.5 WORKING WITH HAP INPUT FORMS

This section discusses the basic operating principles of HAP’s input forms. While much of your work
with the program is done on the main program window, the actual entry of data is done using input forms.
An input form appears when you choose to create a new item or edit an existing item. A separate input
form is provided for each category of HAP data.

i Window Properties - [4x6 Double Glazed w/ Blinds]

—Siindow Details

Name:

Detailed Input: v

Height [fo0 i Wicth: [4.00  f
Frame Twpe: IAIuminum with thermal breaks j
Internal Shade Type: IVenetian Blinds - Light j

Creerall U-alue: II].543 BTU btz F
Creerall Shade Coefficient: II]_459

— Glass Details

Glazing Glass Type Transmissivity | Reflectivity Absorptivity
Outer Glazing |1/8" clear j n.aa 0.07% 0.0
Glazing #2 178" clear j naa n.0va 0.0m
Glazing #3 not used j 1.000 0.000 0.000
Gap Type: |1f4"AirSpace j

0]4 I Cancel Help

Figure 1.2. A Simple Input Form

Simple Input Forms. Many input forms have a simple appearance as shown in Figure 1.2. These simple
kinds of input forms consist of three components:

1.

The Title Bar is found at the top of the input form. It lists the type of data contained in the input
form and the name of the current item being edited. In the example above, data for a window
assembly named “4x6 Double Glazed w/ Blinds” is being edited. The title bar also contains a close
button. If you press this button, the program will return to the main program window without saving
any changes you made on the form. Thus, the close button performs the same function as Cancel.

The Data Area is the middle portion of the form. It contains all the data describing the current item.
In the example above, the data area contains information describing a window assembly: its
dimensions, framing properties, internal shades, glazings and thermal performance.

While entering information in the data area, you can display explanations of each input item by
pressing the F1 key. For example, if you press F1 while the cursor is on the “Frame Type” item in
the figure above, the help topic for “Window Frame Type” will appear automatically. This feature is
useful for learning about the program while you work.

The Command Buttons are found in the lower right-hand portion of the form. All forms contain
three buttons:

o Press the OK button to return to the main program window after saving any changes you made on
the input form.
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o Press the Cancel button to return to the main program window without saving any changes you
made on the input form. The Cancel button performs the same function as the close button in the
title bar.

o Press the Help button to display an overview of the current input form. This overview describes
how the input form is organized and how to use it. It also contains links to help topics for the
individual input items on the form.

pace Properties - [N Perimeter Office]

| Internals | Walls, Windows, Doors | Roofs, Skylights Infiltratic:nl Flaors | Partitiu:unsl

MName IN Perimeter Office

FEloor Area |225_|] f
Awg Ceiling Height Ig_u ft

Building Weight 70.0 b/t I J

Light Med. Heausy

0]4 I Cancel Help

Figure 1.3. A Tabbed Input Form

Tabbed Input Forms. For certain categories of HAP data, the input form has a more complex
appearance as shown in Figure 1.3. This input form contains the same basic elements (title bar, data area,
command buttons) as discussed earlier, but the data area contains multiple categories of information
rather than a single set of information. Categories of data are represented as tabs in a notebook. In Figure
1.3 data for a space is shown. Space data is divided into five categories:

General data

Internal load data

Wall, Window, Door data
Roof, Skylight data
Infiltration data

Floor data

Partition data

To switch between the different categories of data, simply click on the tab title. For example, to switch to
the “Walls, Windows, Doors” category of data, click on the “Walls, Windows, Doors” tab.
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1.6. PERFORMING COMMON TASKS WITH HAP

In order to use HAP, you will need to enter data, edit data and generate reports. A common set of
procedures is used in HAP to perform these tasks, and this makes the program easier to learn and use.
Whether you are working with walls, spaces or systems, for example, the same basic procedures are used.
Further, there are typically two or more ways of performing each task. So you can choose the approach
that you find most convenient. Table 1.1 lists common program tasks along with alternate ways of
performing each. More extensive information on each task is provided in Appendix A and in HAP’s on-
line help system.

Table 1.1 Common Operating Tasks in HAP

Task Menu Tool Tree List List | Special

Bar Bar View | View | View | Feature

Button | Pop-Up Pop-Up
Menu Menu

Creating a New Item X X X
Editing an Existing Item X X X
Using the On-Line Calculator to Enter Data X
Duplicating an Existing Item X X X
Deleting Items X X X X X
Generating Input Data Reports X X X X
Generating Design Reports X X X X
Generating Simulation Reports (HAP only) X X X X

Key:
1. Menu Bar = One of the menus on the menu bar contains an option for performing this task.
2. Tool Bar Button = One of the toolbar buttons can be used to perform this task.
3. Tree View Pop-Up Menu = The pop-up menu displayed from the tree view contains an option for this task.
4. List View = Task can be performed by directly manipulating items in the list view.
5. List View Pop-Up Menu = The pop-up menu displayed from the list view contains an option for this task.
6. Special Feature = A special feature is provided for this task. Please see Appendix A for details.

1.7 WORKING WITH PROJECTS

While using HAP you will need to create and manage project data. This section discusses projects and
features provided for managing project data.

What is a Project? All the data you enter and calculate in HAP is stored together within a “project”. A
Project is simply a container for your data. However, a project can hold data for other programs as well
as HAP. For example, if you create a project for a building design job, it might contain load estimating
and system design data from HAP, air handler selection data from the Carrier AHUBuilder program, and
packaged rooftop selection data from the Carrier Rooftop Pkg Units program. Keeping this data together
in a single container is often more efficient than keeping the data in several separate locations.

Using Projects. HAP provides a variety of features for working with project data. Common project-
related tasks are listed below. Further information on each feature can be found in Appendix B.

Create a new project by using the New option on the Project Menu.

Edit data in an existing project by using the Open option on the Project Menu.
Save changes in a project by using the Save option on the Project Menu

Save changes to a new project using the Save As option on the Project Menu
Delete an existing project using the Delete option on the Project Menu.

HAP Quick Reference Guide 1-11



Chapter 1 Getting Started

o Edit descriptive data for the project, such as the project name, using the Properties option on the
Project Menu.

« Archive project data for safe keeping using the Archive option on the Project Menu.

» Retrieve data that you earlier archived using the Retrieve option on the Project Menu.

« Retrieve data from the previous version of HAP using the Retrieve Previous Version options on the
Project Menu.

How Project Data is Stored. When a new project is saved for the first time, you designate the folder
which will hold the project files (either by accepting the default folder \E20-II\Projects\ProjectName or
by specifying a folder yourself). This folder is the permanent storage location of project data. When you
open the project to work with its data, temporary copies of the project’s data files are made. As you enter
data, make changes and perform calculations, all this data is stored in the temporary copy of the data files.
Only when you use the Save option on the Project Menu are the changes you’ve made are copied to
permanent storage. Therefore, if you ever need to undo changes you’ve made to a project, simply
re-open the project without saving the changes you’ve made. When you re-open the project, the changes
stored in the temporary copy of the data files are discarded, and data from your last project/save is
restored.

Recommended Project Management Practices. Project data represents an important investment of
your time and effort. And, as the saying goes, ‘time is money’. Therefore it is important to safeguard
your investment in project data. We recommend adopting the following practices when working with
projects:

o Create a separate project for each job you work on. It is usually more efficient to keep data for
separate jobs in separate projects. It is also safer to store data in smaller, focused units. If you keep
data for all jobs in a single project, and this project becomes damaged, your data loss will be greater
than if you keep data for separate jobs in separate projects.

» Use a descriptive name for the project so you can quickly recognize what it contains, both now and
when you need to refer to the project in the future. Because the selection list for projects is arranged
alphabetically it is useful to use a consistent naming convention. Many firms begin the project name
with their internal project number followed by descriptive text (e.g., P2002-47 Lincoln School).

o Save early and often. While entering data, changing data and generating reports, save the project
periodically. This practice is useful in the event that you make a mistake and need to undo changes.
If the last time you saved the project was 15 minutes ago, undoing your mistake will only cause you
to lose 15 minutes of work. On the other hand, if the last time you saved the data was 4 hours ago,
undoing a mistake may cause you to lose 4 hours worth of work.

» Archive your data periodically for safekeeping. These days data on hard disks is relatively safe.
However, it is still possible for hard disk drives to become damaged, or for files on the hard disk to be
damaged or erased. Therefore it is a good practice to periodically archive your project data. Data can
be archived to a separate location on your hard disk, to a different hard disk drive or to removable
media such as a zip drive or floppy disks. For example, if you archive data for a large project at the
end of each day and your hard disk drive fails, at most you will have lost one day’s worth of work.
On the other hand, if data for the same large project was never archived and your hard disk drive
fails, all the project data would be lost.

Further Information. Further information on procedures used to manage project data is found in
Appendix B and the program’s on-line help system.

1.8 USING THE HELP SYSTEM IN HAP

HAP Help. HAP provides extensive on-line documentation via its help system to assist users in learning,
understanding and using the software. In HAP you can obtain information from the help system by:

« Using options on the Help menu in the main program window.
» Pressing the Help button on any input form.
o Pressing F1 at any time during program operation.
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Each of method of obtaining help is discussed below in greater detail.

Method 1 - Using The Help Menu.

The Help menu, which is found in the menu bar in the main program window, contains two options.

1. Contents and Index launches the help system. The help system is presented in a dialog that contains
three tabs: Contents, Index and Find.

« “Contents” provides a table of contents representation of the help system. Topics represented by
page icons are organized into chapters represented by book icons. The table of contents operates
as a tree view. Double click on a book icon to display its contents. Double click on a page icon
to display its help topic.

o “Index” contains an alphabetical list of help topics that you can browse through. It also permits
you to enter a search word or phrase. When a search word or phrase is entered, the index is
scrolled to the help topic whose title most closely matches your word or phrase.

o “Find” allows you to enter a word or phrase. The help system then lists all help topics which use
the word or phrase. You can then display any topic in the list. For example, if your search word
is “wall”, the help system will list all topics which use the word “wall”.

2. About HAP displays the HAP title screen which lists the program name and version number. It also
provides a “System Info” button. When you press this button, information about your computer’s
available memory and other hardware-related data appears. This system information is often useful
when diagnosing operating problems.

Method 2 - Using The Help Button on Input Forms.

All HAP input forms contain a Help button. When you press this button, a help topic appears which
provides an overview of the form and its use. This feature is very useful when using a form for the first
time. The overview help explains the data you are entering, gives a quick orientation of the form and its
features, and provides links to all inputs found on the form. For example, the overview help for the space
input form defines the term “space” and explains how it is used in the program, briefly explains the space
input form and its seven tabs, and provides links to information about the 67 types of input items found
on the form.

Method 3 - Using F1 Help

Context sensitive help can be obtained at any time by pressing the [F1] key. This launches the help
system and displays the topic most closely related to the current position of the cursor. For example, if
you are entering space data and the cursor is in the input field for building weight, pressing F1 will
display the help topic for building weight. This feature is very useful for obtaining explanations and
answering questions which arise as you enter data.

1.9 WINDOWS SOFTWARE BASICS

This section provides a brief introduction explaining how to use Windows programs. This introduction is
intended for readers who are new to Windows software. Understanding the principles discussed below
will make it much easier to learn and use HAP. Please note that this introduction is by no means a
comprehensive guide. Readers who feel more information is needed are encouraged to consult one of the
many Windows training guides which are available in bookstores.

Learn Once, Use Anywhere. One of the basic principles involved with Windows software is that all
software programs should use common elements with standard operating rules. Therefore, if you learn
how to operate one Windows program, you will know the basic techniques of using any Windows
program. The successful application of this principle relies on using standard interface elements which
operate according to standard rules. It also relies on users of the software recognizing visual cues which
indicate which kind of interface element is being used, which in turn implies the operating rules.
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Mouse Input. Your mouse can be used to navigate, choose options, select items and press buttons in a
Windows program. A mouse has two or three buttons designated button #1, button #2 and button #3.
Mouse button #1 is typically the left-hand button and button #2 is the right-hand button. In all subsequent
discussions, and throughout the HAP help system, we will use the following common notation when
referring to use of the mouse:

o Click means to press the left-hand mouse button once. We assume left-hand button = button #1.

o Double-Click means to press the left-hand mouse button twice in quick succession. Again, we
assume left-hand button = button #1.

e Right-Click means to press the right-hand mouse button once. We assume right-hand button = button
#2.

Common tasks you can perform with your mouse are as follows:

o To choose a menu option or an item on a list, click on the option or item.
o To display a pop-up menu, right-click on an item.
o To press a button (such as an OK button), click on the button.

Keyboard Input. Keys on your keyboard can also be used to navigate, choose options, select items,
input data and press buttons in a Windows program:

o To move the cursor from one item to the next, press the [Tab] key. To move the cursor from one item
to the previous item, press [Shift] and [Tab] together.

o To choose a menu option, first press [Alt] and the access key for the menu. For example, if the letter
“P” in the name of the Project menu is underlined, “P” is the access key for this menu. Press
[ALT][P] to display the Project menu’s options. To choose an option on a menu, press the access key
for the desired item.

o To select an item on a list, use the up and down arrow keys to move the cursor through the list. When
the desired item is highlighted, press the [ENTER] key.

o To enter data, simply type the numeric or text information using the keyboard. When finished, DO
NOT press [ENTER]. Instead use the TAB key or the mouse to move to another input item.
[ENTER] very often will execute the default command button which may cause you to exit to a
different part of the program.

o To press a button (such as an OK button), use the [Tab] keys to navigate to the button and then press
the [ENTER] key.

Using Forms and Controls. In Windows programs, information is presented on one or more “forms”.
In HAP, the main program window is an example of one kind of form which is used to perform basic
tasks. HAP input forms are another example of a kind of form which is used to enter information.
Individual items which appear on a form, or entire regions of a form are referred to as “controls”. For
example, on the HAP main program window, the left-hand panel in the center part of the window is a
“tree view” control which is used to switch between different categories of HAP data. A particular type
of control always operates according to one consistent set of rules. Efficient use of Windows programs
relies on quickly recognizing different kinds of controls and understanding how each kind of control is
used. This sub-section summarizes the controls most frequently used in HAP.

o Pull-Down Menus. Pull-down menus typically appear toward the top of a form in the “menu-bar”.
To display the menu’s options, click on the menu name, or use press [ALT] and the menu’s access
key. To select a menu option, click on the option name or use the arrow keys to move the highlight
bar to the desired item and then press [ENTER]. An example showing HAP’s Project menu appears
below.

HAP Quick Reference Guide



Getting Started Chapter 1

Projeck  Edit  View FReporks Help

Mew
Cpen, ..
Save
Save hs..,
Delete...

Properties

Archive. ..

Retrieve...

Retrieve HAP v3.2 Data.., F3
Retrieve HAP w4,0 Data.., F4
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Toolbar Buttons. Toolbar buttons typically appear toward the top of a form and are used to perform
common program operating tasks. Each toolbar button contains a picture which indicates its function.
If you are uncertain of a button’s function, position the mouse cursor over the button. A “tooltip” - a
short description of the button’s function - will appear. To press the button, use the mouse to click on
the button. An example showing HAP’s toolbar appears below.

AEHmEE =X Bd& s = I e

Tree View. A tree view displays the relationships between data items in the form of a tree. For
example, in Windows Explorer, the folder structure of your hard disk is shown in a tree view control.
Branches of the tree represent folders on your hard drive and sub-folders beneath each of these
folders. A tree view control is often accompanied by a list view control. In Windows Explorer you
use the tree view to locate a specific folder, and the accompanying list view displays the files in that
folder.

In the HAP main program window, a tree view is used simply to show the categories of program data.
You can perform the following tasks with this HAP tree view:

o Click on the category name to display its data in the list view. For example, clicking on the
Space category name displays a list of spaces in your project in the list view.

« Right-click on the category name to display the pop-up menu for the category. Options on this
menu perform work on all data in a specific category. For example, if you choose the Print Input
Data option on the Space category pop-up menu, data for all spaces in your project will be
printed.

H:i Default Froject | Space | Floor Area
%% Weather @l <new default space>
&b MY Perimeter Office 450.0
12N Perimeter Office 2250
&b ME Perimeter Office 450.0
=B ProjectLibraries | |@IE Perimeter Office 225.0
il Schedules @ SE Ferimater Office 4500
) Walls @S Ferimeter Office 2es.0
& Raots @l S Perimeter Office 450.0
[ Windows @i\ Perimeter Office 2250
L [ Doors @l Fover / Reception Area 676.0
...... ‘x Shades &l Interior Offices 4950100
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« List View. As its name implies, a list view contains a list of items which can be selected and used for
various tasks. The list view can be displayed in four different formats: list, details, large icons and
small icons. These formats show the contents of the list as line items or icons arranged in column or
row format. The example below shows a list view from HAP containing spaces. This example uses
the details format.

| Space | Floor Area
@l <new default space>

& vy Perimeter Office 4500
@ Perimeter Office 22510

& HE Perimeter Office 450.0

@E Perimeter Office 22510
@l SE Perimeter Office 450.0

&S Perimeter Office 225.0

@l =W Perimeter Office 4500
@i Perimeter Office 225.0

@l Fover { Reception Area 675.0

@l Interior Offices 49500

1] I

Standard procedures are used to select items in a list view:

» To select a single item, click on the item. It will be highlighted to indicate it is selected.

o To select multiple, consecutive items, click on the first item in the series. Hold the [Shift] key
down and click on the last item in the series. All the items in the series you selected will be
highlighted.

o To select multiple, non-consecutive items, hold the [Ctrl] key down and click on each item you
wish to select. Each selected item will be highlighted.

Other tasks that can be performed with list view items are:

o In some programs double-clicking on an item in the list view performs a special function. In
HAP, double clicking on an item allows you to edit its data.

o In addition, right-clicking on an item often displays its pop-up menu. In HAP, this feature is
offered for all categories of program data.

o Text Boxes. A text box is used to enter numeric or text data. Its appearance is shown below. When
you move to the text box by clicking on it or using the [Tab] key, the existing value in the text box
will be highlighted indicating you are in replace mode. If you begin typing, the existing value will be
replaced with the new information you enter. To modify individual characters or numerals in the text
box, click on the text box a second time or press the right or left arrow key. A blinking cursor will
appear. In edit mode you can move the cursor to a desired position in the box and insert or delete
individual characters or numerals. When finished entering data, DO NOT press the [ENTER] key. In
Windows software the [ENTER] key has no effect on a text box. Instead it will often execute the
default command button. Rather than [ENTER] moving you to the next input item, it will send you
elsewhere in the program. Instead, use your mouse or the [Tab] key to move to the next input item.

Floor Area |5|]|]_|] #

« Spin Buttons. Sometimes text boxes are accompanied by spin buttons as shown below. Spin buttons
provide an alternate way to change data in a text box. If you click on the up button, the value in the
text box will increase by a predetermined amount. If you click on the down button, the value will
decrease. In the example below, the spin buttons are used to increment or decrement the window
quantity by one each time a spin button is pressed.
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Drop-Down Lists. Drop-down lists are used to choose from a list of items. The example shown
below is a drop-down list used to choose the overhead lighting fixture type in HAP. To display the
list, click on the down arrow at the right-hand end of the control. Once the list appears, click on the
desired item or use the arrow keys to move the highlight bar to the desired item and then press
[ENTER].

Eixdure Type IF’iecessed, unwvented j

Combo Boxes. A combo box is a modified version of a drop-down list. In addition to choosing from
a list of items, a combo box allows you to enter your own item. The example shown below is a
combo box for the city name from the Weather form in HAP. With this combo box, you can select
from a list of pre-defined cities, or you can type in a city name of your own.

City: [Chicago IAP =]

List Boxes. A list box contains a list of items from which you can select one or more items.
Standard procedures are used to select items (see List View below). Sometimes you must scroll the
list to see all of its items. The example below shows a list box used to select spaces included in a
zone in HAP.

Spaces

My Perimeter Office

M Perimeter Office

MNE FPerimeter Office

E Perimeter Office

SE Parimeter Office

5 Perimeter Office

S Perimeter Office

W' Parimetar Office
Foyer { Reception Area
Interior Offices

Check Boxes. A check box is typically used to indicate on/off or yes/no selections. In the example
below, the box will be checked if you want the program to model glass as shaded all day, and will be
unchecked if the glass is to be modeled as unshaded. A check box is changed by clicking on the box.

Glass Shaded All Day: [
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Radio Buttons. Radio buttons are used for selecting one item from a group of mutually exclusive
choices. In the example below, only one of the four floor types can be selected at one time. To select
an item using radio buttons, click on the button opposite the desired name or on the name itself. A
black dot will be placed next to the item you choose, and the dot for the prior selection will be
removed automatically.

Floor Type
" Floor Abowve Conditioned Space
 Floor Above Unconditioned Space
& Slab Floor On Grade
¢ Slab Floor Below Grade

Command Buttons. Command buttons are used to perform various tasks in a Windows programs.
The example below shows the three command buttons which appear on all HAP input forms.
Pressing the OK button, for example, saves the current data and returns to the HAP main program
window. To press a command button, use your mouse to click the button, or use the [Tab] key to
navigate to the button and then press [ENTER]. In some situations, a command button is highlighted
in some manner to show it is the default for a form. In the example below, the OK button has a
darkened outline indicating it is the default. Pressing [ENTER] from anywhere on the form has the
same effect as pressing the default button.

oK I Cancel Help
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This chapter provides two brief tutorials. The first describes how to use the Hourly Analysis Program to
design systems and plants. The second explains how to use the program to estimate annual energy costs
for HVAC systems. The tutorials are designed for readers who want a quick description of how to use the
program and are already familiar with the design process, HAP terminology and basic principles of
program operation.

2.1 HAP SYSTEM DESIGN TUTORIAL

This tutorial explains how to use HAP to perform system design work for systems and plants. When
HAP is started, the main program window appears. At this point the system design process involves the
following five steps to design systems and two additional steps to design plants. Note that this tutorial
assumes the reader is prepared to enter his or her own building and system data. For a complete example
problem, please refer to Chapter 3.

1. Create a New Project

Choose New on the Project menu. This creates a new project. A project is the container which

holds your data.

Choose Save on the Project menu. You’ll be asked to name the project. From here on, save the
project periodically.

2. Enter Weather Data

Click on the “Weather” item in the tree view in the main program window. A “Weather
Properties” item appears in the list view.

Double click on the “Weather Properties” item in the list view. The Weather input form will
appear.

Enter weather data.

Press the OK button on the Weather input form to save the data and return to the main program
window.

3. Enter Space Data

Click on the “Space” item in the tree view in the main program window. Space information will
appear in the list view.
Double-click on the “<new default space>" item in the list view. The Space input form will

appear.
Enter data for your first space. While entering spaces, you may need to create schedules, walls,
roofs, windows, doors or external shades. You can do this by choosing the “create new ...” item

in drop-down selection lists. For example, when entering overhead lighting data, you must
choose a schedule. In the schedule drop-down list, choose the “create new schedule” item to
create a schedule and automatically assign it to overhead lighting. Similar procedures are used
for walls, roofs, windows, doors and external shades. An alternate approach is to create
schedules, walls, roofs, windows, doors and external shading prior to entering space data.

Press the OK button on the Space input form to save your data and return to the main program
window.

To enter another space, in the list view right-click on the name of the space you just created. The
space pop-up menu appears.
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o Choose the “Duplicate” option on the pop-up menu. A copy of the original space will be created
and its input form will appear. This is a quick way of generating new spaces based on defaults
from the previous space. For many projects this will be more efficient than creating each new
space from standard defaults.

« Enter data for this new space.

« Press the OK button on the Space input form to save your data and return to the main program
window.

» Repeat the previous four steps to enter data for as many spaces as you need.

4. Enter Air System Data

o Click on the “System” item in the tree view in the main program window. System information
will appear in the list view.

o Double-click on the “<new default system>" item in the list view. The System input form will
appear.

o Enter data for your first system. While entering the system, you will need to create a
fan/thermostat schedule. You can do this by choosing the “create new schedule” item in the
fan/thermostat schedule drop-down list. This will create a schedule and automatically assign it to
your system. An alternate approach is to create this schedule before entering air system data.

o  Press the OK button on the System input form to save your data and return to the main program
window.

« To enter another system, in the list view right-click on the name of the system you just created.
The system pop-up menu appears.

o Choose the “Duplicate” option on the pop-up menu. A copy of the original system will be
created and its input form will appear. This is a quick way of generating new systems based on
defaults from the previous system, if successive systems are similar. If they are not, use the "new
default system" option to create each new system.

« Enter data for this new system.

o Press the OK button on the System input form to save your data and return to the main program
window.

« Repeat the previous four steps to enter data for as many systems as you need.

5. Generate System Design Reports

o Click on the “System” item in the tree view in the main program window. System information
will appear in the list view.

Select the systems for which you want reports.

Choose the “Print/View Design Data” option on the Reports menu.

On the System Design Reports form, choose the desired reports.

To view the reports before printing, press the Preview button.

To print the reports directly, press the Print button.

Before generating reports, HAP will check to see if system design calculations have been
performed. If not, HAP automatically runs these calculations before generating the reports.

6. Enter Plant Data (if necessary)

o Click on the “Plant” item in the tree view in the main program window. Plant information will
appear in the list view.

o Double-click on the “<new default plant>" item in the list view. The Plant input form will
appear.

« Enter data for your first plant. For plant design purposes users will typically only select from the
first three plant types (Generic Chilled Water, Generic Hot Water, Generic Steam). HAP users
have additional options for specific types of chilled water, hot water and steam plants, but these
require extra data not relevant to the design calculation. Therefore it is more efficient to use the
Generic plant types for design. Later Generic plants can be converted into specific plant types
without loss of data.

o Press the OK button on the Plant input form to save your data and return to the main program
window.

o To enter another plant, in the list view right-click on the name of the plant you just created. The
plant pop-up menu appears.
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o Choose the “Duplicate” option on the pop-up menu. A copy of the original plant will be created
and its input form will appear. This is a quick way of generating new plants based on defaults
from the previous plant, if successive plants are similar. If they are not similar, use the "new
default plant" option to create each new plant.

« Enter data for this new plant.

o Press the OK button on the Plant input form to save your data and return to the main program
window.

» Repeat the previous four steps to enter data for as many plants as you need.

7. Generate Plant Design Reports (if necessary)

o Click on the “Plant” item in the tree view in the main program window. Plant information will
appear in the list view.

Select the plants for which you want reports.

Choose the “Print/View Design Data” option on the Reports menu in the menu bar.

On the Plant Design Reports form, choose the desired reports.

To view the reports before printing, press the Preview button.

To print the reports directly, press the Print button.

Before generating reports, HAP will check to see if plant design calculations have been
performed. If not, HAP automatically runs these calculations before generating the reports.

2.2 HAP ENERGY ANALYSIS TUTORIAL

This tutorial explains how to use HAP to estimate annual energy use and energy cost for alternate system
designs. The tutorial is only for HAP users as energy analysis features are not provided in HAP System
Design Load.

When HAP is started, the main program window appears. At this point the energy analysis involves the
following 9 steps. If system design work has already been completed, many of these steps will not be
necessary or will only require minimal work. Note that this tutorial assumes the reader is prepared to
enter his or her own data. For a complete example problem, please refer to Chapter 4.

1. Create a New Project

o Choose New on the Project menu. This creates a new project. A project is the container which
holds your data.

o Choose Save on the Project menu. You’ll be asked to name the project. From here on, save the
project periodically.

o If system design work was done previously, then the project will already exist. In this case use
the Open option on the Project menu to open the project.

2. Enter Weather Data

o Click on the “Weather” item in the tree view in the main program window. A “Weather
Properties” item appears in the list view.

« Double click on the “Weather Properties” item in the list view. The Weather input form will
appear.

o Enter weather data. Be sure to enter data on the Simulation tab of the Weather form. Inputs on
this tab link simulation weather data to the project and define the holiday calendar for the year.

o Press the OK button on the Weather input form to save the data and return to the main program
window.

3. Enter Space Data

This step is the same as in the System Design Tutorial in section 2.1, but with the following
exceptions:

o Make sure that schedules for internal loads include profiles assigned for all 7 days of the week
and for holidays. Data originally used for system design work may only have defined profiles for
the design day.
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o Make sure infiltration rates for energy analysis days are specified. For design work infiltration
rates may only have been specified for design cooling and design heating conditions.

4. Enter Air System Data

This step is the same as in the System Design Tutorial in section 2.1, but with the following
exceptions:

o Systems used in an energy analysis may not use the "Undefined" equipment class. Any
“Undefined” system must be converted to one of the specific equipment classes before it can be
used in energy simulations. To convert a system, edit its data and change the “Equipment Class”
input from “Undefined” to one of the other choices. This will change the cooling and heating
sources for coils in the system, but will retain the other input data. Review your input data,
particularly the cooling coil and heating coil source items before saving the system.

« When defining data for packaged rooftop, packaged vertical units, split DX air handlers,
packaged or split DX fan coils or water source heat pumps, you must enter data on the Equipment
tab of the Air System form. This tab provides inputs describing the full load capacity, full load
efficiency and operating controls for these types of equipment.

o When analyzing water-cooled vertical packaged units, cooling tower data must be entered prior to
entering your system data.

o When analyzing water source heat pump systems, cooling tower data must be entered prior to
entering your system data. If studying a closed loop WSHP system, auxiliary boiler data must
also be defined before entering system data.

5. Enter Plant Components (Chillers, Cooling Towers, Boilers) (if necessary)
If your study includes a chiller plant, define chillers as follows:

o Click on the “Chiller” item in the tree view in the main program window. Chiller information
will appear in the list view.

o Double-click on the “<new default chiller>" item in the list view. The Chiller input form will
appear.

o Enter data for the chiller. As explained in the help system, there are three ways to enter chiller
data. If your sales engineer has provided you with an import file generated by Electronic
Catalog, this data can be loaded using the Import button. If you have full load and IPLV or
NPLV data, you can load this data using the Template button. Or, if you have full load
performance data and complete performance maps for the chiller, the data can be entered
manually.

o Once finished entering data press the OK button on the Chiller input form to save your data and
return to the main program window.

« If'the project includes several different chillers, repeat the previous steps to define each.

If your study includes water-cooled chillers, define cooling towers as follows:

o Click on the “Cooling Tower” item in the tree view in the main program window. Cooling Tower
information will appear in the list view.

o Double-click on the “<new default cooling tower>" item in the list view. The Cooling Tower
input form will appear.

« Enter data for the cooling tower.

« Once finished entering data press the OK button on the Cooling Tower input form to save your
data and return to the main program window.

» If the project includes several different cooling towers, repeat the previous steps to define each.

If your study includes hot water or steam boilers, define boilers as follows:

o Click on the “Boiler” item in the tree view in the main program window. Boiler information will
appear in the list view.

o Double-click on the “<new default boiler>" item in the list view. The Boiler input form will
appear.

» Enter data for the boiler.
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o Once finished entering data press the OK button on the Boiler input form to save your data and
return to the main program window.
o If'the project includes several different boilers, repeat the previous steps to define each.

6. Enter Plant Data (if necessary)
If your study includes chilled water, hot water or steam plants, define each as follows:

o Click on the “Plant” item in the tree view in the main program window. Plant information will
appear in the list view.

o Double-click on the “<new default plant>" item in the list view. The Plant input form will
appear.

« Enter data for your plant.

o Press the OK button on the Plant input form to save your data and return to the main program
window.

« If more than one plant is required for your analysis, repeat the previous steps to define each plant.

7. Enter Utility Rate Data
To define the electric rate, use the following steps:

o Click on the “Electric Rate” item in the tree view in the main program window. FElectric Rate
information will appear in the list view.

» Double-click on the “<new default electric rate>" item in the list view. The Electric Rate input
form will appear.

« Enter data for your electric rate.

o Press the OK button on the Electric Rate input form to save your data and return to the main
program window.

If other fuel sources such as natural gas, fuel oil, propane, remote hot water, remote steam or remote
chilled water are used in your analysis, a fuel rate must be defined for each source. Use the
following steps:

o Click on the “Fuel Rate” item in the tree view in the main program window. Fuel Rate
information will appear in the list view.

» Double-click on the “<new default fuel rate>" item in the list view. The Fuel Rate input form
will appear.

« Enter data for your fuel rate.

o Press the OK button on the Fuel Rate input form to save your data and return to the main program
window.

« If more than one fuel rate is required for your analysis, repeat the previous steps to define each.

8. Enter Building Data

o Click on the “Building” item in the tree view in the main program window. Building information
will appear in the list view.

o Double-click on the “<new default building>" item in the list view. The Building input form will
appear.

« Enter data for your building.

o Press the OK button on the Building input form to save your data and return to the main program
window.

» Repeat the previous steps to define each building in your analysis. Typically an energy analysis
contains at least two buildings containing equipment for alternate HVAC designs.

9. Generate Simulation Reports

o Click on the “Building” item in the tree view in the main program window. Building information
will appear in the list view.

o To study energy use and cost data for one building, select a single building. If you wish to
compare energy use and costs for a group of buildings, select all buildings in the group.

o Choose the “Print/View Simulation Data” option on the Reports menu in the menu bar.

o On the Building Simulation Reports dialog, choose the desired reports.
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« To view the reports, press the Preview button.

o To print the reports directly, press the Print button.

o Before generating reports, HAP will determine whether system, plant and building calculations
are necessary to generate data for your reports. If so, HAP will automatically run the calculations
before generating your reports. If no calculations are necessary, reports will be generated
immediately.

Note that simulation reports can also be generated for systems and plants. These reports provide
more detailed information about the energy use of these equipment components. To generate these
reports, use the same procedure described above, but use systems or plants instead of buildings.
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HAP Quick Reference Guide



Chapter 3 System Design Example Problem

This chapter contains a simple example problem which demonstrates how to use HAP to design an HVAC
system. The example builds on concepts and procedures discussed in Chapters 1 and 2.

3.1 OVERVIEW FOR THE EXAMPLE PROBLEM
The procedure for designing HVAC systems in HAP involves five steps, as discussed in Chapter 1:

1. Define the Problem.

2. Gather Data.

3. Enter Data Into HAP.

4. Use HAP to Generate Design Reports.
5. Select Equipment.

The example problem presented in this chapter will demonstrate each step in this process. In the
remainder of this chapter a separate section will deal with each step.

3.2 DEFINING THE PROBLEM

The objective of this example problem is to design an HVAC system which serves one wing of a high
school building located in Chicago, Illinois. The floor plan for this portion of the school building is
shown in Figure 3.1. It is comprised of six classrooms, a music room and its associated office, storage
and practice rooms, plus two corridors and two doorway vestibules for a total of 14 rooms. In Figure 3.1,
classrooms D101 through D104 face due east. East, south and west walls are exposed to ambient. The
north walls adjoin other air-conditioned areas of the building; we will assume there is no heat transfer
across this northern boundary.

The rooms in this portion of the school building will be air conditioned by one packaged rooftop unit
serving parallel fan powered mixing box (PFPMBX) terminals. A gas-fired preheat coil in the rooftop
unit and electric resistance heating coils in the mixing box terminals provide heating. HAP will be used
to model the heat transfer processes in the building in order to determine the following eight equipment
sizing values:

Rooftop unit required cooling capacity.
Rooftop unit required fan airflow

Rooftop unit required preheat coil capacity.
PFPMBX terminal design airflow rates.
PFPMBX terminal minimum airflow rates.
PFPMBX terminal fan design airflow rates.
PFPMBX terminal reheat coil capacities.
Space required supply airflow rates.
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Figure 3.1 Floor Plan for School Building

3.3 GATHERING DATA

The second step in the design process is to gather information necessary to model heat transfer processes
in the building and to analyze operation of the HVAC equipment which heats and cools the building.
This involves gathering data for the building, its environment and its HVAC equipment. Below,
gathering of weather data, data for spaces in the building and data for the HVAC system will be
discussed.

3.3.1 Gathering Weather Data

ASHRAE design weather conditions for Chicago O’Hare International Airport (Chicago IAP) will be
used for this analysis. These design parameters are shown in Figure 3.2. In addition to the ASHRAE
data, we will:

Specify daylight savings time from April 7 through October 26.

Use the period May through November as the design cooling months. This means cooling sizing
calculations will only be performed for this range of months. We could use January through
December as the calculation period. However, design weather conditions in Chicago are such that
peak loads are most likely to occur during the summer or fall months. So we can reduce the set of
calculation months to May through November to save calculation time without sacrificing reliability.
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3.3.2 Gathering Space Data

In this example problem we will model the heat transfer of each room separately so peak loads and
required airflow rates can be determined for each room. In this portion of the school building there are 14
rooms, but three (D101, D102 and D103) are identical. Therefore we will define one of these classrooms
as a space and reuse it three times. This reduces the total number of spaces needed for the analysis from
14 to 12. Characteristics of these spaces were derived from architectural plans and from information
about the use of the building and are described below.

Walls. One common wall construction is used for all exterior walls. The construction, whose data is
shown in Figure 3.3, consists of 4-inch face brick, R-7 board insulation, 8-inch lightweight concrete
block, an air space and gypsum board finish. The exterior surface absorption is in the “dark” category.
The overall U-value is 0.084 BTU/(hr-sqft-F). The overall weight is 69.8 1b/sqft.

Roofs. One uniform horizontal roof construction is used for this portion of the school building. Its data
is shown in Figure 3.7. The roof construction consists of built-up roofing, R-14 board insulation, 22
gauge steel deck, a plenum air space and acoustic ceiling tiles. The exterior surface absorption is in the
“dark” category. The overall U-value is 0.056 BTU/(hr-sqft-F). The overall weight is 5.8 Ib/sqft. Note
that in HAP the roof assembly must include all material layers from the exterior surface to the interior
surface adjacent to the conditioned space. Thus, the ceiling plenum is considered part of the overall roof
assembly.

Windows & External Shading. One type of casement window unit is used for all windows in this
portion of the school building. The window units measure 6 feet in height by 4 feet in width, are double
glazed with 1/8-inch clear glass glazings, and use an aluminum frame with thermal breaks. No internal
shades are used. Manufacturer’s NFRC ratings indicate the window has a U-value of 0.649 BTU/(hr-sqft-
F) and a shading coefficient of 0.82. All windows have a 4-inch reveal depth. Window data is shown in
Figure 3.4 while external shading data is shown in Figure 3.8

Doors. Each vestibule contains a pair of stile and rail doors. Doors contain a single-glazing in an
aluminum frame. The frames use thermal breaks. Each door measures 7 feet in height by 4 feet in width.
Manufacturer’s ratings indicate the door U-value is 1.13 BTU/(hr-sqft-F) and the shade coefficient is
0.94. Door data is shown in Figure 3.6.

Lighting. Recessed, unvented fluorescent lighting fixtures are used for all rooms in this portion of the
school building. A lighting density of 3.00 W/sqft is used. The fixture ballast multiplier is 1.08.

For classrooms, offices, storage rooms and practice rooms we will use design day lighting levels of 100%
from 0700 through 1700, the standard occupancy period for the school, and 5% from 1800 through 2100
when lighting is reduced or operated intermittently for custodial work. This lighting profile applies for
the days the school is in session. For weekends and holidays lighting levels of 0% are used. The holiday
period includes a summer shutdown period from late June to early August. Therefore the
Weekend/Holiday lighting profile will be used for July for design calculations. Lighting schedule data is
shown in Figure 3.5.

For the corridors and vestibules we will use design day lighting levels of 100% for 0700 through 2100.
Security lighting levels of 5% will be used for all other hours. This lighting profile applies for days the
school is in session. For weekends and holidays lighting remains at 5% security levels for all hours.
Lighting schedule data is shown in Figure 3.5

Occupants. The maximum number of occupants varies by space and will be discussed later in this
section. For all rooms except the music room, a “seated at rest” activity level will be used (230
BTU/hr/person sensible, 120 BTU/hr/person latent). For the music room the “office work™ activity level
will be used due to the higher level of activity in this room (245 BTU/hr/person sensible, 205
BTU/hr/person latent).

For all rooms we will use design day occupancy levels of 100% for 0700 through 1700, the normal hours
of operation for the school. Occupancy during the period 1800 through 2100 is very infrequent and will
be ignored. Thus, occupancy levels of 0% will be used for all other hours of the day. This occupancy
profile applies for days the school is in session. For weekends and holidays 0% occupancy is used for all
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hours. For the summer shutdown period from late June to early August these 0% occupancy values will
be used. The occupant schedule is shown in Figure 3.5.

Spaces. A total of 12 spaces will be defined. Data for these spaces appears in Figures 3.9 through 3.20.
Details:

o Floor areas are shown in Table 3.1.
o The average ceiling height is 8 feet for all spaces.
o The building weight is 70 1b/sqft (medium category).

« One type of lighting fixture is used in all spaces. Lighting fixture characteristics and schedules were
discussed earlier in this subsection.

e Occupants per space are listed in Table 3.1. Occupant heat gains and schedules were discussed earlier
in this subsection.

o One set of common wall, door, window and external shading constructions are used for the building.
Wall orientations, wall areas, and window and door quantities for each space are summarized in Table
3.1.

o One common roof construction is used for the building. Roof areas are shown in Table 3.1.

o Infiltration is only modeled for the vestibules at the end of each corridor. Infiltration has been
estimated at 18 CFM for design cooling conditions and 27 CFM for design heating conditions.
Infiltration is assumed to be present for all hours of the day.

o This wing of the school building uses slab on grade floor construction. The floor slab is constructed
of 6-inch of heavy weight concrete with an overall U-value of 1.2 BTU/(hr-sqft-F). R-7 edge
insulation is used for the slab. Slab floor areas and exposed perimeters are shown in Table 3.1. Note
that slab floors are not modeled for the corridor spaces since neither has an exposed slab perimeter.

Table 3.1 Summary of Space Characteristics (continued)

Floor | People | Wall, Window, Door Roof Data Slab Slab
Area Data Floor | Exposed
(sqft) Area | Perimeter
(sqft) (ft)

D101 - Typical Classroom | 907.5 25| E:275 sqft, 3 windows H: 907.5 sqft| 907.5 27.5

D104 - Classroom 907.5 25| E: 275 sqft, 3 windows H: 907.5 sqft| 907.5 60.5
S: 330 sqft, 0 windows

D106 - Classroom 907.5 25| W: 275 sqft, 3 windows H:907.5 sqft| 907.5 71.5
S: 330 sqft, 0 windows
E: 110 sqft, 0 windows

D107 - Classroom 907.5 25| W: 275 sqft, 3 windows H:907.5 sqft| 907.5 27.5

D108 - Music Room 1781.0 50| S:242 sqft, 2 windows H: 1781.0 sqft | 1781.0 24.2

D109 - Practice Room 65.0 1| W: 66 sqft, 0 windows H: 65.0 sqft 65.0 16.5
S: 99 sqft, 0 windows

D110 - Storage Room 120.0 0| W: 121 sqft, 0 windows H: 120.0 sqft| 120.0 12.1

D111 - Office 174.0 1| W: 132 sqft, 1 window H: 174.0 sqft| 174.0 13.2

D113 - West Corridor 1054.0 0 None H: 1054.0 sqft 0.0 0.0

D114 - South Corridor 920.0 0 None H: 920.0 sqft 0.0 0.0

D105 - South Vestibule 73.0 0 S: 110 sqft, 2 doors H: 73.0sqft| 73.0 11.0

D112 - West Vestibule 68.0 0 W: 88 sqft, 2 doors H: 68.0 sqft 68.0 8.8
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3.3.3 Gathering Air System Data

One air handling system will provide cooling and heating to the rooms in this wing of the school building.
Therefore, we will define one HAP air system to represent this equipment. Data for this air system is
shown in Figure 3.21. Details:

Equipment Type. A VAV packaged rooftop unit will be used.

Ventilation. Outdoor ventilation airflow of 3142 CFM will be specified. This is based on the
ASHRAE Standard 62.1-1999 requirement of 15 CFM/person for the classrooms and music rooms
and 0.05 CFM/sqft for corridors and utility rooms. “Constant” control for ventilation will be used so
the system uses 3142 CFM of outdoor air at all times. Ventilation dampers are closed during the
unoccupied period and the damper leak rate is 5%.

Cooling Coil. The system provides a constant 55 F supply air temperature to zone terminals. The
DX cooling coil is permitted to operate in all months. The bypass factor for the cooling coil is 0.050
which is representative of the type of equipment we expect to select.

Preheat Coil. The rooftop unit contains a preheat coil to maintain minimum supply duct
temperatures during the winter. The preheat coil is located downstream of the point where return air
and outdoor ventilation air mix. The preheat setpoint is 52 F. The gas-fired heat exchanger in the
rooftop unit is used for this purpose. The coil is permitted to operate in all months.

Supply Fan. The supply fan in the rooftop unit will be forward curved with variable frequency drive.
The total static pressure for the system is estimated to be 3 in wg. The overall fan efficiency is 48%.
The coil configuration is draw-thru.

Return Air Plenum. The system uses a return air plenum. It is estimated that 70% of the roof load,
20% of the wall load and 30% of the lighting load is removed by plenum air.

Zoning. A zone is a region of the building with one thermostatic control. One zone will be created
for each classroom. The music room and its adjacent office, storage room and practice room will all
be part of a single zone. Each corridor and each vestibule will also be zone. Therefore, a total of 11
zones will be created: one each for the six classrooms, one for the music room, two for the corridors
and two for the vestibules.

Thermostats. Thermostat settings of 74 F occupied cooling, 85 F unoccupied cooling, 72 F occupied
heating and 60 F unoccupied heating will be used in all zones. The throttling range will be 3 F. The
schedule for fan and thermostat operation for the design day will designate 0700 through 2100 as
“occupied” hours. This covers both the 0700-1700 operating hours for the school and the 1800-2100
period when custodial staff is present. All other hours will be “unoccupied”. This profile applies for
the school year which runs from August through June. During the shutdown month of July all hours
will be designated as “unoccupied”. Schedule data is shown in Figure 3.5.

Supply Terminals. All zones use parallel fan powered mixing box terminals with 0.5 in wg total fan
static, 50% overall fan efficiency and a 110 F heating supply temperature. Minimum supply airflow
for the terminals is 15 CFM/person for the classrooms and music rooms, and 0.05 CFM/sqft for the
corridors and vestibules. The heat source for the reheat coils is electric resistance.

Sizing Criteria. Required zone airflow rates will be based on the peak sensible load in each zone.
Required space airflow rates will be based on peak space loads for the individual spaces. A safety
factor of 10% for cooling loads and 20% for heating loads will be used in calculations.
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3.4 ENTERING DATA

After weather, space and HVAC system data has been gathered, it is entered into HAP. This is the third
step in the design process. The procedure for entering data into HAP is presented below in a tutorial
format.

1. Program Setup

o (Optional) If you are running HAP, it may be helpful to switch to System Design mode before
entering data. This hides energy analysis inputs from view and simplifies the user interface. To
switch to System Design Mode, choose “Options” on the View Menu, click on the Other Options
tab and then uncheck the “Enable Energy Analysis Features” check box. This feature is only
available in HAP and not in HAP System Design Load.

2. Create a New Project

o (Optional) If you only wish to view this example rather than entering all the data yourself, you
can use archive data for the example problem which is provided on the HAP CD. To use this
archive file:

» Copy the Example.E3A file from the \Example folder on the CD to the \E20-II\Archives
folder on your computer.

» Using Windows Explorer, right-click on the Example.E3A file after it has been copied.
Select the “Properties” option on the pop-up menu that appears. On the Properties dialog that
appears, uncheck the “Read-Only” check box. Then press OK.

» Run HAP. Use the New option on the Project Menu to create a new untitled project. Then
use the Retrieve option on the Project Menu to retrieve the data from the Example.E3A
archive. Finally use the Save option on the Project Menu to save the project. Use the project
name “Example Problem”.

»  Skip to step 3 below.

o If you will be entering example problem data yourself, choose New on the Project menu. This
creates a new project. A project is the container which holds your data. The new project you
create will contain data for the example problem.

o Then choose Save on the Project menu. Because you are saving the project for the first time, you
will be asked to specify a name for the project. Use “Example Problem” as the project name.
From here on, save the project periodically.

3. Enter Weather Data

o Click the “Weather” item in the tree view in the main program window. A “Weather Properties”
item appears in the list view.

« Double click on the “Weather Properties” item in the list view. The Weather input form will
appear.

o From the drop-down lists on the Weather form, choose data for United States / Illinois /
Chicago IAP. Also select design cooling months of May through November, and specify
daylight savings time from April 7 through October 26. Design parameter input data for the
example problem is shown in Figure 3.2.

« When finished entering this data, press the OK button on the Weather input form to save the data
and return to the main program window.

3-6
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4. Enter Space Data

Entering space data is the most labor-intensive phase of data entry. By using the program’s
“duplicate” feature input effort can be minimized. First enter data for the “D101- Typical Classroom”
space:

Click the “Space” item in the tree view in the main program window. Space information will
appear in the list view.

Double-click on the “<new default space>" item in the list view. The Space input form will
appear.

Enter data on the General tab of the space input form using data shown in Figure 3.9.

Switch to the Internals tab on the space input form and enter the data shown in Figure 3.9. As
you enter internal load data it will be necessary to create a lighting schedule and an occupant
schedule. This can be done “on-the-fly” without leaving the space input form. Simply choose
the “<create new schedule>" item in the schedule drop-down list. This will launch the schedule
input form. Enter data for the appropriate schedule shown in Figure 3.5. If you are new to the
Schedule form, make frequent use of the help features on this form to learn about the many ways
in which schedule data can be entered. When finished, press the OK button to save the schedule
and return to the space form. When you do this, the schedule you created will be assigned to the
space automatically. For example, if you chose “<create a new schedule>" from the drop down
list for overhead lighting schedule, the schedule you create will be assigned to overhead lighting
automatically.

Switch to the Walls, Windows, Doors tab on the space input form and enter the data shown in
Figure 3.9. As you enter this data it will be necessary to create wall, window, door and external
shade constructions. For example, while the desired exposure line in the table is highlighted, you
can create the wall construction for that exposure by choosing the “<create a new wall>" item in
the wall drop-down list. Similar procedures are used for creating window, door and external
shade constructions. Wall, window, door and shade construction data is shown in Figures 3.3,
3.4, 3.6 and 3.8 respectively.

Switch to the Roofs, Skylights tab on the space input form and enter the data shown in Figure 3.9.
As you enter this data it will be necessary to create a roof construction. With the desired
exposure row in the table highlighted, you can create a roof construction for that exposure by
choosing the “<create a new roof>" item in the roof drop-down list. Roof construction data is
shown in Figure 3.7.

Switch to the Floors tab on the space input form and enter the data shown in Figure 3.9.

At this point, press the OK button to save data for space D101 and return to the main program
window.

D102 and D103 are identical to D101, so the next space we enter will be “D104 - Classroom”. The
“duplicate” feature can be used to minimize input effort:

Right-click the “D101 - Typical Classroom” space item in the list view portion of the main
program window. On the pop-up menu that appears, select the “duplicate” option. A duplicate of
“D101 - Typical Classroom” will be created, the space input form will be launched and data for
the new space will be displayed. Because this new space is a copy of D101, we will only need to
modify items which differ from D101.

On the General tab of the space input form change the space name to “D104 - Classroom” and
specify its floor area as shown in Figure 3.10.

Switch to each of the other tabs on the space input form in succession and enter the data shown in
Figure 3.10. Note that many of the default values for this space will not need to be changed since
much of the space data is common among spaces. By making duplicates of successive spaces, the
number of items which need to be modified will be minimized.
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e When finished modifying data for space D104, press the OK button to save data for space D104
and return to the main program window.

Enter data for the remaining spaces using a procedure similar to that used for D104: Use the
“duplicate” feature to create successive copies of spaces and modify the data for each new space you
create in this manner. As you enter data for the remaining spaces, use a strategy of entering similar
spaces consecutively. The recommended order for the remaining spaces in this example is D106,
D107, D108, D109, D110, D111, D113, D114, D105, and D112. Input data for the remaining spaces
is shown in Figures 3.11 through 3.20.

5. Enter Air System Data

o Click on the “System” item in the tree view in the main program window. System information
will appear in the list view.

» Double-click on the “<new default system>" item in the list view. The System input form will
appear.

» Enter data for the “Packaged Rooftop AHU” air system shown in Figure 3.21. If you are new to
the air system form, make frequent use of the help button or the on-line help features (F1 key) to
learn about form operation.

« As you enter data you will need to create a fan/thermostat schedule for the air system. This is
done in a manner similar to creating schedules “on-the-fly” for spaces. In the Thermostats data
view on the Zone Components tab, choose the “<create a new schedule>” item in the schedule
drop-down list. This will launch the Schedule input form. Use this form to enter the
fan/thermostat schedule data shown in Figure 3.5. Be sure to specify the schedule type as
“fan/thermostat” instead of “fractional”. When finished, press the OK button to save the schedule
and return to the air system form. The schedule will be assigned to the air system automatically.

o When finished entering air system data, press the OK button on the System form to save your
data and return to the main program window.

At this point all input data has been entered and we’re ready to design the system. Procedures for
generating system design reports will be discussed in Section 3.5.

3.5 GENERATING SYSTEM DESIGN REPORTS

The fourth step in the design process is to use the data entered in step 3 to perform system design
calculations and generate system design reports. The procedure for doing this is as follows:

o Click the Systems item in the tree view portion of the main program window. Systems information
will appear in the list view.

« Right click the “Packaged Rooftop AHU” item in the list view. On the menu which appears, select
the “Print/View Design Data” item. The System Design Reports dialog will appear.

o On the System Design Reports dialog, select the “System Sizing Summary” and “Zone Sizing
Summary” report options. Then press the Preview button.

« When you press the Preview button, the program will determine whether system design data exists for
the air system. Since design data has not yet been calculated, the program will run design
calculations automatically. A status monitor will appear to help you track the progress of the
calculation. Once the calculation is finished, the reports you requested will appear in the HAP Report
Viewer.

o The Report Viewer can be used to browse and print the reports. Use the scroll bar to browse each
report document. Use the buttons on the Report Viewer toolbar to move from one report to the next..
The System Sizing Summary and Zone Sizing Summary reports are shown in Figures 3.22 and 3.23.
Information in these reports can be used to size the various components of the HVAC system as
explained in section 3.6.
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3.6 SELECTING EQUIPMENT

The final step in the design process is to use system design reports to select HVAC equipment. At the
beginning of this example, eight equipment sizing objectives were listed. Data provided on the System
Sizing Summary report (see Figure 3.22) and the Zone Sizing Summary report (see Figure 3.23) can be
used to meet all eight of these objectives. Table 3.2 lists the eight sizing objectives and the report and
table which contains data needed to meet each objective.

The System Sizing Summary report contains data used to select the packaged rooftop unit. The Central
Cooling Coil Sizing Data table lists the peak coil capacities, coil entering and leaving conditions and a
number of useful check figures. The Preheat Coil Sizing Data table lists the peak load for this coil as well
as entering and leaving conditions. The Supply Fan Sizing Data table provides the required airflow rates
and motor data for the supply fan. Together this data can be used in packaged rooftop unit selection
software offered by Carrier and other manufacturers to select a rooftop unit which meets the sizing
requirements.

The Zone Sizing Summary report contains data used to select terminal equipment. The Zone Sizing Data
table lists the required airflow rate for each zone terminal. It also lists the minimum airflow rate which
can be used to set minimum damper positions for the mixing boxes. The Zone Terminal Sizing Data table
lists the required sizes for the parallel mixing box fans and the reheat coils. The Space Loads and
Airflows table lists the required airflows for each space served by the system. Because 10 of the 11 zones
contain a single space, space and zone airflows for these zones will match. For the Music Room zone
which contains four spaces, the airflow rates can be used to size ductwork and supply diffusers for the
four rooms in this zone. Together this data can be used in air terminal selection software offered by
Carrier and other manufacturers to select terminal components which meet the sizing requirements. This
data can also be used in duct design calculations to size ductwork for the system.

Table 3.2. Location of System Sizing Data on Design Reports

Objective: Table

Report: Air System Sizing Summary

1. Rooftop Cooling Capacities Central Cooling Coil Sizing Data

2. Rooftop Supply Fan Airflow Supply Fan Sizing Data

3. Rooftop Preheat Coil Capacity Preheat Coil Sizing Data

Report: Zone Sizing Summary

4. Supply Terminal Airflow Rate

Zone Sizing Data (see “Design Air Flow”)

5. Supply Terminal Minimum Airflow Rates

Zone Sizing Data (see “Minimum Air Flow”)

6. Supply Airflow Rates for Mixing Box Fans

Zone Terminal Sizing Data
(see “Mixing Box Fan Airflow”)

7. Terminal Reheat Coil Capacities

Zone Terminal Sizing Data
(see “Reheat Coil Load”)

8. Space Airflow Rates

Space Loads and Airflows (see “Air Flow”)
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Design Weather Parameters & MSHGs

Example Prokblem 041272002
Cartier Corporation 63 5040

Design Parameters:

City Mame
Location

Chicago IAP
llinois

Latitude 42.0 Deq.
Longitude 879 Deg
Elevation 673.0 ft

Surmmer Desian Dn-BUll 91.0 °F

Summer CoincidentWet-Bulb 740 °F

summer Daily Range °F

Wintar Design Dry-Bulh | °F

Winter Design Wet-Bulb °F
Atmospheric Cleamess MUMBEr e 1.00

Average Ground Reflectance 020

Soil Conductivity 0.800 BTUShr-t-"F)
Lacal Time fone (GMT +- W hours) 6.0 haours

Consider Daylight Savings Time .
Daylight Sav IO S BN S April, 7
Daylight Savings Ends

Simulation YWeather Data |
Current Data is 2001 ASHRAE Handbook

Figure 3.2 Design Weather Parameters

Wall Constructions

Example Proklem 044 272002
Carrier Corporation 05 5540
E xterior Wall
Wall Details

Ciutzide Surface Color Dark

Wall Layers Details (Inside to Outside)

Thickness Density | Specific Ht. R-Vaue Weight

Layers in IbitE | BTU / {lb - “F} |{(hr-fE-FBTU 1b/F
nzide surface resistance 1.0 [RK] oo OES200 (U]
Gypaum bosrd 0.625 50.0 0.26 0.56021 26
Air space 0.000 o0 000 0.97000 [
5-in LWy concrete block &.000 5.0 0.20 202020 253
F- board insuation 1000 20 [ 594444 0z
Face brick 4.000 1250 0.22 0.43300 4.7
Dutside surface resistance 0.000 o0 000 0.333500 [
Totals 13.625 - - 11.89 69.8

Figure 3.3 Wall Construction Data
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Window Constructions

Example Problem 044 2/2002
Carrier Corporation 09 0280
Casement Window

Window Details:

Detailed Input
Height B
Wickth it

Creerall -V alue 0649 BTUIhr-#%"F)

Owerall Shade Coeficient

Figure 3.4 Window Construction Data

Schedule Input Data
Example Problem 044 2/2002
Catrier Corporation 55480

Lighting - Classrooms (Fractional)

Hourly Profiles:

1:5chool_In_Session

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 |14 (15 (16 |17 (18 |19 (20 |21 |22 |23
Valwe | O |0 (O |0 (0 |0 (0 [100(100 (100 {100 (100|100 (100 100 (100 100 (100 |10 {10 (10 |10 |0 | 0O

2WeekendHoliday

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 [14 [15 (16 |17 (18 |19 (20 |21 (22 |23
Valpe O |0O (O |0 (O O (O |O|O|O|O (O (OO |0 (0|0 (0|00 0|0 |00

Assignments:

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Hov Dec
Design| 1 1 1 1 1 1 2 1 1 1 1 1

Lighting - Comidors (Fractional)

Hourly Profiles:

1:5chool_In_Session

Hour (OO (01 (02 (03 (04 |05 |06 |OF |05 |09 |40 |11 |12 (13 (14 (15 (16 |17 |13 |19 |20 | |22 |23
Valwe | 5 |5 (5 |5 (5 |5 (5 [100(100 (100 {100 (100 {100 (100 100 (100 100 (100 100 {100 (100 100 | 5 | &

2WeekendHoliday

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 [14 [15 (16 |17 (18 |19 (20 |21 (22 |23
Value| = |3 |5 |5 |5 |5 |5 |5 |5 |5 |5 |5 |2 |55 |5 |5 |5 |5 |5 |5 |5 |5 |5

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Hou Dec

Figure 3.5 Schedule Input Data
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Schedule Input Data
Example Problem 044 2/2002
Carrier Carporation 05 564N

Occupants (Fractional)

Hourly Profiles:

1:5chool_In_Session

Hour |00 |04 (02 |03 (04 (05 |06 (OF (05 |09 (10 (11 |12 |13 (14 |15 |16 (17 |18 (19 |20 |21 |22 (23
Value| O |0 | O [0 |0 |0 [0 100100 |100 100 [100 (100 100 100 (100 100 00 (0 JO (0O [0 |0 |0

2WeekendHoliday

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 [14 [15 (16 |17 (18 |19 (20 |21 (22 |23
Valwe( O (O |O |0 |0 OO o oo (o fO0 (OO0 |0 |0 0O |00 |0 o (0|0

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Hou Dec

Fan / T-Stat Schedule (Fan ! Themmostat)

Hourly Profiles:

1:5chool_In_Ses=sion

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 [14 [15 (16 |17 (18 |19 (20 |21 (22 |23
Valpe U | U (U U (U U (OO [ |0 |0 (D |00 |0 (O |0 [0 |0 [0 O |3 |Uu U

2WeekendHoliday

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 |14 (15 (16 |17 (18 |19 (20 |21 |22 |23
Valge U | U (U U (U U (U0 U [ (U |0 (U 0w (o Uy uju

0 = Occupied U = Unoccupied

Assignments:
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Hov Dec
Design| 1 1 1 1 1 1 2 1 1 1 1 1
Figure 3.5 Schedule Input Data (Continued)
Door Constructions
Example Problem 044 2/2002
Carrier Carporation 090540

Stile and Rail Door

Door Details:
Gross Ated
Door U-alug

ﬂ!
BT Uihr-15-F)

Glass Details:
Glass Area 280 1it*
Glass U-Value | L1430 BTUSHr-#2°F)
Glass Shade Coefficient
Glass Shaded 2l Day?

Figure 3.6 Door Construction Data
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Roof Constructions

Example Problem 044 272002
Carrier Corporation 09 004
Roof Assembly
Roof Details
Outside Surface Color __Dark
Absorptivity 0.900
Owerall U-YYalue D056 BTUShr-12-°F)
Roof Layers Details (Inside to Outside)
Thickness Density | Specific HL. R-Value Weight
Layers in IbitE | BTU / {lb - “F} |(hr-fE-FUBTU 1b/F
nzide surface resistance 0.000 o0 000 0.EZ500 [
Acoustic tile 0.750 300 0.20 179000 18
AlF pace .00 on 000 031000 on
22 gage steel deck 0.034 4350 0.12 0.00011 1.4
T4 board insufation 200 20 022 1585559 1]
B uit-up roofing 0.375 0.0 0.35 033245 2.2
Cutzide surface resistance 0000 (2] [N ]n] 033300 an
Totals 3.159 - - 17.94 5.8
Figure 3.7 Roof Construction Data
External Shade Geometries
Example Problem 044 2/2002
Carrier Carporation 09 0540

Casement Window Reveal

Reveal Depth

Left Fin:

Overhang
Projection from surface

Ext. past RH side of wind

Right Fin:
Prajection from surface,

Diizt. from edge of windovy, |

Figure 3.8

External Shading Geometry
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Space Input Data

Example Problem 044 2/2002
Carrier Carporation 0907 &b
D101 - Typical Classroom
1. Genera Details:
Floor Ares ft=
Ay, Ceiling Height ft2
Building YWeight lkrit=
2. Intemals:
2.4, Overhead Lightinge 2.4, Peoples
Fixture Type ... Recessed (Unvented) Qccupancy People
Wattage 300 e Activity Level
Ballast MuRipher 1.08 Senzible BTt petzon
Schedule Lighting - Clasarooms Latert BTUMrinerson
Schedule
2.2. Task Lighting 2.5, Miscellaneous Loads:
Wattage LA LU Sensible 0 BTUMr
Schedule .. Hone
BTU Mr
2.3. Electrical Equipment:
Wiattane s
Schedule
3. Walls, Windows, Doors:
Exp. Wall Grose Area ) Window1 Oy, | Window2 Oty Door 1 Gy
E 2750 3 0 1]
3.4, Construction Typesfor Exposure E
‘Wall Type E xterior Wall
Tatwiindowe Type  Casement Window
1t Window Shade Type Casement Window Reveal
4. Roofs, Skylights:
Exp. Roof Gross Area {ft*) Roof Slope (deg.) Skylight Gry.
H 075 1] 1]
4.1. Construction Typesfor Exposure H
RoofType Roof Assembly
5. Infiltratione
Dresign Cooling L0 CFM
Design Heating 0o CFM
Energy Analysis Do CFM

-

7.

Infittration ocours anly when the fan is of.

. Floors
Type Slab Floor On Grade
Floor Ares 7.5 ft*

Tatal Floor U-Walug ™
Exposed Perimeter
Edge Inzulation R-\alue

4,200 BTUihe-2°F)
25t
7.0 [hr2oFLETU

Partitions:
{Ho partiion data).

Figure 3.9 D101 — Typical Classroom
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Example Problem
Carrier Carporation

Space Input Data

0401272002
0907 A0

D104 - Classroom

1. Genera Details:
Floor Ares
Ay, Ceiling Height
Building YWeight

ft=
ft=
Iift=

2. Intemals:

2.4, Overhead Lightinge
Fixture Type
Wettage
Ballazt Multiplisr
Schedule

W

Lighting - Classrooms h

2.2, Task Lighting
Wattage
Schedule

. 000 A
.. Hone

2.3. Electrical Equipment:
Wiattane
Schedule

000
. Hone

e

3. Walls, Windows, Doors:

2.4, Peoples
Qcoupancy
Activity Level
Senzible

People

BTUMtperson
BTUMrperson

2.5. Miscellaneous Loads:
Senzible

BTUMr

BTUMr

Exp. Wall Gross Area (ff*) Window1 Oy

Window 2 Crty.

Door 1 Oty

E 2720 3 0

0

5 3300 1] 0

i}

3.4, Construction Typesfor Exposure E
Wl Type
Tt Window: Type
1t Window Shade Type |

Exterior Wall
_Casement Window
Casement Window Reveal

3.2. Construction Typesfor Exposure 5

Wall Type E xterior Wall

4. Roofs, Skylights:

Exp. Roof Gross Area (f°)

Skdight Oty

H 075

0

4.1. Construction Typesfor Exposure H
Roof Type

o

. Infiltratione
Design Coaling
Design Heating
Energy Analysis
Infittration occurs only when the fan is off.

6. Floors
Type Slab Floor On Grade
Floor Ares L a0Fs T
Tatal Floor U-value

1.200 BTUNhr-1%°F)
Exposed Perimeter 605 1t

Edge Insulstion R-value LT the-ReFIET U

7. Partitions:

{Ho partiion data).

Figure 3.10 D104 - Classroom
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Space Input Data

Example Proklem 044 252002
Carrier Corporation 0907 &b
D106 - Classroom
1. Genera Details:
Floor Ares A
Ay, Ceiling Height 8. t*
Building Weight | F0.000 bt
2. Intemals:
2.4, Overhead Lighting 2.4. Peoples
Ficture Type Recesszed (Unvented) DCEUBENCY | e e People
00 A Activity Level
Biallazt hutipher Senzible BT hrierson
Schedule Latert BTUMrherzon
Schedule |
2.2. Task Lighting 2.5. Miscellaneous Loads:
Wattage R Sensible BTUMr
Schedule Schedule Hone
BTU Mr
2.3. Electrical Equipment:
Wattage Ml
Schedule

3. Walls, Windows, Doors:

Exp. Wall Gross Area (ff*) Window1 Oy Window 2 Crty. Door 1 Oty
2750 3 0 1]
S 3300 1] 0 1]
E 1100 i 0 1]
3.4, Construction Typesfor Exposure W
Wall TYRe Exterior Wall
1t Windowe Type
1t Window Shade Type Casermnent Window Reveal
3.2. Construction Typesfor Exposure 5
WL TYRE Exterior Wall
3.3. Construction Typesfor Exposure E
WL TYRE e, Exterior Wall
4. Roofs, Skylights:
Exp. Roof Gross Area (f°) Roof Slope (deq.) Skdight Oty
H 07 .5 1] i
4.1, Construction Typesfor Exposure H
ROOETYRE Roof Assembly
5. Infiliratione

Design Cooling
Dezign Heating
Energy Analysis
Infittration occurs only

6. Floors
Type Slab Floor On Grade
Floor A 9075 it
Total Floor U

1200 BTUihr-15°F)
M5t
7.0 the-tFLETU

Edae Insulation R-walug

7. Partitions:
{Ho partiion data).

Figure 3.11 D106 - Classroom
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Space Input Data

Example Problem 044 2/2002
Carrier Corporation 09:07 A4

D107 - Classroom

1. Genera Details:

Floor Ares ft=
Ay, Ceiling Height 1tz
Building Wweight lhift®
2. Intemals:
2.4, Overhead Lighting 2.4, People:
Fixture Type Qcocupancy .25 People
R Activity Level
SenEble 230.0 BTUhriperzon
Latert 120.0 BTUhrierson
Schedule
2.2, Task Lightinge 2.5, Miscellaneous Loads:
Wattage R Sensible BTUMr
Schedule Schedule
Latert 0 BTUMr

2.3. Electrical Equipment:
Wattage
Schedule

L

3. Walls, Windows, Doors:

Exp. Wall Gross Area (ff*) Window1 Oy Window 2 Crty. Door 1 Oty

Wy 2750 3 0 1]

3.4, Construction Typesfor Exposure W

Wall Type E xterior Wall

Tatwiindowe Type . Casement Window

1stwindow Shade Type Casement Window Reveal
4. Roofs, Skylights:

Exp. Roof Gross Area (&) Roof Slope (deq.) Skylight Oty
H 075 1] a

4.1, Construction Typesfor Exposure H

ROOETYRE Roof Assambly
5. Infiliratione

Dresign Coaling o CFM

Design Heating 0.0 CFM

Energy Analysis o CFM

Infittration ocours only when the fan is off.
6. Floors

Type Slab Floor On Grade

Floor Srea B0FSs At

Total Floor U-Yalue 1.200 BTUihe-f2-"F)

Expozed Perimeter 275 ft

Edge Inzulation R-Yalue T [he-r=FuBTU

7. Partitions:
{Ho partition data).

Figure 3.12 D107 - Classroom
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System Design Example Problem

Space Input Data

Example Problem 044 2/2002
Carrier Corporation 09:07 A4
D108 - Music Room
1. Genera Details:
Floor Ares ft=
Ay, Ceiling Height ft=
Building Wweight lhift®
2. Intemals:
2.4, Overhead Lighting 2.4, People:
Fixture Type Qcocupancy 50 People
WM Activity Lenvel
SenEble 245.0 BTUhriperzon
Latert 205.0 BTUhrinersan
Schedule

2.2, Task Lightinge
Wattage
Schedule

i

2.3. Electrical Equipment:
Wattage
Schedule

i

3. Walls, Windows, Doors:

2.5. Miscellaneous Loads:

Senzible
Schedule
Latert

BTUMr

0 BTUMr

Exp. Wall Gross Area (ff*) Window1 Oy Window 2 Crty. Door 1 Oty
S 2420 2 0 1]
3.4, Construction Typesfor Exposure S
Wall Type E xterior Wall
Tt wiinodow Type . Casement Window
Tetwindowe Shade Type Casement Window Reveal
4. Roofs, Skylights:
Exp. Roof Gross Area (ft*) Roof Slope (deg.) Skodight Oty
H 17810 1] i
4.1, Construction Typesfor Exposure H
ROSETYRE Roof Assembly
5.
0o CFM
0.0 CFM
Energy Analysis o CFM

Infittration occurs anly when the Tan iz off

6. Floors
Type Slab Floor On Grade
Floar Area 17810

Tatal Floor U-alue =
Exposed Perimeter
Edge Inzulation R-\alue

24.2

7. Partitions:
{Ho partiion data).

1200 BTUihe-12°F)
it
LT Thrt e FLETU

Figure 3.13 D108 — Music Room
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Space Input Data

Example Problem 044 272002
Carrier Corporation 09:07 A4

D109 - Practice Room

1. General Details:

Floaor Area
Ay, Ceiling Height
Building Wweight
2. Intemals:
2.41. Overhead Lighting 2.4, People:
Fixture Type ... Recessed (Unvented) Qcoupancy Person
Wattage 300 e Activity Level OfficeWork
Ballast Multipher 1.08 SenEiblE 245.0 BT Uhriperson
Schedule Lighting - Clasarooms Latert 205.0 BTUhriperzan
Schedule
2.2, Task Lightinge 2.5, Miscellaneous L cads:
Wattage LA ILIRRRTAT 1 NS 0 BTUMr

Schedule Hone Schedule

BTUMr

2.3. Electrical Equipment:
Wiattane
Schedule

000 At
.. Hone

3. Walls, Windows, Doors:

Exp. Wall Gross Area (ff*) Window1 Oy Window 2 Crty. Door 1 Oty

Wy EE.0 1] 0 1]
S 95.0 1] 0 1]
34. Construction Typesfor Exposure W
WWEILTYRE e Exterior Wall
3.2. Construction Typesfor Exposure 5
Wall TYRE Exterior Wall
4. Roofs, Skylights:
Exp. Roof Gross Area (ft*) Roof Slope (deg.) Skadight Oty
H 55.0 1] a
4.1, Construction Typesfor Exposure H
RoofType Roof Assembly
5. Infiliratione
Dresign Cooling L0 CFM

Degign Heating 0.0 CFM
Energy Analysis 0 CFM
Infittration occurs only when the tan is off.
6. Floors
Type Slab Floor On Grade
e = 650 it*
Total Floor U N 1.200 BTUihe-f2-"F)
Expozed Perimeter RLE- I

Edge Insulstion R-Yalue

7. Partitions:
{Ho partition data).

Figure 3.14 D109 — Practice Room
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System Design Example Problem

Space Input Data

Example Problem 044 2/2002
Carrier Corporation 09:07 A4
D110 - Storage Room
1. Genera Details:
Floor Ares ft=
Ay, Ceiling Height ft=
Building Wweight lhift®
2. Intemals:
2.4, Overhead Lighting 2.4, People:
Fixture Type Qcocupancy 0 Person
WM Activity Lenvel
SenEble 245.0 BTUhriperzon
Latert 2050 BT Uhrinerson
Schedule

2.2, Task Lightinge
Wattage
Schedule

2.3. Electrical Equipment:
Wattage
Schedule

3. Walls, Windows, Doors:

2.5. Miscellaneous Loads:

it Senzible
Schedule

Latert

i

Exp. Wall Gross Area (ff*) Window1 Oy Window 2 Crty. Door 1 Oty
Wy 1210 a 0 1]
3.4, Construction Typesfor Exposure W
WEITTYRE e Exterior Wall
4. Roofs, Skylights:
Exp. Roof Gross Area (%) Roof Slope (deg.) Skyight Criy.
H 1200 1] i
4.1, Construction Typesfor Exposure H
ROOTTYRE e Roof Assembly
5. Infiltratione
Design Cooling 0o CFM
Design Heating 0.0 CFM
Energy Analyzis L0 CFm
Infittration occurs only
6. Floors
Type Slab Floor On Grade
12000 itR
Total Floor U-Yalue 1.200 BTUihr-2-"F)
Expozed Perimeter 124 ft

Edge Insulation R-Yalue

7. Partitions:
{Ho partiion data).

LT thr-tEFIETLU

BTUMr

0 BTUMr

Figure 3.15 D110 — Storage Room
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Space Input Data
Example Problem 044 2/2002
Carrier Corporation 09:07 A4
D111 - Office

1. Genera Details:

Floor Ares ft=
Ay, Ceiling Height ft=
Building Wweight lhift®
2. Intemals:
2.4, Overhead Lighting 2.4, People:
Fixture Type Qcocupancy 1 Person
WM Activity Lenvel

Senzible 245.0 BTUhriperzon

Latert 205.0 BTUhrinersan
Zchedule
2.2, Task Lightinge 2.5, Miscellaneous Loads:
Wattage it Senzible BTUMr
Schedule Schedule
Latert 0 BTUMr

2.3. Electrical Equipment:
Wattage
Schedule

i

3. Walls, Windows, Doors:

Exp. Wall Gross Area (%) Window1 Oy Window 2 Oy, Door 1 Oty

Wy 1320 1 0 1]
3.4, Construction Typesfor Exposure W
Wall Type E xterior Wall
Tt wiinodow Type . Casement Window
1etwindowe Shade Type Casement Window Reveal
4. Roofs, Skylights:
Exp. Roof Gross Area {ft*) Roof Slope (deg.) Skylight Gry.
H 174.0 1] i
4.1, Construction Typesfor Exposure H
RODTTYRE o Roof Assambly
5.
0.0 CFM
.0 CFM
Energy Analysis .0 CFM
Infittration occurs only when the tan is off.
6. Floors
Type Slab Floor On Grade
Floor Area 14 At
Total Floor U-Yalue 1.200 BTUihe-f2-"F)
Expozed Perimeter 32 1t

Edge Inzulation R-\alue 7.0 (hr-t*oFuBETU

7. Partitions:
{Ho partiion data).

Figure 3.16 D111 - Office
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Space Input Data

Example Problem 044 2/2002
Carrier Corporation 09:07 A4
D113 - West Comidor
1. Genera Details:
Floor Ares ft=
Ay, Ceiling Height 1tz
Building Wweight lhift®
2. Intemals:
2.4, Overhead Lighting 2.4, People:
Fixture Type Recessed (Unvented) Qcocupancy 0 Person
Wattage AL Activity Level
Ballast Multipher 1.08 SenEble 230.0 BTUhriperzon
Lighting - Comidors Latert 1A BTUhriperson
Schedule
2.2, Task Lightinge 2.5, Miscellaneous Loads:
Wattage LR T Sensible BTUMr
Schedule .. Hone Schedule
BTU Mr
2.3. Electrical Equipment:
Wattage LU
Schedule .. Hone

3. Walls, Windows, Doors:
{Ho Wall, Window, Door data).

4. Roofs, Skylights:
Exp. Roof Gross Area (ft*) Roof Slope (deg.) Skodight Oty
H 1054.0 1] 1]
4.1. Construction Typesfor Exposure H
RoofType Roof Assembly
5. Infiltratione
Design Cooling 0.0 CFM

Diesign Heating Toan CFM
Erergy Analysis 0.0 CFM
Infittration occurs only when the tan iz off.

6. Floors
Type Floor Above Conditioned Space

{Ho additional input required for this floor type).

7. Partitions:
{Ho partiion data).

Figure 3.17 D113 — West Corridor
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Space Input Data

7. Partitions:
{Ho partiion data).

{Ho additional input required for this floor type).

Example Problem 044 2/2002
Carrier Corporation 09:07 A4
D114 - South Corridor
1. Genera Details:
Floor Ares ft=
Ay, Ceiling Height 1tz
Building Wweight lhift®
2. Intemals:
2.4, Overhead Lighting 2.4, People:
Fixture Type Recessed (Unvented) Qcocupancy 0 Person
Wattage AL Activity Level
Ballast Multipher 1.08 SenEble 230.0 BTUhriperzon
Lighting - Comidors Latert 120.0 BTUhrierson
Schedule
2.2, Task Lightinge 2.5, Miscellaneous Loads:
Wattage LR T Sensible BTUMr
Schedule .. Hone Schedule
Latert 0 BTUMr
2.3. Electrical Equipment:
Wattage LU
Schedule .. Hone
3. Walls, Windows, Doors:
{Ho Wall, Window, Door data).
4. Roofs, Skylights:
Exp. Roof Gross Area (ft*) Roof Slope (deg.) Skodight Oty
H 920.0 1] 1]
4.1. Construction Typesfor Exposure H
RoofType Roof Assembly
5. Infiltratione
Dresign Coaling o CFM
Dresign Heating 00 CFM
Erergy Analysis 0.0 CFM
Infittration occurs only when the tan iz off.
6. Floors
Type Floor Above Conditioned Space

Figure 3.18 D114 — South Corridor
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Space Input Data

Example Problem 044 2/2002
Carrier Corporation 09:07 A4
D105 - South Vestibule
1. Genera Details:
Flook Srea 73.0_ ft
Ay, Ceiling Height 1tz
Building Wweight lhift®
2. Intemals:
2.4, Overhead Lighting 2.4, People:
Fixture Type Recessed (Unvented) Qcocupancy 0 Person
Wattage AL Activity Level
Ballast Multipher 1.08 SenEble 230.0 BTUhriperzon
Lighting - Comidors Latert 120.0 BTUhrierson
Schedule
2.2, Task Lightinge 2.5, Miscellaneous Loads:
Wattage LR T Sensible BTUMr
Schedule .. Hone Schedule
Latert 0 BTUMr
2.3. Electrical Equipment:
Wattage LU
Schedule .. Hone
3. Walls, Windows, Doors:
Exp. Wall Gross Area (ff*) Window1 Oy Window 2 Crty. Door 1 Oty
S 110.0 1] 0 2
3.4, Construction Typesfor Exposure S
Wall Type E xterior Wall
Dot Type ... Stile and Rail Door
4. Roofs, Skylights:
Exp. Roof Gross Area (%) Roof Slope (deg.) Skyight Criy.
H 730 1] 1]
4.1, Construction Typesfor Exposure H
ROOFTYRE e, Roof Assembly
5. Infiltratione
Deszign Cooling 18.0 CFMm

Design Heating
Energy Analysis
Infittration occurs &t sl hours.

6. Floors
Type Slab Floor On Grade
Floor Area 730 it
Tatal Floor U-value 1.200 BTUShe-f="F)

1.0t

Exposed Perimeter 1
R fhr-eFuETU

Edge Inzsulation R-Yalue

7. Partitions:
{Ho partiion data).

Figure 3.19 D105 — South Vestibule
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Space Input Data
Example Problem 044 2/2002
Carrier Carporation 0907 &b

D112 - West Vestibule

1. General Details:

Floor Ares 63.0 ft*
e
lkift2
2. Intemals:
2.1, Overhead Lighting 2.4. Peoples
Fixdture Type . Recessed Unvented) Qccupancy 0 Person
Wattage oo win Activity Level Seated at Rest
Ballast Mulipher SIS 2300 BTUhtperson
Schedule Latert BTUMrherzon
Schedule
2.2. Task Lighting 2.5. Miscellaneous Loads:
Wattage LA LU Sensible 0 BTUMr
Schedule Schedule
Lot et BTU Mr
2.3. Electrical Equipment:
it

Schedule

3. Walls, Windows, Doors:

Exp. Wall Gross Area (ff*) Window1 Oy Window 2 Crty. Door 1 Oty

Wy 5.0 1] 0 2
3.4. Construction Typesfor Exposure W
Wall Type E xterior Wall
Dot Type ... atile and Rail Door
4. Roofs, Skylights:
Exp. Roof Gross Area (f°) Roof Slope (deq.) Skdight Oty
H E5.0 1] 1]
4.1, Construction Typesfor Exposure H
ROOFTYRE e, Roof Assembly
5. Infiltratione
Deszign Cooling 180 CFm
Design Heating V2P0 CFM

Energy Analysis

18.0 CFM
Infittration ocours &t sl hours.

=,

. Floors
Type Slab Floor On Grade
68.0  fit*

1.200 BTUihr-2°F)
8.8 1t

Tatal Floor U-*alue =
Expozed Perimeter

___________ U hetreFuBTU
T. Partitions:
{Ho partiion data).

Figure 3.20 D112 — West Vestibule
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Packaged Rooftop AHU Input Data

Froject Mame: Example Proklem 04/ 272002
Prepared by: Cartier Corporation 09 2540

1. Genera Details:
Ajy System Mame
Equipment Clazs
Air Systemn Type

Number Df B et e e e e e e et ettt 11
2. System Components:
Ventilation Air Data:

Airflowy Contral .. Constant Yentilaton Arflow

Design Arflow
Uroce. Damper
Damper Lesk Rate

L3420 CRM
Clo=ed

Economizer Data:
Control
Upper Cotaff
Lower Cutoff

Preheat Coil Data:
Setpoint 52.0 °F
Heating Source . Combustion - Hatural Ga
Schedule JFMAMLIASOHD

Coil position

Cenfral Cooling Data:

Supply Air Temperature
Coil BypassFactar |
Cooling Source
Schedule

....Forward Curved with Wariable Frequency Orive
Drawthru

300 inwg

% Airflow| 100 a0 &0 40 20 a0
Yo kW 100 G0 35 19 g 3

Duct Systermn Data:
Supply Duct Data:

Duct Heat Gain |
Duct Leakage

Return Duct or Plenum Data:
Return Air via ___Retum Air Plenum

Wall Heat Gair o Pigriam L2 %
Roof Hest Gainto Plenum i %
Lighting Heat Gain ta Plenum 30 %

Figure 3.21 Packaged Rooftop AHU Inputs
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3. Zone Components:
Space Assignments:

Zone 1: D101 - Classroom
OT07 - Typical Clazsroom | E4l
Zone 2: M02 - Classroom
D107 - Typical Classroom | Fal
Zone 3: D103 - Classroom
O07 - Typical Clazsroom | 1
Zone &: D104 - Classroom
D04 - Clas=sroom [ =T
Zone 5: 0106 - Classroom
0106 - Clazsroom S
Zone B D107 - Classroom
D107 - Clazsroom [ =l
Zone 7: D108-111 Music Room
D105 - Music Room S|
D09 - Fradice Foom Edl
D70 - Slorage Room Edl
D111 - Cffice %1
Zone 3: D113 - West Comdor
D113 - West Corricar [ =l
Zone 3: 0114 - South Comidor
D114 - South Carridor S
Zone T0: 105 - South Vestibule
D05 - South Yestihule [ =T
Zone 11: 112 - We st Vestibule
D712 - West Vedibule [T
Thermo=stats and Fone Data:
Tone
Cooling T-stat: Occ. °F
Coaling T-stat: Unocc. .0 °F
Heating T-stat: Occ. 720 °F
Hesting T-ztat: Unocc. 600 °F
T-stat Thrattling Range 3.00 °F
Diversity Factar A0 %
Drirect Exhaust Airflow 0 CEm
Direct Exhaust Fan kW 0.0 KV
Thermastat Schedule __Fan [ T-5tat Schedule
Unocoupied Cooling is Available
Supply Terminals Data:
Fan Design Supply
Zone Terminal Type Min Airflow Fan Perfomance | Efficiency Temperature
1 PFFPMBX with RH 15.00 CF MJperson 0.50in wgy 50 % 110.0°F
2 PFFMBX with RH 15.00 CF Miperson 0500wy 50 % 110.0°F
3 PFFPMB?X with RH 15.00 CFMiperson 0.500in wy 50 % 110.0°F
4  |PFPMBX with RH 15.00 CF MJperson 0.50in wgy 50 % 110.0°F
5 PFFPMB?X with FH 15.00 CF MJperson 0500wy a0 % 110.0°F
6 PFFMBX with RH 15.00 CF Miperson 0500wy 50 % 110.0°F
7 FFFMBEX with RH 15.00 CFMjperson 0.300in wy a0 % 110.0°F
] FFFMBEX with RH 0.05 CF Mt 0.300in wy a0 % 110.0°F
9 PFFMBX with RH 0.05 CFM it 0500wy 50 % 110.0°F
10 [PFPMBX with RH 0.05 CF Mt 0.300in wy a0 % 110.0°F
11 [PFPMBX with RH 0.05 CFMIft2 0.50in wgy 50 % 110.0°F

Rehest Coil Schedule

R eheat Coil Source

Electric Resistance

Zone Heating Units:

JFMAMJJASOND

AN

Figure 3.21

Packaged Rooftop AHU Inputs (continued)
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Fong Unit Heat Source Hot Water

4, Sizing Data (Computer-Generated):

System Sizing Data:

Hydronic Siang Specifications:
Chilled \Water Delta-T 1o °F
Hat Wiater Delta-T

Safety Factors:
Coaling Sensible
Cooling Latent
Heating

B et

Zone Sizing Data:
Zone Airflovy Sizing Method
Space Arflove Sizing ethod

. Individual peak space loads

Figure 3.21 Packaged Rooftop AHU Inputs (continued)

Air System Sizing Summary for Packaged Rooftop AHU
Project Mame: Example Problem 044 272002
Frepared by Cartier Corporstion 00420

Air System Information
Ajr System Mame
Equipment Clazs
Air Systemn Type

Packaged Rooftop AHU Mumber of zones N
PKG ROOF Floor Area

Sizing Calculation Information
Zoneand Space Sizing Method
Tone CFM Peak zone sensible load Calculation Months

Mayto How
Sizing Data Calculated

Central Cooling Coil Sizing Data
Tatal coil load 321 Tons Load ooours &t _Aug 1600
Total coil load 3849 MBH CADBMWE 0740 °F
Senzible coil load | 275.2 MBH Entering DB 1"WB 86.5/689 °F
Coil CFMat Aug 1600 T815 CFM Leaving DB fWE 53117524 °F
e block CFM at Aug 1700 8445 CFM Coil ADP 514 CF
Sum of peak rone CFM G586 CFM Bypass Factor
Senzible heat retio 0.715 Fezulting RH

ft23Ton 3024 Design supply temp. 550 °F
BTUfhr-#7) Zone T-stat Check 1M of 11 OK
Wwizter flawe @ 10.0°F rise Max zone temperature devation N
Preheat Coil Sizing Data
Maw coil load | MEBH Load ocoursat ., Des Htg
Coll CFM et Des Hg CFM Ent.CB fLvalB -6.0/52.0 °F
Max ool CFM CFM
Water flowe @ 200°F drop
Supply Fan Sizing Data
Actual mae CEM at Aug 1700 Fan motor BHP .38 BHFP
Standard CFW Fan motar kW .60 kWY
Actual max CFMIf? Fan static L300 inag
Outdoor Ventilation Air Data
Dresign airflow CFh CRWURErSON 15.55 CFMiperson
CFM I

Figure 3.22 Air System Sizing Summary Report
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Zone Sizing Summary for Packaged Rooftop AHU

Froject Mame: Example Proklem 044 272002
Frepared by Carter Corporation 100420
Sizing Calculation Information
Zoneand Space Sizing Method
Fone CFh Peak zone sensible load Calculation Months
Sizing Data Calculated
Zone Sizing Data
Maximum Design| Minimum Time| Maximum Fone
Cooling Air Air of Heating Floor
Sendble Flow Flow Peak Load Area Zone|
Zone Hame (MBH) (CFM) (CFM) Load (MBH) (%) CFMM?
D101 - Classroom 169 G642 375 Jun 1600 125 EVR 0493
D102 - Clagsroom 169 G42 375 Jun 1600 125 EIVRE 0.93
D103 - Classroom 16.9 a42 375 Jun 1600 12.5 07 5 0.93
D104 - Classroom 17.2 EEE] 375 Aug 1600 16.1 07 5 0.95
D106 - Classroom 198 EEE] 375 Aug 1700 17.3 07 5 1.09
D107 - Classroom 1941 a52 375 Aug 1700 125 EE 1.05
0108-111 Music Room 34 .4 17185 a0 Aug 1700 236 21400 0.50
D113 - West Corricor 9.1 455 a3 Jun 1600 25 10540 0.43
0114 - South Corridor g0 397 45 Jun 1600 4.5 9200 0.43
0105 - South Westibule E.5 34 4 Sep 1400 a7 730 4 57
D112 -West Vesdtibule El] 351 4 Jun 1700 95 E5.0 516
Zone Terminal Sizing Data
Reheat Zone Zone
Reheat Coil Htg Htg Mizing|
Coil Water Coil Water Box Fan
Load gpm Load gpm Airflow|
Zone Hame (MBH)| @@ 20.0 °F (MBH) @ 20.0 °F {CFM)
D01 - Classroom 182 - [iKi] 0.0o0 236
D102 - Classroom 19.2 - 0o .00 238
D103 - Classroom 192 - 0.0 0.0o 236
D104 - Classroom 229 - 0.0 0.0o 306
D106 - Classroom 240 - [i] 0.00 328
D107 - Classroom 182 - [i] 0.00 236
D108-111 Music Room 376 - i) 0.00 447
D113 - West Corridor 64 - [ilx] 0.00 104
0114 - South Corridor B - i3] 0.00 91
0105 - South Wesibule EE] - i3] 0.00 185
D112 -West Vesdtibule EX - i3] 0.00 180

Figure 3.23 Zone Sizing Summary Report

HAP Quick Reference Guide

3-29




Chapter 3 System Design Example Problem

Zone Sizing Summary for Packaged Rooftop AHU

Froject Mame: Example Proklem 04/ 272002
Prepared by: Cartier Corporation 00420

Space Loads and Airflows

Cooling Time Air Heating Floor

Zone Hame [ Sensible of Flow Load Area Space

Space Hame Muit ({MBH) Load (CFM) ({MBH) (Ft5) CFMIFE
D107 - Clzssroom

D101 - Typical Classroom 1 169 Jur 1600 G642 125 075 0.a3
D102 - Classroom

D101 - Typical Classroom 1 169 Jur 1600 G642 125 075 0.a3
D103 - Classroom

D101 - Typical Classroom 1 169 Jur 1600 G642 125 075 0.a3
DF - Classroon

D104 - Clagsroom 1 17.2 Aug 1600 859 161 075 0.a5
D706 - Chassroon

D106 - Clagsroom 1 189.8 Aug 1700 55 173 07 .5 1.09
D107 - Classroom

D107 - Classroom 1 [EX] Aug 1700 952 125 075 1.05
DT08-T17 NVissic Room

D108 - Music Room 1 288 Sep 1500 1438 157 17810 0.51

D109 - Practice Room 1 1.0 Aug 1700 49 20 65.0 076

D110 - Storage Room 1 141 Jun 1700 a7 20 1200 047

D111 - Dffice 1 39 Aug 1700 195 38 174.0 112
D113 - West Conidor

D113 - West Corridor 1 9.1 Jun 1E00 455 55 10540 0.43
D114 - Soath Corridor

D114 - South Corridor 1 0] Jun 1800 397 45 9200 0.43
D105 - Sounth Vestibub

D105 - South Westibule 1 6.5 Sep 1400 34 97 730 4 57
D112 - West Vestibuk

D112 - West Wedibule 1 El] Jur 1700 351 EE] 65.0 516

Figure 3.23 Zone Sizing Summary Report (continued)
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Chapter 4 Energy Analysis Example Problem

This chapter contains a simple example problem which demonstrates how to use HAP to estimate annual
energy use and cost for a building. The example builds on concepts and procedures discussed in
Chapters 1 and 2. Note that these energy analysis features are available in HAP but not in HAP System
Design Load.

4.1 OVERVIEW FOR THE EXAMPLE PROBLEM

The procedure for conducting an energy analysis with HAP involves five steps previously discussed in

Chapter 1:

1. Define the Problem.

2. Gather Data.

3. Enter Data Into HAP.

4. Use HAP to Generate Simulation Reports.
5. Evaluate the Results.

The example problem presented in this chapter will demonstrate the first four steps in this process. In the
remainder of this chapter a separate section will deal with each step.

4.2 DEFINING THE PROBLEM

The objective of this example problem is to estimate annual energy use and energy cost for a building.
Normally an energy analysis compares energy use and cost for two or more design scenarios. To make
this example practical and efficient, the scope of the example will be limited to estimating energy use and
cost for a single design scenario. This will demonstrate the key steps in the energy analysis process. In a
real energy study, certain of the steps would be repeated to generate the additional design scenarios being
evaluated.

The example will analyze the classroom wing of the high school building used in the system design
example problem discussed in Chapter 3. The floor plan for this wing of the school building is shown in
Figure 4.1. It is comprised of six classrooms, a music room and its associated office, storage and practice
rooms, plus two corridors and two doorway vestibules for a total of 14 rooms.

The rooms in this portion of the school building will be air conditioned by one packaged rooftop unit
serving parallel fan powered mixing box (PFPMBX) terminals. A gas-fired preheat coil in the rooftop
unit and electric resistance heating coils in the mixing box terminals provide heating. HAP will be used
to simulate building loads and equipment operation hour-by-hour for one year in order to determine
energy use and energy cost.
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Figure 4.1 Floor Plan for School Building

4.3 GATHERING DATA

The second step in the analysis process is to gather information necessary to model heat transfer processes
in the building, to analyze operation of the HVAC equipment and to calculate costs for energy and fuel
use. This involves gathering data for the building, its environment, the HVAC equipment and the utility
rate structures. Below, each type of data will be discussed.

4.3.1 Gathering Weather Data

The same design weather conditions used in the system design example problem in Chapter 3 will be used
here: ASHRAE design weather conditions for Chicago O’Hare International Airport, plus daylight
savings time specifications and cooling design calculation months (see Figure 3.2).

For the energy analysis, simulation weather data will also be needed. This is observed weather data for a
typical year spanning all 8,760 hours in the year. We will use the Typical Meteorological Year (TMY)
weather file for Chicago O’Hare International Airport as the source of this data. This data is provided in
the library of HAP simulation weather data.

In addition, the operating calendar for the year must be specified. We will use a calendar with January 1*
falling on a Tuesday and having the following days designated as holidays:
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Table 4.1 Calendar of Holidays

January 1 New Year’s Day

April 15-19 Spring Holiday

May 27 US Memorial Day

June 22 — August 11 Summer Holiday

September 2 US Labor Day

November 28, 29 US Thanksgiving Holiday
December 23 — 31 Christmas/New Year Holiday

4.3.2 Gathering Space Data

Data describing the heat transfer elements of each room in this wing of the building will be the same as
described in Chapter 3, section 3.3.2. This discussion in Chapter 3 covers wall, roof, window, door,
external shade, schedule and space data.

The only adjustment needed for energy analysis will be the assignment of schedule profiles to days of the
week and times of year. The “School In Session” profiles for each schedule will be assigned to
weekdays in all 12 months. The “Weekend/Holiday” profiles for each schedule will be assigned to
Saturday, Sunday and Holidays in all 12 months. Because we have designated the June 22 to August 11
summer shutdown period as “holidays” we do not need to create separate profiles representing operation
during the shutdown days. This expanded schedule data is shown in Figure 4.3.

4.3.3 Gathering Air System Data

One VAV packaged rooftop unit will provide air-conditioning to the rooms in this wing of the school
building. Heating will be provided by a gas-fired preheat coil in the rooftop unit and electric resistance
coils in the parallel fan powered mixing box terminals. Data defining this air system equipment is the
same as described in Chapter 3, section 3.3.3.

Because we are performing an energy analysis, performance data for the DX cooling apparatus and the
gas-fired preheat coil will need to be added to this system data. Results from the system design
calculations in Chapter 3 established the following sizing requirements:

Required cooling capacity of 384.9 MBH total and 275.2 MBH sensible.
Outdoor air temperature at peak cooling coil load of 91 F.

Entering cooling coil conditions of 86.5 F dry-bulb and 68.9 F wet-bulb.
Required preheat capacity of 191.7 MBH.

Required supply fan airflow rate of 8445 CFM.

These requirements were used to select a sample packaged rooftop unit. Performance data and associated
product data for this rooftop unit is as follows:

Design outdoor air temperature =91 F.

Gross cooling capacity = 427 MBH, gross sensible cooling capacity = 289 MBH
Compressor and condenser fan input power = 42.5 kW

Outdoor air temperature for start of head pressure control = 55 F

Outdoor air temperature for unit shutoff =15 F

Gross heating capacity = 304 MBH

Efficiency for gas-fired heat exchanger = 82%
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4.3.5 Gathering Electric Rate Data

The General Service electric rate structure for the local utility company is defined as follows:

Monthly Customer Charge

The Monthly Customer Charge shall be................cc.ccoeevevevnnan... $40.00

Demand Charge

Charge per kilowatt for all kilowatts of Maximum Demand for the month:
For Summer MONEAS ............cccooeeeeeeeieeeeeeeeeeeeeeeeeeee $314.50
For Winter MORERS. ..............c.ccccoceeoiieieneieieeeeeeee e $11.25

For purposes of the demand charge, the Summer Months shall be the customer’s first billing period with
an ending meter reading on or after June 15 and the three succeeding monthly billing periods.

Energy Charge
Charge per kilowatt-hour for kilowatt-hours supplied in the month:

For the first 30,000 kilowatt-hours.............ccccccccevveveenannne. $0.04247
For the next 470,000 kilowatt-hours...........cccceeeeeeeeeeaeeeeanenn. $0.03167
For all over 500,000 kilowatt-hours ...............cccccoveveeeneneeenen. $0.03118

Maximum Demand
The Maximum Demand shall be the highest 30-minute demand established at any time during the month.

Minimum Charge
The minimum monthly charge shall be the Monthly Customer Charge.

4.3.6 Gathering Fuel Rate Data

The packaged rooftop unit uses gas heating equipment so a fuel rate for natural gas must be defined. The
General Service natural gas rate structure for the local utility company is defined as follows:

Monthly Customer Charge
The Monthly Customer Charge shall be...............cccccevcvvivoennnne.e. $22.00

Distribution Charge
Charge per Therm for natural gas supplied in the month:

For the first 100 TRerms ............c..ccooeueeeeeeceeeeeeeeeeeeeennn. $30.22360
For the next 4,900 Therms ... 30.11500
For all over 5000 Therms ..........ccccooeeeenceeieniiieeiiaeeee $0.05329
Gas Charge
Charge per Therm for natural gas supplied in the month:
FOr @l TREFMLS ..o 30.39650

Minimum Charge
The minimum monthly charge shall be the Monthly Customer Charge.

4.4 ENTERING DATA

Once input data has been gathered, it is entered into HAP. This is the third step in the analysis process.
The procedure for entering data into HAP is presented below in a tutorial format.

1. Program Setup

« (Optional) If you are running HAP and switched to System Design mode for system design work,
you must switch back to full HAP mode in order to perform energy analysis work. To activate
energy analysis features, choose “Options” on the View Menu, click on the “Other Options” tab
and then check the “Enable Energy Analysis Features” check box.
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2. Project Setup

(Optional) If you only wish to view this example rather than entering all the data yourself, you
can use archive data for the example problem which is provided on the HAP CD. To use this
archive file:

» Copy the Example.E3A file from the \Example folder on the CD to the \E20-II\Archives
folder on your computer.

» Using Windows Explorer, right-click on the Example.E3A file after it has been copied.
Select the “Properties” option on the pop-up menu that appears. In the Properties dialog that
appears, uncheck the “Read-Only” check box. Then press OK.

» Run HAP. Use the New option on the Project Menu to create a new untitled project. Then
use the Retrieve option on the Project Menu to retrieve the data from the Example.E3A
archive. Finally use the Save option on the Project Menu to save the project. Use the project
name “Example Problem”.

»  Skip to step 3 below.

If you already performed the system design portion of this example problem (Chapter 3), then a
project already exists containing example problem data. In this case use the Open option on the
Project Menu to open the project.

If you did not work through the system design portion of the example, choose New on the Project
menu. This creates a new project. Then choose Save on the Project Menu. Name the project
“Example Problem”. From here on, periodically save the project as you enter data.

3. Enter Weather Data

Click the “Weather” item in the tree view panel in the main program window. A “Weather
Properties” item appears in the list view panel.

Double click on the “Weather Properties” item in the list view. The Weather input form will
appear.

On the General tab enter design weather parameters as shown in Figure 3.2 in Chapter 3. If you
previously worked through the system design example problem in Chapter 3, this design weather
data will already exist and does not need to be re-entered.

Next click on the Simulation tab to define simulation weather data and operating calendar data.

Press the “Change City” button to select simulation weather data. This will display the “Select
City” dialog listing simulation weather files in the \E20-II\Weather folder. In this folder, choose
the USA_Illinois Chicago.HW1 file. It contains simulation weather data for Chicago. If you did
not copy simulation weather files to this folder ahead of time, you will need to load the data from
the HAP CD. To do this, insert the HAP CD in your CD drive. Then, enter “d-\weather” in the
“File Name” item on the Select City dialog where d: is the drive letter for your CD drive. This
will display a list of all simulation weather files in the HAP library. Locate and select the
USA_lllinois Chicago.HW1 file.

After returning to the Weather form, specify the day of the week for January 1% as Tuesday. Also
select the holidays shown in Figure 4.2

Finally, press the OK button to save the data and return to the HAP main window.

4. Enter Space Data

If you previously worked through the system design example problem in Chapter 3, then data for
spaces and associated walls, roofs, windows, doors, external shades and schedules has already
been defined. Only modifications to schedule data will be required as described in step 5 below.
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e On the other hand, if you did not work through the system design example problem, enter the
space data shown in Figures 3-9 through 3-20 in Chapter 3. Associated wall, roof, window, door,
external shade and schedule data is shown in Figures 3.3 thru 3.8. While entering this data press
F1 or the Help button if you have questions about input items or procedures.

Modify Schedule Data

The entry of schedule data described in Chapter 3 only covered data for system design applications.
For energy analyses, profiles within the schedule must be assigned to the days of the week and times
of year. Repeat the following steps for each of the four schedules in this example problem:

« Edit the schedule.

o Click on the assignments tab. Assign the “School In_Session” profile to Monday through Friday
for all 12 months. Assign the “Weekend/Holiday” profile to Saturday, Sunday and Holidays for
all 12 months. This data is shown in Figure 4.3. For helpful hints on quickly entering this data,
please refer to the online help system by pressing “Help” or F1 while on the Schedule form.

Enter Air System Data

If you previously worked through the system design example problem in Chapter 3 then you only
need to add equipment performance data for the gas-fired preheat coil and the DX cooling apparatus.
To add this data, edit the Packaged Rooftop AHU and enter the data described below.

If you did not work through the system design example, enter the system data shown in sections 1
through 4 of Figure 4.4. If you have questions about input data or procedures, press F1 or the Help
button on the System form.

Next enter the equipment performance data as described below.
o Go to the Equipment Tab on the System form.

o Press the “Edit Equipment Data” button opposite “Preheat Unit”. On the Equipment dialog that
appears enter data for the preheat coil shown in section 5 of Figure 4.4. Then press OK to return
to the System form.

o Next press the “Edit Equipment Data” button opposite “Central Cooling Unit”. On the
Equipment dialog that appears enter data for the DX cooling equipment shown in section 5 of
Figure 4.4. Then press OK to return to the system form.

« Finally press OK to save the system inputs and return to the HAP main window.
Enter Electric Rate Data

e Click on the “Electric Rate” item in the tree view panel in the main program window. Electric
Rate information will appear in the list view panel.

o Double-click on the <new default electric rate> item in the list view panel. The Electric Rate
input form will appear.

« Enter data for the electric rate shown in Figure 4.6. While entering data press F1 or the Help
button if you have questions about input items or procedures.

The electric rate described in section 4.3.5 contains a customer charge and a minimum charge.
Seasonal scheduling is used with a 4-month summer season running from June through
September. The energy charge is a “declining block™ type of charge with 3 steps. Modeling of
this type of charge is discussed in section 6.13 of this manual. The demand charge is a “flat
price” type of charge with 2 steps, one for each season. This type of charge is also discussed in
section 6.13. The billing demand is equal to the measured peak demand so there are no demand
determination clauses.

« After entering the electric rate data, press the OK button to save the data and return to the HAP
main window.
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8. Enter Fuel Rate Data

Click on the “Fuel Rate” item in the tree view panel in the main program window. Fuel Rate
information will appear in the list view panel.

Double-click on the <new default fuel rate> item in the list view panel. The Fuel Rate input form
will appear.

Enter data for the fuel rate shown in Figure 4.5. While entering data press F1 or the Help button
if you have questions about input items or procedures.

The Natural Gas fuel rate described in section 4.3.6 contains a customer charge and a minimum
charge.

The fuel charge is a “declining block™ type of charge with 3 steps. Modeling of this type of
charge is discussed in section 6.13 of this manual. One wrinkle in this fuel rate is that separate
“distribution” and “gas” charges are listed. These need to be combined into one set of prices. An
easy way to do this by using the on-line calculator feature of the program. For example, for the
first step in the fuel charge enter the value 0.2236+0.3965=. When you press the “=" key the two
values will be added and the result displayed in the input cell.

Finally, there is no demand charge for this fuel rate and therefore there are also no demand
determination clauses.

After entering the fuel rate data, press the OK button to save the data and return to the HAP main
window.

9. Enter Building Data

The final data entry step involves building data. As described in Chapter 1, the building is simply a
container for all the system, plant and non-HVAC energy-consuming equipment in the building.
Because we are dealing with a packaged rooftop unit in this example, we only have system
equipment. No chilled water, hot water or steam plant equipment is involved. Therefore, the
building contains only the Packaged Rooftop AHU air system and the electric and fuel rate pricing
structures. To enter this data:

Click on the “Building” item in the tree view panel in the main program window. Building
information will appear in the list view panel.

Double-click on the <new default building> item in the list view panel. The Building input form
will appear.

Enter data for the building shown in Figure 4.7. While entering data press F1 or the Help button
if you have questions about input items or procedures.

On the Plants tab, enter the reference name for the building as “Base Case Design”. In many
applications plants would also be included in the building. However, this example problem does
not involve plants so no further inputs are needed on this tab.

On the Systems tab, select the Packaged Rooftop AHU air system to include it in the building. A
system multiplier of 1 will be used.

The Misc. Energy tab contains inputs for non-HVAC systems which consume energy and have
not yet been accounted for. In the example problem, the only non-HVAC equipment is lighting
and it has already been accounted for in space inputs. Therefore, no data needs to be entered on
the Misc. Energy tab.

Finally, on the Meters tab, select the “General Service Electric Rate” you defined earlier for the
electric meter. Select the “General Service Gas Rate” you defined earlier for the natural gas
meter.

After entering the building data, press the OK button to save the data and return to the HAP main
window.
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At this point all input data has been entered and we’re ready to generate energy simulation reports.
Procedures for generating reports will be discussed in Section 4.5.

4.5 GENERATING SIMULATION REPORTS

The fourth step in the energy analysis procedure is to use the data entered in step 3 to perform energy
analysis calculations and generate simulation reports. The procedure for doing this is as follows:

o Click the Building item in the tree view portion of the main program window. Building information
will appear in the list view.

« Right click the “Base Case Design” item in the list view. On the menu which appears, select the
“Print/View Simulation Data” item. The Building Simulation Reports dialog will appear.

e On the Building Simulation Reports dialog, select the “Annual Component Costs” and “Monthly
Energy Use by Energy Type” options. The Annual Component Costs report will list the costs for
each system component such as fans, cooling, heating and lights. The “Monthly Energy Use” report
will list energy consumption for electricity and gas for each month of the year. These are just two of
the many useful reports offered for building simulations. They were chosen to provide a sample of
energy simulation results. The choice of simulation results depends on the information you are
seeking. Some reports compare final results for multiple buildings. Others provide more detailed
information for a single building and are used when investigating aspects of building performance.

o After selecting the reports, press the Preview. The program will determine whether system and
building calculations need to be run before generating the report. Calculations will be required the
first time you generate reports and they will run automatically. A status monitor will help you keep
track of the progress of the calculation. Once the calculation is finished your reports will be
generated and displayed in the Report Viewer.

o The Report Viewer can be used to browse and print the reports. Use the scroll bar to browse each
report document. Use the buttons on the Report Viewer toolbar to move from one report to the next.
The Annual Component Costs and Monthly Energy Use reports are shown in Figures 4.8 and 4.9.
Information about the content of these reports can be found in the program’s on-line help system.

Information about intermediate results in an energy simulation can also be obtained. These reports are
useful for investigating aspects of performance for a particular air system or plant included in the
building. For example, the following steps can be used to generate simulation reports for the Packaged
Rooftop AHU air system.

o  Click the Air System item in the tree view portion of the main program window. System information
will appear in the list view.

» Right-click the “Packaged Rooftop AHU” item in the list view. On the menu which appears, select
the “Print/View Simulation Data” item. The System Simulation Reports dialog will appear.

« On the System Simulation Reports dialog, place a check in the box in the “Table” column opposite
“Monthly Simulation Results”. Then press the Preview button. Because simulation calculations were
just run, this report will be displayed immediately. It shows monthly total loads and energy use for
all components in the air system. A copy of this report is shown in Figure 4.10. Many other report
options are provided on the System Simulation Reports dialogs and can provide useful information
when studying system performance.
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Simulation Weather Summary for Chicago, lllinois {TMY)

Carrier Corporation

Example Problem 044202002

02:05P M

Table 1. Descrptive Parameters:

City Chicago
. Minois

Longitude
Elewation
Local Time Fone (FT +i- bl hours)
Daylight Savingz Begine |
Daylight Savings Ends
Average Ground Reflectanc

Tables 2, 3, 4 not shown

Table 5. Calendar Data:

Dray of Wieek for Januaty 1t Tuesday

Holidays:

Jan 1 |

apr |15 |15 |1? |13 |19|

May |27

Jun (22193 124 |25 |26 |27 (25 (29 (30

w (12 ]s]s]s|s]7]e o i 11|12|13|14‘15|1E‘1?|18‘19|2D‘21 ‘22‘23|24‘25|2E‘2?’|28‘29|30|31‘

Aug123458?891ﬂ11‘

Sep 2
Houv |25 (25
Dec |23 |24 |25 |2E |2? |23 |29 |3|:| |31 ‘

Figure 4.2 Simulation Weather Data
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Schedule Input Data
Example Problem 044 272002
Carrier Corporation 02 09F M

Lighting - Classrooms (Fractional)

Hourly Profiles:

1:5chool_In_Ses=sion

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 |14 (15 (16 |17 (18 |19 (20 |21 |22 |23
Valwe | O |0 (O |0 (0 |0 (0 [100(100 (100 {100 (100|100 (100 100 (100 100 (100 |10 {10 (10 |10 |0 | 0O

2WeekendHoliday

Hour (00 |01 (02 |03 |04 |05 |06 (OF |05 (09 |10 (11 |12 (13 |14 [15 (16 |17 (18 |19 (20 |21 (22 |23
Valwe( O (O |O |0 |0 OO o oo (o f0 (OO O |0 |0 0O |00 |0 |o (0|0

Assignments:
Jan Feb Mar Apr May Jun Jul Aug Sep Oct How Dec
Design| 1 1 1 1 1 1 2 1 1 1 1 1
Monday | 1 1 1 1 1 1 1 1 1 1 1 1
Tuesday| 1 1 1 1 1 1 1 1 1 1 1 1
Wednesday | 1 1 1 1 1 1 1 1 1 1 1 1
Thursday | 1 1 1 1 1 1 1 1 1 1 1 1
Friday| 1 1 1 1 1 1 1 1 1 1 1 1
Saturday| 2 2 2 2 2 2 2 2 2 2 2 2
Sunday| 2 2 2 2 2 2 2 2 2 2 2 2
Holiday| 2 2 2 2 2 2 2 2 2 2 2 2

Lighting - Comidors (Fractioral)

Hourly Profiles:

1:5chool_In_Session

Hour (00 |01 (02 |03 |04 |05 |06 (O7 |08 (09 |10 (11 |12 (13 |14 (15 (16 |17 (18 |19 (20 |21 (22 |23
Value| 5 |5 |5 |5 (5 |5 (5 [100(100 (100 {100 (100 {100 (100 |100 (100 100 100 100 (100 (100 100 | 5 | &
2WeekendHoliday
Hour (00 |01 (02 |03 |04 |05 |06 (O7 |05 (09 |10 (11 |12 (13 |14 (15 (16 |17 (18 |19 (20 |21 (22 |23
Value| 5 |5 |5 |5 |5 |55 |5 |5 |5 |5 |5 Sls |5 |5 |5 |55 |55 |5 |5 |5
Assignments:
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Hov Dec
Design| 1 1 1 1 1 1 2 1 1 1 1 1
Monday| 1 1 1 1 1 1 1 1 1 1 1 1
Tuesday| 1 1 1 1 1 1 1 1 1 1 1 1
Wednesday | 1 1 1 1 1 1 1 1 1 1 1 1
Thursday | 1 1 1 1 1 1 1 1 1 1 1 1
Friday| 1 1 1 1 1 1 1 1 1 1 1 1
Saturday | 2 2 2 2 2 2 2 2 2 2 2 2
Sunday| 2 2 2 2 2 2 2 2 2 2 2 2
Holiday| 2 2 2 2 2 2 2 2 2 2 2 2

Figure 4.3 Schedule Data
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Schedule Input Data
Example Problem 044 2/2002
Carrier Carporation 02:09P M

Occupants (Fractional)

Hourly Profiles:

1:5chool_In_Session

Hour (OO (01 (02 (0F (04 |05 |06 |OF |05 |09 |10 |11 |12 (13 (14 (15 (16 |17 |13 |19 |20 | |22 |23
Value( O [0 | O |0 |0 |0 |0 |100100 100 (100 (100 (100 (100 (100 (100 Q00 Q00 )0 jo |0 |0 (@0 (0
2WeekendHoliday
Hour (OO (01 (02 (03 (04 |05 |06 |OF |05 |09 |10 |11 |12 (13 (14 (15 (16 |17 |18 [19 |20 | |22 |23
Value( O (0O |O |0 |O|O |0 O |0 |0 |0 fO0|(O|O|O |0 |0 |00 |00 |0 (00
Assignments:
Jan Feb Mar Apr May Jun Jul Aug Sep Oct How Dec
Design| 1 1 1 1 1 1 2 1 1 1 1 1
Monday | 1 1 1 1 1 1 1 1 1 1 1 1
Tuesday| 1 1 1 1 1 1 1 1 1 1 1 1
Wednesday | 1 1 1 1 1 1 1 1 1 1 1 1
Thursday | 1 1 1 1 1 1 1 1 1 1 1 1
Friday| 1 1 1 1 1 1 1 1 1 1 1 1
Saturday | 2 2 2 2 2 2 2 2 2 2 2 2
Sunday| 2 2 2 2 2 2 2 2 2 2 2 2
Holiday| 2 2 2 2 2 2 2 2 2 2 2 2

Fan / T-5tat Schedule {Fan / Thermostat)

Hourly Profiles:

1:5chool_In_Session

Hour |00 |01 |02 (03 |04 |05 (06 |OF |08 (09 |10 (11 |12 |13 (14 |15 [16 (17 |18 (19 |20 |21 (22 |23
Value| U (U (U (U (U (U (W [ [ [ (o (o (o (a (a Q[ [ ([ (o [ U U

2WeekendHoliday

Hour (00 |01 |02 (03 |04 |05 (06 |OF |08 (09 |10 (11 [12 |13 (14 |15 [16 (17 |15 (19 |20 |21 (22 |23
Value( U (U (U (U (U (U (W (W {0 {0 fu fu (o (o (o fu (o (o fufufufu

0 = Occupied U = Unoccupied

A=signments:
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Hov Dec
Design| 1 1 1 1 1 1 2 1 1 1 1 1
Monday | 1 1 1 1 1 1 1 1 1 1 1 1
Tuesday| 1 1 1 1 1 1 1 1 1 1 1 1
Wednesday | 1 1 1 1 1 1 1 1 1 1 1 1
Thursday | 1 1 1 1 1 1 1 1 1 1 1 1
Friday| 1 1 1 1 1 1 1 1 1 1 1 1
Saturday| 2 2 2 2 2 2 2 2 2 2 2 2
Sunday| 2 2 2 2 2 2 2 2 2 2 2 2
Holiday| 2 2 2 2 2 2 2 2 2 2 2 2

Figure 4.3 Schedule Data (continued)
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Packaged Rooftop AHU Input Data

Froject Mame: Example Proklem 04 272002
Prepared by: Cartier Corporation 02:16P M

1. Genera Details:
Ajr System MName
Equipment Class
Air Systemn Type
Mumber of zones 11

2. System Components:

Ventilation Alr Data:
Airflowy Contral
Design Arflow
Uroce. Damper
Damper Leak Rate

.. Constant Yentilaton Arflow
L3420 CRM
Closed

Economizer Data:
Contral
Upper Cotaff
Lower Cutoff

Preheat Coil Data:
Setpoint 52.0 °F
Heating Source | . Combustion - Hatural Ga
Schedule JFMAMLIASOHD

Coil position

Cenfral Cooling Data:

Supply Air Temperature
Coil BypassFactar |
Cooling Source
Schedule

....Forward Curved with Wariable Frequency Orive
Drawthru
300 i

% Airflow | 100 ] =] 40 20 a0
Yo kW 100 G0 33 19 ] G

Duct Systern Data:
Supply Duct Data:
Druct Heat Gain |
Duct Leakage

Return Duct or Plenum Data:
Return Air Wia ... Retum Air Plenum

Wall Heat Gainto Plenum L
Roof Heat Gainto Plenum n %
Lighting Hest Gain to Plenum L3 %

Figure 4.4 Air System Data
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-
3. Zone Components:
Space Assignments:
Zone 1: M1 - Classroom
D07 - Typical Claszroom | 1
Zone 2: 0102 - Classroom
D07 - Typical Classroom | F3l
Zone 3: M03 - Classroom
D07 - Typical Classroom | Fal
Zone 4: 104 - Classroom
0104 - Clagzroom [
Zone 5 0706 - Classroom
0706 - Classroom [ =1
Zone &: 07 - Classroom
D107 - Clagsroom [ =1
Zone 7: D105-111 Music Room
D105 - Music Room s
D709 - Fradice Koom o
D710 - Storage Room F3l
D111 - Office %1
Zone §: D117 - West Comdor
D113 -West Corridor [ =1
Zone 3 0114 - South Comridor
D114 - South Corridar [
Zone T0: D105 - South Vestibule
D05 - South YWestibule [ =1
Zone 11: D112 - We s Vestibule
D12 - West Westihule [
Themostats and Zone Data:
Tone
Cooling T-stat: Occ.
Cooling T-stat; Unoce.
Heating T-atet: Ooo.
Heating T-stat: Unocc.
T-stat Throttling Range
Driversity Factor
Direct Exhaust Fan By
Thermostat Schedule
Unoccupied Cooling iz
Supply Terminals Data:
Fan Design Supply
Zone Terminal Type Min Airflow Fan Performance | Efficiency Temperature
1 FFPMBX with RH 15.00 CFM/person 0.50i0n wy 50 % 1100°F
2 FFPMBX with RH 15.00 CFM/erson 0.500n wy 50 % 1100°F
3 FFPMBX with RH 15.00 CFMersan 0.50 00 wg a0 % 110.0°F
4  [PFPMBX with RH 15.00 CFMperson 0.50 0wy 50 % 110.0°F
5 FFPMBX with RH 15.00 CFMperson 0.500n wy 50 % 1100°F
] FFPMBX with RH 15.00 CFMerson 0.500n wg 50 % 1100 °F
T FFPMBX with RH 15.00 CFMperson 0.500n wy 50 % 1100°F
8 FFPMBX with RH 0.05 CF it 0.50i0n wy 50 % 1100°F
9 FFPMBX with RH 0.05 CF it 0.50i0n wy 50 % 1100°F
10  [PFPRMBX with RH 0.05 CFhit? 0.500n wg 50 % 1100 °F
11 |PFPRMBX with RH 0.03 CFhit* 0.50 00 wg a0 % 110.0°F
Fehesat Coil Source Electric Resistance
JFMAMIIJASOHD
Tone all
Figure 4.4 Air System Data (continued)
HAP Quick Reference Guide 4-13




Chapter 4 Energy Analysis Example Problem

Packaged Rooftop AHU Input Data
Project Mame: Example Problem 044 272002
Frepared by Cartier Corporation 02:16FPM
Fone Unit Heat Source Hot Water

4. Sizing Data (Computer-Generated):
Sy=tem Sizing Data:
Hydronic Siang Specifications:
Chilled \Water Delta-T 10.0 °F

Haot Wyater Delta-T 20.0 °F

Safety Factors:
Cooling Sensible
Cooling Latent
Heating

SR

Zone Sizing Data:
Fone Airflovy Sizing Method
Space Lrflove Sizing Method Individual peak space loads

5. Equipment Data

Preheat Unit - Combustion
Heating Capacity 328.0 WMBH
Avwerage Effciency L
Mizc. Electric 0000 kW

Cenfral Cooling Unit - Air-Cooled DX
Design OAT | Mo CF
Gross Cooling C 427.0 MBH
Compreszor & OD Fan Power U425 kw
550 °F

Convertional Cutaff QAT
Used
150 °F

Lowy Temperature Operation
Loy Temperature Cutoff QAT

Figure 4.4 Air System Data (continued)

Fuel Rate Input Data
Example Proklem 04/ 272002
Carrier Corporation 02 25PM

General Semvice Gas Hate

General Details
Rate Mame General Service Gas Rate

CURRBNCY e B

Fate Type | Complex

Energy Unitz .. Therm

Conversion 10000000 KETUTherm

Demand Units _Hourly Peak

Customer Charge i

Minimum Charge 22.00 ¥

Tax Rate

Fuel Charges
Step Type Season Period Block Size Block Units $/Therm

Energy Al Seasons All Periods 100 Therm 062010
Energy Al Zeasons AllPeriods 400 Therm PESEE]
Energy All Seasons All Periods 9999959 Therm 0.44979

Demand Clause
Mo data specified.

Figure 4.5 Natural Gas Fuel Rate Data
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-
Electric Rate Input Data
Example Problem 044 272002
Carrier Corporation 0221PM
General Semvice Electric Rate
Genera Details
Rete Mame ... General ServiceElectric Rate
Curency
Rate Type
Energy Units
Conversion 1.00000 KYhAh
Demand Units kW
Customer Chardge 40,00 §
Minimum Charge 40.00 ¥
Tax Rate
Seasonal Scheduling
Seasons Jan | Feb | Mar | Apr | May | Jun Jul | Aug | Sep Oct | Hov | Dec
Summer = = = =
Mlidi
Wimer EJ EJ EJ EJ EJ EJ EJ EJ
Energy Charges
Type of Eneroy Charge ... Standard
Step Type Season Period Block Size Block Units FKWh
Energy All Seasons All Periods 30000 k'vwh 0.04247
Energy Al S easzons AllPeriods 70000 EWh OO3TeT
Energy Al Seasons AllFeriods 0595559 Kk 003715
Demand Charges
Season Period Block Size | Block Units $Fikwh
SUmmer All Periods 95955999 Ky 14.50000
inter AllPeriods fEj=]e=tere ] F 125000
Figure 4.6 Electric Rate Data
Base Case Design Input Data
Example Problem 044 272002
Carrier Corporation 02:32PM
1. Genera Details:
Building Mame BaseCase Design
2. Plants Included in this Building:
(nane)
3. Air Systemns Included in this Building:
Systern Hame Mult.
Fackaged Rooftop AHU 1
4: Miscellaneous Energy
(no itemn s defined)
5: Meters
Electric __General Service Electric Rate
Matural Gas G eneral Service Gas Hate
6: Miscellaneous Data
Awerage Building Power Factor 100.00 %
Source Electric Generating Efficie (2800 %
Additional Floar Area 0.0 ft=
Figure 4.7 Building Data
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Energ_:;y Analysis Example Problem

Example Proklem
Carrier Carporation

Annual Component Costs - Base Case Design

041672002
0503

Heating 14 204

Lights 2 994

13.9% Cooling

4184 Air System Fams

1. Annual Cosls

Annual Cost Percent of Total

Component (%) ($55) (%)
Air Zy=tem Fans G445 0.067 41
(Cooling 2180 0225 1389
Heating 3014 0.311 19.2
Pumps 1] 0000 0.0
Cooling Tower Fans o 0.000 oo
HVAC Sub-Total 5,839 0.603 3T

Lighit= 9,580 1.019 629
Electric Equipment o 0.000 oo
hisc. Electric 1] 0.a00 [aa]
Mizc. Fuel Uze 1] 0.0oo 0.0
Hon-HYAC Sub-Total 9,880 1.019 62.9
Grand Total 15,719 1.622 100.0

Mote: Cost per unt foor ares is based onthe gross building floor area.

Gross Floor Ares

9700.0 ft*
9700.0 ft*

Figure 4.8 Annual Component Costs
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Chapter 4

Monthly Energy Use by Energy Type - Base Case Design

Example Proklem 040 672002
Carrier Carporation 05:03P M
1. HYAC Energy Use

Electric Hatural Gas Fuel 0il Propane Remote HW| Remote Steam Remote CW
Month {KWh) {Therm) {naj {naj {na} {na} {na}
Jan 5,936 300 u] u] 0 0 0
=] 4 034 265 u] u] 0 0 0
i ar 2192 164 u] u] 0 0 0
LYalg 1,107 34 u] u] 0 0 0
i ary 2,595 2 u] u] 0 0 0
Jun 4451 1] u] u] 0 0 0
Ll a7 1] u] u] 0 0 0
ALy 5,329 1] u] u] 0 0 0
Sep 34972 1] u] u] 0 0 0
Ot 1,364 11 u] u] 0 0 0
Moy 2,007 G4 u] u] 0 0 0
Dec 5976 169 u] u] 0 0 0
Totals 40,234 1,012 u] u] 0 0 0
2. Hon-HYAC Energy Use

Electric Hatural Gas Fuel Oil Propane Remote HW | Remote Steam
Month {KWh) {Therm} {naj {naj {na} {na}
Jan g 567 1] u] u] 0 0
F b 7 786 1] u] u] 0 0
ETS 5,189 1] u] u] 0 0
A pr B GE9 1] u] u] 0 0
EW 8,567 1] u] u] 0 0
Jun 5914 1] u] u] 0 0
Jul 255 1] u] u] 0 0
AL 5,922 1] u] u] 0 0
Sep 7803 1] u] u] 0 0
Ot §945 1] u] u] 0 0
Mo 7425 1] u] u] 0 0
Dec 5,922 1] u] u] 0 0
Totals &1 964 1] u] u] 0 0

Figure 4.9 Monthly Energy Use by Energy Type
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Monthly Simulation Results for Packaged Rooftop AHU
Froject Mame: Example Proklem 04 672002
Prepared by: Cartier Corporation 05:07P M
Air Systern Simulation Results (Table1):
Preheat Central Central
Preheat Coil| Preheat Eqpt Preheat Coil | Heating Misc. Cooling Coil | Cooling Eqpt Central Unit
Load Load Input Electric Load Load Clg Input
Month (kBTU) (kBTU) (kBTU) (kKwh) (KBTU) (kBTU) {kWh)
Januany 24522 24522 30027 1] u] 0 1]
F ebruarny 21967 21967 26789 1] u] 0 1]
March 13444 13444 16385 1] 476 476 37
A pril 2745 2748 3351 1] 2735 2738 220
May 166 166 202 1] 25251 25251 2278
June 1] 0 0 1] 40993 40993 3866
July 1] 0 0 1] 5463 G463 873
August 1] 0 0 1] 21145 21145 4747
S eptermher 3 3 4 1] 3E¥2 38312 3380
O ctober G55 G55 1083 1] GE05 G508 719
Hovember 5214 5214 E355 1] 1214 1214 92
D ecermber 13859 13858 165901 1] 53 53 4
Total 82911 82911 101110 1] 177459 177459 16216
Air Systern Simulation Results (Table 2):
Terminal Termminal
Heating Coil Heating Coil Electric
Load Input SupplyFan | Terminal Fan Lighting E quipment
Month (KBTU) (kWhj (kwh) (kwh) (Khy) (kwh)
Januany 18756 2497 360 79 GaET 0
F ebruarny 12411 63T 333 B4 7TEE 0
March 5965 1748 357 49 51589 0
A pril 1847 541 324 22 GEG3 0
May =0 15 B00 3 GaET 0
June 1] 0 585 1] 5914 0
July 1] 0 95 1] 255 0
August 1] 0 582 1] 5922 0
S eptemmber 15 g 86 1 7a03 0
O ctober 529 155 475 15 5945 0
Hovember 5254 1540 332 43 7425 0
D ecermber 19295 SESE 250 EY 2922 0
Total 64128 18794 4882 343 81964 0

Figure 4.10 Monthly Simulation Results for Packaged Rooftop AHU
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Chapter 5 Design Applications

This chapter provides application information describing how to use the program to perform different
types of system design analyses. It also provides advice on how to troubleshoot problem jobs. Material
in this chapter is written assuming the reader is familiar with the program operating principles discussed
in Chapter 1.

5.1 APPLICATION INFORMATION OVERVIEW

This chapter explains how to use the program for common system design applications. Chapter 1
contained a general discussion of how to use the program to design systems. However, the program can
be used in design work involving a wide variety of different types of HVAC systems and equipment.
Procedures for using the program for these applications are not always obvious, especially for new
program users. Therefore, this chapter summarizes how the program can be used for four common
categories of design applications:

o Sizing single-zone HVAC units.

o Sizing terminal HVAC units such as fan coils and water-source heat pumps.

o Sizing multiple-zone HVAC systems.

» Sizing chiller and boiler systems.

Discussions will dwell on modeling strategies and procedures for generating sizing information. In each
case it is assumed the reader is familiar with the basic program operating procedures outlined in Chapter
1. Further, it is assumed input data has been gathered and weather, schedule, wall, roof, window, door
and shading data has already been entered. Therefore, entry of this data will not be covered in the
application discussions.

Finally, the last section in the chapter discusses troubleshooting strategies required when investigating
program results.

5.2 APPLICATIONS INVOLVING SINGLE-ZONE HVAC UNITS

Introduction. Many design applications involve single-zone HVAC equipment. These include small
buildings with open areas that can be properly air-conditioned with one single-zone unit, or regions of a
building served by separate single-zone units. These applications generally fall into two categories:

o Applications involving rooftop or vertical packaged equipment. However, it could also involve
applications with split DX units and central station air handlers.

o Applications involving terminal units such as hydronic fan coils, DX fan coils, packaged terminal air
conditioners (PTACs) and water source heat pumps (WSHPs).

Applications in the first category will be discussed in this section. Analysis of terminal units will be
described in Section 5.3.

Analysis Strategy. To size single-zone HVAC units with the program, each HVAC unit must be defined
as a separate air system. When calculations are performed, reports will be generated with sufficient
information to size the cooling and heating coils, the unit fan and any system ductwork. Considerations
for this analysis are discussed below.
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Chapter 5 Design Applications

1. Defining Spaces. Spaces can represent each room in the area served by the HVAC unit. This will
allow load and airflow sizing data to be calculated on a room-by-room basis as well as on a zone
basis. If your objectives for the design calculation do not require a room-by-room sizing analysis,
then one space representing the entire region served by the unit can be defined instead.

2. Defining The Air System. One air system must be defined for each single-zone HVAC unit to be
sized. Typically units will be constant volume, so the "Single Zone CAV" system option should be
used and the appropriate system attributes should be defined. During air system inputs, the spaces
contained in the zone served by the unit are specified. When a space is used to represent the entire
building or the entire region served by the unit, the zone will include only one space. When spaces
represent separate rooms in the region served by the unit, the zone will contain a group of spaces.

3. Generating System Design Reports. First choose the air systems to be sized. In cases where
multiple single-zone units are involved, it may be more efficient to enter the air system data for all the
HVAC units, and then generate reports all in one batch. The program provides capabilities for doing
this.

When choosing outputs, select the Air System Sizing Summary and the Zone Sizing Summary. The
Air System Sizing Summary provides data for sizing and selecting the supply fan and central cooling
and heating coils. This data includes the design supply airflow rate, the design cooling and heating
coil loads, coil selection parameters and useful check figures. The Zone Sizing Summary provides
information for sizing space supply diffusers, zone and space ductwork and any zone heating units or
reheat coils.

5.3 APPLICATIONS INVOLVING TERMINAL UNITS

Introduction. This section discusses applications involving the second category of single-zone HVAC
units. This category of equipment includes packaged and split terminal air conditioners, hydronic fan coil
units, and water source heat pumps (WSHPs) which are used to condition separate rooms or groups of
rooms. Examples include units serving separate offices in an office building, separate guest rooms in a
hotel, or classrooms in a school building. Applications involving these types of equipment typically
require that a large number of units be sized. To assist in this task, the program provides special features
for efficiently entering system information and producing sizing data.

Analysis Strategy. Rather than defining one air system per single-zone HVAC unit as was done in
Section 5.2, the program allows one "air system input" to represent multiple HVAC units. This feature is
available when using the Packaged DX Fan Coil, Split DX Fan Coil, 2-Pipe Fan Coil, 4-Pipe Fan Coil
and WSHP air system types. The program also produces streamlined output for sizing this equipment.
These features help minimize input effort and the quantity of output produced. Considerations for the
analysis are summarized in the following paragraphs.

1. Defining Spaces. As discussed in Section 5.2, a space should represent a single room when your
design analysis requires room-by-room sizing data. When this is not necessary, each space can
represent the entire area served by one HVAC unit. In many applications, each HVAC terminal unit
will serve a single room, such as a fan coil in a hotel room, so the space must represent a single room
in these cases.

A more important consideration in this analysis is minimizing the number of spaces and units that are
defined in order to save time and effort. In most applications it is not necessary to define one space
and one HVAC unit for every terminal unit in the building. For rooms with the same sizes and
patterns of loads, it may be possible to size an HVAC unit once, and then use the same unit in
multiple rooms. For example, guest rooms on the same exposure of a hotel might all be the same
size, use the same wall and window construction and experience the same internal loads. One space
input and system sizing calculation for a typical guest room might suffice for selecting units for 10 or
even 100 guest rooms in this situation. When considering how to reduce the number of units
analyzed, remember to evaluate all factors that affect loads. For example, separate calculations must
be performed for two rooms of the same size on the same exposure if one is on the top floor and the
other is on an intermediate floor, since only one has a roof exposure.

5-2
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2. Defining the Air System. When entering air system data, choose the Packaged DX Fan Coil, Split

DX Fan Coil, 2-Pipe Fan Coil, 4-Pipe Fan Coil or WSHP system type. All five provide the same
system design input features, and are sized using the same procedures.

When one of these system options is chosen, the program allows multiple terminal HVAC units to be
defined in one air system input. In addition, outdoor ventilation can be supplied either directly to the
unit, or by a central tempering unit. When a central tempering unit is used, the temperature of air
delivered to the terminal units often affects coil loads for the terminal HVAC units. This factor is
considered in program calculations.

Performing System Design Reports. First choose the air system containing the terminal unit data.
When choosing sizing reports, select the Zone Sizing Summary report. If ventilation air is provided
via a common ventilation unit, also select the Air System Sizing Summary report.

The Zone Sizing Summary provides data for sizing cooling coils, heating coils, fans and airflow for
each terminal unit and also airflow to individual spaces served by the terminal units. If an HVAC
terminal unit serves two or more spaces, this data will be essential for sizing space diffusers and
ductwork.

The Air System Sizing Summary will provide sizing data for the common ventilation unit, if one is
used. This includes information for sizing the airflow, fan motor, cooling coil and heating coil in the
ventilation unit.

5.4 APPLICATIONS INVOLVING MULTIPLE-ZONE HVAC SYSTEMS

Introduction. Many design projects involve a central packaged unit or a built-up air handling unit which
provides conditioned air to many different regions in a building. Each of these regions has its own
thermostat making this a multiple-zone HVAC system. These systems comprise the third category of
design applications.

Analysis Strategy. To design multiple-zone HVAC systems with the program, each packaged unit or
AHU must be defined as a separate air system. When design calculations are performed, output data will
provide sizing information for all cooling and heating coils, fans and terminals in the system.
Considerations for this analysis are described below.

1.

Organizing Zones & Defining Spaces. How to zone the system is one of the first decisions required
when organizing the analysis. Zoning usually depends on the building use and layout, and the HVAC
system controls. The goal is to provide a thermostat for each region of the building requiring specific
temperature control. Since the program defines a zone as the region served by one thermostat, the
location of thermostats in the system dictates how rooms will be grouped into zones.

Examples: Offices on a south exposure of a building might be included in one zone since they are of
similar size and experience the same patterns of loads. A conference room on the same exposure
might have a separate thermostat since its pattern of loads will differ from those of the offices on the
same exposure. Further, north and south offices in a building would typically be assigned to separate
zones since offices on each exposure experience significantly different patterns and magnitudes of
loads.

Once zoning decisions have been made, all spaces included in each zone must be defined. As
discussed in previous sections, each space should represent a separate room when room-by-room load
and airflow sizing data is required. When a room-by-room sizing analysis is not required, each space
can represent the entire area in one zone.

Another important consideration when entering spaces is how to minimize input effort. When each
space represents a single room, the brute force approach is to define a separate space for every room
in the building. However, in many cases series of identical rooms (same size, same pattern and
magnitude of loads) will exist in a zone. In these situations, one of the identical rooms can be defined
as a space once. Later during air system input, a multiplier can be applied to this space to account for
the total number of rooms present in the zone. This reduces input effort.
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2. Defining The Air System. One air system must be entered to represent the multiple-zone HVAC
system. The program provides options for defining and sizing many different types of constant
volume and variable volume multiple-zone HVAC systems. Define the appropriate attributes for the
system being designed.

Entering air system data also requires defining the zones served by the system. The number of zones
is specified first. Next, spaces included in each zone are identified by specifying the quantity of each
space included in a zone. In a simple case in which a zone contains one space, a quantity of 1 would
be defined. In another case, a zone might contain six identical offices. If one space has been defined
to represent one of these offices, the zone would contain one space but the space would be assigned a
quantity of 6. Finally, a zone might contain a group of different rooms each defined as a separate
space. In this case, the zone would contain multiple spaces.

3. Generating System Design Reports. First choose the air system to be sized. When designing
multiple air systems in a large building, it may be more efficient to define all the systems and then
generate reports for all in one batch. The program provides features for doing this.

On the report selection screen, choose the Air System Sizing Summary and Zone Sizing Summary
options. The Air System Sizing Summary lists maximum coil loads for all central cooling and heating
coils in the system, required airflow rates for central supply and return fans, coil selection parameters,
and useful check figures. This data can be used to select coils and fans for the system. The Zone
Sizing Summary provides data for sizing zone terminals such as VAV boxes, zone reheat coils, zone
baseboard or fan coil heating units and fan powered mixing boxes, as well as space diffusers and
ductwork.

5.5 APPLICATIONS INVOLVING CHILLERS AND BOILERS

Introduction. System design work can also require sizing central chiller and boiler plants. In these
situations, a chiller and boiler might serve several central air handling units in a large building and/or a
large number of hydronic fan coil units located in different rooms of a building. In either case, the
program provides capabilities for sizing both the air handling and terminal units as well as the chiller and
boiler equipment. This section describes the analysis procedure required.

Analysis Strategy. Performing this analysis requires developing inputs for all the air systems served by
the chiller and boiler first and then generating system sizing reports. Next, a chiller plant is created and
systems having chilled water cooling coils are linked to it. A boiler plant is also created and systems
having hot water or steam heating coils are linked to it. Finally, plant design reports for the chiller and
boiler are generated. Considerations required in the analysis are discussed below.

1. Defining Air Systems. The same principles discussed earlier in this chapter for single-zone and
multiple-zone systems are required when defining air systems for this application. In previous
discussions the choice of an equipment type and the specification of the cooling and heating sources
for coils were not critical. However, when sizing chillers and boilers, these details are important.

Coils served by the chiller must have chilled water designated as the cooling source. Chilled water is
the default cooling source when the systems equipment classification is Chilled Water AHU, and
when using the 2-Pipe Fan Coil or 4-Pipe Fan Coil system types. When using systems in the
Undefined equipment class, the cooling source is "Any" and can be used for chilled water plant
design calculations.

Coils served by the boiler must have hot water or steam designated as the heating source. When
using systems in the Undefined equipment class, the heating source is "Any" and can be used for both
hot water and steam design calculations.

Special Consideration. Finally, a key requirement of the chiller and boiler analysis is that the total
load imposed on equipment must be considered. Because techniques for minimizing work when
analyzing terminal equipment such as fan coils involves analyzing duplicate units only once, this can
cause problems in generating correct chiller and boiler load totals.
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Example: A hotel contains 220 guest rooms served by 4-pipe fan coils. 100 of these rooms are on one
face of the building and have identical size and load patterns. Another group of 100 are on the
opposite face of the building and also have identical size and load patterns. The remaining 20 rooms
must be modeled separately because each has unique characteristics. To save time, we could model
this situation with one 4-pipe fan coil system having 22 zones - 1 zone representing one unit out of
the first group of 100 identical zones, 1 zone representing one unit out of the second group of 100
zones and one zone each for the remaining 20 unique zones. This would vastly reduce effort required
to size and select the fan coils.

However, if we linked this fan coil air system to a chiller or boiler plant, we would have a problem
since loads would be undercounted. We have only accounted for the loads of 22 out of the 220 fan
coil units in the building.

To correct this problem, an alternate approach would be used. Define three 4-pipe fan coil air
systems. The first contains 20 zones, one for each of the 20 unique hotel zones. The second contains
1 zone representing a single zone in the first group of 100 identical zones. The third system contains
1 zone representing a single zone in the second group of 100 identical zones. System sizing reports
can be run as before to generate data needed to select the fan coil units.

To size the chiller, the three fan coil air systems would be linked to the chiller. The system
containing the 20 unique zones would be assigned a system multiplier of 1. The single-zone systems
representing each group of 100 identical zones would each be assigned a system multiplier of 100. In
this way the total load for all 220 fan coil units would be accounted for and the chiller would be
properly sized. The same sort of approach would be used when linking the fan coil air systems to the
boiler plant.

2. Generating System Design Reports. Once air systems have been defined, generate system design
reports for each. As discussed in earlier sections, the system design reports provide information for
sizing cooling coils, heating coils, fans, diffusers and ductwork.

If system sizing data is not a concern (e.g., if you are performing a preliminary block load
calculation), this step can be skipped. The plant sizing calculations performed as part of step 4 will
automatically run system sizing calculations first if system sizing results do not already exist.

3. Defining Plants. For a chilled water plant, create one plant and choose "Generic Chilled Water
Plant" as the plant type. Then specify the air systems served by this plant. For each system linked to
the plant, HAP will assume that all chilled water coils, and coils whose cooling source is “Any” are
served by the plant. As mentioned in item 1 above, system multipliers can be used when an air
system represents one of a number of identical systems or units served by the chiller.

For hot water or steam plant create a second plant. For a hot water boiler, choose "Generic Hot Water
Plant" as the plant type. For a steam boiler, choose "Generic Steam Plant” as the plant type. Then
specify the air systems served by this plant. In a hot water plant HAP will assume all hot water coils
and coils with a heating source of "Any" are served by the plant. In a steam plant HAP will assume
that all steam coils and coils with a heating source of "Any" are served by the plant. System
multipliers can again be used for situations in which a system represents one of a number of identical
systems or units.

For HAP users who will later run energy analyses, “Generic” plants can be converted into specific
plant types. When converting plants, system selection data is preserved.

4. Generating Plant Design Reports. Finally, generate design reports for the chiller and boiler. For
the chiller, choose the Cooling Plant Sizing Summary report. This report lists the peak chiller load as
well as the coincident loads for all systems served by the chiller. For a boiler, choose the Heating
Plant Sizing Summary report. This report lists the peak boiler load as well as coincident loads for
systems served by the boiler.
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5.6 TROUBLESHOOTING STRATEGIES

This section describes general strategies used to investigate load calculation and system sizing results.
These investigations may be necessary when diagnosing problems with results or simply learning more
about results generated by the program. Due to the wide range of situations requiring diagnosis, it is not
possible to discuss troubleshooting procedures for specific applications. Rather, general strategies useful
in a variety of situations will be described below.

1. Investigate Input and Output Data. When a question about results arises, first generate reports of
all input data and pertinent load calculation results. Inspect and compare data on the different
printouts. Sometimes unusual sizing results are caused by inadvertent input errors.

2. Research Input Definitions and Calculation Procedures. In many cases, a thorough knowledge of
how the program uses certain inputs and performs its load and sizing calculations is necessary to
understand program results. Topics in the on-line help system provide definitions of all program
inputs and explain how inputs are used by the program. Documentation topics in the help system
explain calculation procedures.

3. Perform Comparative Analysis. When a more detailed investigation is needed various types of
comparative analyses can be helpful. The success of this technique depends on the user's ingenuity,
knowledge of system and load behavior, and knowledge of the program. Two common applications
for comparative analysis are provided below to serve as examples.

» Single-Hour vs Multiple Hour Data. Frequently, unusual results found on the 4ir System Sizing
Summary or Zone Sizing Summary reports can be successfully diagnosed by comparing data with
full 24-hour load profiles.

Example: Suppose the Air System Sizing Summary report shows that the peak coil load occurs at
7am. Since peak coil loads usually occur in the mid to late afternoon, this is an unexpected result.
One way to diagnose this result is to generate the Hourly Air System Design Day Loads report
which lists cooling coil loads for all hours in a specific month. By comparing coil loads at
different times of day, a user can gain insight into why the maximum load occurs in the early
morning. Sometimes this type of result will be due to an unusually large pulldown load which
causes loads during the first few hours of operation in the occupied period to exceed coil loads
during the mid-afternoon hours. Such results could be due to legitimate system behavior or could
be due to errors in modeling building heat gains or system controls.

o Air System Variations. When an air system containing several components and accessory
controls yields unusual sizing results, a useful diagnostic strategy is to run calculations for
variations of the system to determine the effect of each component or control.

Example: An air system including dehumidification control, a preheat coil and a ventilation
reclaim device yields unusual sizing results. To diagnose this problem, make four copies of the
air system. From one copy remove all three supplemental components and controls. This system
will represent a base case. For the other three copies include each of the components separately.
For example, one system would only include the dehumidification control. Another would
include the preheat coil only, and so forth. Finally, run sizing calculations for each for the four
system variations. A comparison of results from these systems should demonstrate the individual
effect of each component control. Often this points out the reason for the original results that
were questioned. When it does not, it may be necessary to use 24-hour load profile reports to
evaluate differences in system performance, or to run further test cases using combinations of two
components at a time (e.g., dehumidification and the preheat coil together, the preheat coil and
ventilation reclaim, etc...).
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Chapter 6 Energy Analysis Applications

This chapter explains how to use the program for common energy analysis applications. It also provides
advice on how to troubleshoot unexpected energy simulation results. Material in this chapter assumes
the reader is familiar with the program operating principles discussed in Chapter 1. Note that energy
analysis features are only available in HAP and not in HAP System Design Load.

6.1 APPLICATION INFORMATION OVERVIEW

This chapter explains how to use the program for common energy analysis applications. Chapter 1
contained a general discussion of how to use the program for energy analysis studies. However, the
program can be used in studies involving a many different types of HVAC equipment. Procedures for
using the program for these applications are not always obvious, especially for new program users.
Therefore, this chapter covers the following ten application topics:

General energy analysis strategies.
Troubleshooting strategies.

Simulating packaged rooftop units
Simulating vertical packaged units.
Simulating split DX air handlers.
Simulating chilled water air handlers.
Simulating packaged or split DX fan coil units.
Simulating hydronic fan coil units.
Simulating water source heat pump systems.
Simulating chilled water plants.

Simulating hot water and steam plants.
Modeling utility rate structures.

In all of these discussions it is assumed the reader is familiar with the basic program operating procedures
outlined in Chapter 1. Further, it is assumed input data has been gathered and entered for weather,
schedules, walls, roofs, windows, doors and shading geometries. Therefore, entry of this data will not be
covered in the application discussions.

6.2 ENERGY ANALYSIS STRATEGIES

The purpose of an energy analysis is to compare the annual energy use and energy costs of alternate
system designs. To generate energy use data, the operation of all energy-consuming equipment in a
building must be simulated. This includes energy use by air handling systems, plant equipment, and non-
HVAC systems such as lighting and office equipment. In small buildings, the analysis is easy to organize
due the relatively small number of components involved. For larger buildings, however, the analysis can
be much harder to organize. In these cases it is important to consider ways to minimize input effort and
calculation time. This section discusses strategies for maximizing the accuracy of energy analysis results
while minimizing effort.

The most accurate energy analysis results can be obtained by analyzing equipment exactly as it is
installed. For example, if a building contains 400 water source heat pump (WSHP) units, the most
accurate approach would be to model 400 heat pump units and the spaces they serve separately. In this
way loads experienced by each WSHP unit and the performance of each unit could be accurately
evaluated.
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While this is conceptually the simplest approach to energy analysis, it can often require the largest
amount of time for gathering and inputting data and then running simulations. In certain situations the
number of spaces, zones, air systems and plants can be systematically reduced without significantly
affecting the accuracy of results.

Simplification of the energy analysis is achieved using two techniques. One involves combining or
"lumping" together similar components in the analysis. Two identical zones in an air system, for
example, can be combined without affecting system simulation results. The other is simulating identical
equipment only once, and then using multipliers to account for the total number of units in the building.
In a hotel, for example, packaged terminal air conditioner (PTAC) units might be used in 75 identical
south-facing guest rooms. Rather than simulate all 75 PTAC units separately, one representative unit can
be simulated and then multiplied by 75 to account for the total energy consumption of the equipment in
energy cost calculations.

Both these approaches require careful evaluation of which components in the analysis can and cannot be
combined. If the analysis is oversimplified, energy use and costs can be significantly over or under-
estimated. Separate paragraphs below summarize considerations involved with reducing the number of
spaces, zones, air systems and plants involved in the analysis.

« Space Data. In many situations, rooms in a zone can be combined and defined as one space.
Because a zone has only one thermostat, it is the total zone load that drives air terminal operation and
therefore system operation, not the individual space loads. Therefore, the same total zone loads will
be calculated whether the zone is defined using one large combined space or multiple spaces
representing separate rooms.

In a zone containing several identical rooms, another approach is to define only one of the rooms as a
space. When linking spaces to zones, a multiplier can be used to account for the total number of this
type of room in the zone.

These techniques reduce the number of spaces entered and the time required for the program to
compute loads during the energy simulations.

Note: For several reasons design considerations may prevent using this reduction technique. If a
project involves both system design and energy analysis, it may be necessary to define each room as a
space in order to size air diffusers for each room. Further, if design zone airflow rates are based on
the sum of peak space airflow rates, then spaces in the zone cannot be combined. To properly size
zone airflow rates, the individual spaces in the zone must be defined.

e Zone Data. A zone is defined as the region of a building served by one thermostat. Large air-handling
systems which contain many zones and systems involving multiple single-zone units, such as fan coils,
offer the greatest potential for simplification.

In a central air-handling system serving an office building, for example, each perimeter office may
contain a thermostat. However, many offices on the same perimeter exposure may experience
identical or very similar patterns of loads. Rather than analyzing each room as a separate zone, many
zones can be lumped together without sacrificing accuracy. For example, 20 offices on the south
exposure of a building might be combined into one large south-facing zone. The same principles
apply when terminal units such as fan coils serve the offices. When combining zones:

+ Do combine zones with identical or similar patterns of loads. Typically these zones will have the
same exterior exposure and the same patterns of occupancy and internal heat gains.

o Don't combine zones with different exterior exposures. For example, combining north-facing and
south-facing offices is a poor choice since each experiences significantly different patterns of solar
loads.

« Don't combine zones which do have a roof exposure with those that don't. The presence of the roof
causes load patterns to differ from those in zones without a roof exposure.

« Don't combine interior regions with perimeter zones. For much of the year, interior heat gains will
offset perimeter heat losses causing heating loads to be understated.
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o Don't combine zones with different use patterns. For example, in a school building, a classroom zone
should not be combined with a cafeteria zone since the occupancy and heat gain patterns in each
differ.

The advantages of reducing the number of zones are that fewer spaces need to be input, and times for
load calculations and air system simulations are reduced.

Air System Data. Opportunities for reducing the number of air systems in an analysis vary between
central air handling systems and terminal systems such as fan coils.

Opportunities for combining central air handling systems are usually limited, except in special cases
where several similar or identical systems serve different parts of a building. For central air systems
to be "similar", the systems must contain the same components, be sized in the same way, serve the
same number of zones, and experience the same pattern of loads. This situation might occur in a
multi-story building where separate air systems serve each floor, and patterns of loads on each floor
are very similar. In such a case, an air system for a typical intermediate floor could be defined and
simulated once. When the air system is linked a plant or a building, a multiplier can be used to
account for the total number of air systems of this type in the building.

Opportunities for reducing the number of terminal type air systems in an analysis are much more
common. As discussed earlier, the number terminal air-conditioner units in guest rooms in a hotel
can be vastly reduced analyzing typical units and using multipliers. When identifying typical units,
or when lumping units together, the criteria previously described for combining zones should be used.
In addition, units which use different components or controls should not be lumped together since
these differences will affect performance and energy consumption.

Plant Data. Opportunities for combining central plants such as chiller and boiler plants rarely exist, since
buildings typically contain one of each, if plants are used at all.

6.3 TROUBLESHOOTING STRATEGIES

This section describes general strategies used to investigate energy analysis results. These investigations
may be necessary when diagnosing problems or simply learning more about results generated by the
program. General strategies useful in a variety of situations will be described below.

1.

Investigate Input and Output Data. When a question about results arises, generate and inspect
printouts of pertinent input and simulation data. Checking input printouts often reveals input errors
which cause incorrect results. In addition, checking and comparing printouts of simulation data often
reveals the reason for results, or provides clues to simulation problems, as discussed below.

Questions frequently arise about unusual building energy cost results. Energy costs are the final,
bottom-line results of the energy analysis. Because costs are dependent on many factors, it is
necessary to generate details showing how the costs were calculated and intermediate results showing
the performance of air systems and plants contributing to building energy consumption. The strategy
should be to work backward from the final results to determine how they were derived. This work
can be performed in two stages. First, generate detailed building outputs. The following building
simulation reports are often useful:

« Energy Budget by System Component: When complex rate structures are used, operating costs are
not proportional to energy use due to the demand, fixed and tax charge components of the energy bill.
Therefore, operating costs often do not present a clear picture of energy use by the building.
Comparing only the bottom line cost figures may obscure the energy performance of the building.
The Energy Budget by System Component report lists annual energy use totals in common units
(kBTU in English, kWh in Metric) and can be a better basis for comparison.

o Monthly Energy Use By System Component: This report lists month by month energy use by
both system component and energy type. It provides more detailed information than the Energy
Budget report, listing energy use in billing units (e.g., kWh for electric, Therms for gas, etc..) for
each system component category. This makes it much easier to make direct comparisons between
buildings and identify key differences in energy performance.
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« Billing Details: These reports document the individual charges contributing to the total electric and
fuel bills. The reports also list the monthly average price of energy, energy consumption totals,
monthly demands and the time when each demand occurs. This data can be used to determine how
the utility bill was calculated, and to identify factors contributing to unusual results. For example, an
unusual increase in costs may be due to a large peak demand in one month. This might focus the
investigation on equipment performance during the particular month with the large demand.

If building reports do not reveal the cause of a problem, the second stage in the analysis is to
investigate simulation results for the plants and air systems in the building. Two ways of doing this
are discussed below.

»  Monthly-Daily-Hourly Simulation Results. One approach is to first inspect the monthly report to
identify months with unusual results, then inspect the daily report for that month to focus on the
individual days with odd results, and finally inspect hourly reports for those days.

« Hourly Graphics. An alternate approach is to generate hourly graphs for long sequences of time in
order to pinpoint portions of the year showing unusual behavior, and then generate graphs for shorter
periods of time to investigate behavior in greater detail. For example, cooling coil loads for all 8,760
hours in the year can be included in one plot. This plot might show times of year when unusually
large or small cooling loads exist. The next step would be to generate graphs for these shorter periods
of time to understand this behavior.

Using these strategies, problems can be efficiently investigated and diagnosed.

Research Input Definitions and Calculation Procedures. In many cases, thorough knowledge of
how the program uses inputs and performs its energy simulations is necessary to understand program
results. Material in the program's on-line help system provides this information. The operation
sections of the on-line help system discuss program inputs and explain how inputs are used by the
program. The documentation sections of the on-line help system explain calculation assumptions and
procedures.

Perform Comparative Analyses. In some cases, investigating input and output data, and
researching calculation procedures are not sufficient to diagnose problems with results. In these
situations, various types of comparative analyses performed with the program can be helpful. The
success of this technique depends on the user's ingenuity, knowledge of load, system and equipment
behavior, and knowledge of the program. A common example of how comparative analysis can be
used is provided below.

Example: Suppose unusual energy costs results are obtained and an investigation of program outputs
shows that results are due to peculiar air system behavior. The air system in question uses
dehumidification control, a preheat coil and an enthalpy economizer. Careful inspection of monthly,
daily and hourly simulation results does not reveal a logical reason for the results.

Because it is possible behavior of one of the system components or unanticipated interaction between
components is causing the results, a useful strategy is to run simulations for variations of the air
system to try to identify how each component influences system performance. First make four copies
of the air system. One should represent a base case without dehumidification control, a preheat coil
or an economizer. The other three copies should include one of the extra components each. For
example, one system would include only the dehumidification control, one would include the preheat
coil, and one would include the economizer. Generate air system simulation reports for all four
systems and compare results. The comparison will clearly show the effect of each component on
system behavior, and may allow you to determine the reason for the original results. If not, it may be
necessary to run simulations for simple combinations of components such as the economizer and
dehumidification control, dehumidification control and the preheat coil, etc... Inspection of results for
these simulations may reveal unanticipated interaction or conflicts between the components.

6-4
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6.4 SIMULATING PACKAGED ROOFTOP UNITS

This section explains how to model packaged rooftop equipment in energy simulations. This equipment
contains a supply fan, condenser fans, DX cooling apparatus and heating apparatus all in one packaged
unit. Heating options are electric resistance, combustion, heat pump and, in unusual cases, hot water or
steam. Modeling procedures are described below.

1.

Air Systems. Define one air system per rooftop unit. If the building contains multiple rooftops
which are identical, serving identical or similar areas of the building, a single rooftop unit can be
modeled and a multiplier can be applied to account for the total number of these units. Modeling tips:

o Specify the Equipment Class as "Packaged Rooftop Unit"

o Specify the appropriate system type and enter system data.

o Define the performance characteristics of the DX cooling equipment using the Equipment Tab on
the Air System form.

o If heat pump or combustion heating is used, define performance characteristics of the heating
equipment using the Equipment Tab on the Air System form.

o Ifelectric heat is used, no additional heating equipment inputs are required.

Plants. It is not necessary to define a plant except in the unusual cases where a hot water or steam
heating coil has been added to the rooftop unit. In these cases a hot water or steam plant must be
defined to serve these coils. The rooftop air system will be linked to this plant. If a heating plant
serves multiple systems, a single heating plant can be defined and all systems can be linked to it.

Building. If electric, combustion or heat pump heating is used, the air system is linked directly to the
building. A multiplier can be used if the rooftop represents one of a group of identical units. If hot
water or steam heating is used, then both the heating plant and the rooftop air system must be linked
to the building.

6.5 SIMULATING VERTICAL PACKAGED UNITS

This section explains how to model vertical packaged (VPAC) equipment in energy simulations. The air-
cooled version of this equipment contains a supply fan, condenser fans, DX cooling apparatus and heating
apparatus all in one packaged indoor unit; in some cases a remote condenser is used. The water-cooled
version of this equipment contains a supply fan, DX cooling apparatus and heating apparatus in one
packaged indoor unit. The water cooled condenser is connected to a cooling tower. Heating options
include electric resistance, combustion, hot water and steam. Modeling procedures are described below.

1.

Air Systems. Define one air system per vertical packaged unit. If the building contains multiple
VPACs which are identical, serving identical or similar areas of the building, a single VPAC unit can
be modeled and a multiplier can be applied to account for the total number of these units. Modeling
tips:

« Specify the Equipment Class as "Packaged Vertical Unit"

o Specify the appropriate system type and enter system data.

» Define the performance characteristics of the DX cooling equipment using the Equipment Tab on
the Air System form.

« For water-cooled units, a cooling tower must be defined and linked to the air system. This is
done using the "Miscellaneous Equipment" button on the Equipment Tab.

» If combustion heating is used, define performance characteristics of the heating equipment using
the Equipment Tab on the Air System form.

o Ifelectric heat is used, no additional heating equipment inputs are required.

Plants. Plant equipment is not needed unless hot water or steam heating is used. In these cases a hot
water or steam plant must be defined and the VPAC air system is linked to this plant. If the heating
plant serves multiple air systems, a single heating plant can be defined and all air systems linked to it.

Building. If electric or combustion heating is used, the VPAC air system is linked directly to the
building. A multiplier can be used if the VPAC represents one of a group of identical units. If hot
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water or steam heating is used, then both the heating plant and the VPAC air system must be linked to
the building.

6.6 SIMULATING SPLIT DX AIR HANDLING UNITS

This section explains how to model split DX air handling units in energy simulations. This equipment
includes an indoor unit containing fans, a DX cooling coil and heating apparatus, plus an outdoor
condensing unit. Heating options include electric resistance, combustion, heat pump, hot water and
steam. Modeling procedures are described below.

1. Air Systems. Define one air system per split DX air handler. If the building contains multiple split
units which are identical, serving identical or similar areas of the building, a single air handler can be
modeled and a multiplier can be applied to account for the total number of these units. Modeling tips:

»  Specify the Equipment Class as "Split DX AHU"

« Specify the appropriate system type and enter system data.

o Define the performance characteristics of the DX cooling equipment using the Equipment Tab on
the Air System form.

o If heat pump or combustion heating is used, define performance characteristics of the equipment
using the Equipment Tab on the Air System form.

o Ifelectric heat is used, no additional heating equipment inputs are required.

2. Plants. Plant equipment is not needed unless hot water or steam heating is used. In these cases a hot
water or steam plant must be defined and the split DX air system is linked to this plant. If the heating
plant serves multiple air systems, a single heating plant can be defined and all the air systems linked
to it.

3. Building. If heat pump, combustion or electric heat is used, the split DX air handler is linked directly
to the building. A multiplier can be used if the split DX unit represents one of a group of identical
units. If hot water or steam heating is used, then both the heating plant and the split DX air system
must be linked to the building.

6.7 SIMULATING CHILLED WATER AIR HANDLING UNITS

This section explains how to model chilled water air handling units in energy simulations. This
equipment includes fans, a chilled water cooling coil and heating apparatus in a packaged or built-up unit.
Heating options include electric resistance, combustion, hot water and steam. Modeling procedures are
described below.

1. Air Systems. Define one air system per chilled water air handler. Typically these are larger systems
which are unique. But in those situations where a building contains multiple chilled water AHUs
which are identical, serving identical or similar areas of the building, a single air handler can be
defined and a multiplier can be applied to account for the total number of these units. Modeling tips:

»  Specify the Equipment Class as "Chilled Water AHU"

« Specify the appropriate system type and enter system data.

o If combustion heating is used, define performance characteristics of the equipment using the
Equipment Tab on the Air System form.

o Ifelectric heat is used, no additional heating equipment inputs are required.

2. Plants. Define a chilled water plant to provide chilled water to the air handler cooling coils. Plant
options include chiller plants and remote chilled water (also known as district cooling). Typically the
chilled water plant will serve two or more air handlers. When defining the plant, link to all the air
systems served by the plant. When a system represents one of a group of identical systems, a
multiplier can be used when linking it to the plant.

If hot water or steam heating is used, define a hot water or steam plant to provide heating to air
handler heating coils. Plant options include boiler plants and remote (district) heating. Typically the
hot water or steam plant will serve two or more air handlers. When defining the plant, link to all the
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air systems served by the plant. A multiplier can be used if an air system represents one of a group of
identical systems.

3. Building. Link the chilled water AHU air system as well as the cooling plant and the heating plant (if
used) to the building.

6.8 SIMULATING PACKAGED OR SPLIT DX FAN COIL UNITS

This section explains how to model packaged or split DX fan coil units in energy simulations. This
equipment includes Packaged Terminal Air Conditioners (PTACs), Packaged Terminal Heat Pumps
(PTHPs), DX unit ventilators, room air conditioners, split DX fan coils, ductless split units and other
similar products. The packaged version of the equipment contains a supply fan, air-cooled DX cooling
apparatus and heating apparatus in one packaged unit. The split version of the equipment contains a
supply fan, DX cooling coil and heating apparatus in an indoor unit plus an outdoor condensing unit.
Heating options include electric resistance, combustion, heat pump, hot water and steam. Modeling
procedures are described below.

1. Air Systems. Define one air system for the entire collection of DX fan coil units. HAP will model
each zone in the system as containing one fan coil unit. Loads for each zone and the performance of
each zone's fan coil unit will be performed separately. Loads and energy use are then summed to
obtain system totals which are displayed on the simulation reports. Modeling tips:

o Specify the Equipment Class as "Terminal Units"

o Specify the System Type as "Packaged DX Fan Coil" or "Split DX Fan Coil" and enter system
data.

o Define performance characteristics of the DX cooling equipment using the Equipment Tab on the
Air System form. Be sure to define performance data for all zone fan coils.

« If heat pump or combustion heating is used, define performance characteristics of the equipment
using the Equipment Tab on the Air System form. Again, be sure to define performance for all
zones.

o Ifelectric heat is used, no additional heating equipment inputs are required.

o If the number of fan coil units exceeds the number of zones permitted in a system, then an
additional system will be required to accommodate the extra fan coils.

2. Plants. If heat pump, combustion or electric heat is used then no plant equipment is required. If hot
water or steam heating is used, a hot water or steam plant must be defined and must link to the fan
coil air system. If the heating plant serves multiple air systems, a single plant can be defined and
linked to all air systems containing hot water or steam coils.

3. Building. If electric resistance, heat pump or combustion heating is used, link the air system directly
to the building. If hot water or steam heating is used, link both the system and the plant to the
building.

Note: Fan coil systems are good candidates for the reduction techniques discussed in section 6.2.
However, if you use these techniques to reduce input and calculation time, planning is required to account
for the correct number of fan coil units in the building.

Example: A hotel is being studied which has 75 identical fan coil zones on the south face of the building,
62 identical fan coil zones on the north face of the building and 48 fan coil zones which are unique. In
this situation it may be best to define three air systems. System #1 would contain 48 zones holding the 48
fan coil units that are unique. System #2 would contain only one zone representing the typical south-
facing zone. System #3 would contain only one zone representing the typical north-facing zone. When
linking systems to the building a system multiplier of 1 would be used for system #1, a multiplier of 75
would be used for system #2 and a multiplier of 62 would be used for system #3. This is necessary
because multipliers are applied at the system level when linking systems to plants and buildings.

An alternate approach is to lump identical fan coils together rather than defining a single typical unit for
each. This means that the 75 south facing fan coil zones would be combined, using a space multiplier of
75. The cooling and heating equipment inputs would define full load capacity and input power values
that are the sum of the 75 fan coil capacities and input powers rather than the actual capacity and power
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for one representative unit. This approach would allow the typical north and typical south zones to be
included in System #1 with the 48 unique zones while still correctly accounting for the total loads and
energy use of these fan coil units.

6.9 SIMULATING HYDRONIC FAN COIL UNITS

This section explains how to model hydronic fan coil units in energy simulations. This equipment
contains a supply fan, a chilled water coil and a heating coil in one packaged indoor unit. Heating options
include hot water, steam and electric resistance. Modeling procedures are described below.

1. Air Systems. Define one air system for the entire collection of hydronic fan coils. HAP will model
each zone in the system as containing one fan coil unit. Loads for each zone and the performance of
each zone's fan coil unit will be performed separately. Loads and energy use are then summed to
obtain system totals which are displayed on the simulation reports. Modeling tips:

Specify the Equipment Class as "Terminal Units"

Specify the System Type as "2-Pipe Fan Coil" or "4-Pipe Fan Coil" and enter system data.

If electric heat is used, no additional heating equipment inputs are required.

If the number of fan coil units exceeds the number of zones permitted in a system, then an
additional system will be required to accommodate the extra fan coils.

2. Plants. Define a chilled water plant to provide chilled water to the fan coil units. Plant options
include chiller plants and remote chilled water (district cooling).

If hot water or steam heating is used, define a hot water or steam plant to provide heating to the fan
coil units. Plant options include boiler plants and remote (district) heating. If electric resistance
heating is used then no heating plant is required; electric heat energy use will be included in the air
system calculations.

3. Building. Link the hydronic fan coil system as well as the cooling plant and the heating plant (if
used) to the building.

Note: Fan coil systems are good candidates for the reduction techniques discussed in section 6.2. Please
refer to the note at the end of section 6.8 for a discussion of special considerations when reducing the
number of fan coil units modeled.

6.10 SIMULATING WATER SOURCE HEAT PUMP SYSTEMS

This section explains how to model water source heat pump (WSHP) systems in energy simulations.
These systems consist of a number of heat pump units connected to a common water loop. In a closed
loop system, heat is rejected from the loop through a cooling tower and heat is added by a hot water
boiler. In an open loop system, the water loop uses an open source such as well, river or lake water;
auxiliary heating is done by electric resistance heaters. Modeling procedures are described below.

1. Air Systems. Define one air system for the entire collection of WSHP units. HAP will model each
zone in the system as containing one WSHP unit. Loads for each zone and the performance of each
zone's WSHP will be performed separately. Interaction of the WSHP units via the common water
loop will also be analyzed. Loads and energy use for the individual WSHP units are then summed to
obtain system totals which are displayed on the simulation reports. Modeling tips:

o Specify the Equipment Class as "Terminal Units"

o Specify the System Type as "Water Source Heat Pumps" and enter system data.

o Define performance characteristics of the WSHP units for both cooling duty and heating duty
using the Equipment Tab on the Air System form. Be sure to define performance data for all
WSHP units.

» Also enter system information using the "Miscellaneous Equipment" button on the Equipment
tab. These inputs specify whether the system is closed loop or open loop, and allow a cooling
tower and boiler to be linked to the system.
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« When a common ventilation unit is used, it can be designated as a WSHP unit, or as an Air-
Cooled DX unit. When used, performance of the cooling and heating apparatus in the vent unit
must be defined using the Vent Cooling and Vent Heating buttons on the Equipment tab.

o If the number of WSHP units exceeds the number of zones permitted in a system, then an
additional system will be required to accommodate the extra WSHP units.

2. Plants. No plant needs to be defined for this type of equipment. All equipment energy use is
accounted for in air system calculations.

3. Building. Link the WSHP air system to the building.

Note: WSHP systems are good candidates for the reduction techniques discussed in section 6.2.
However, because all WSHP units in a single system are connected to a common loop, it important to use
a "lumping" technique to reduce the number of WSHP units modeled rather than modeling single
"typical" units.

Example: A hotel is being studied which has 30 identical WSHP zones on the south face of the building,
25 identical WSHP zones on the north face of the building and 28 WSHP zones which are unique. In this
situation it may be best to still define one air system so all 83 heat pump units can be connected to a
common water loop. The first 28 zones in the system could represent the WSHP zones which are unique.
Zone 29 would represent a combination of the 30 identical WSHP units in south facing rooms. This
means the full load capacity and input power for this WSHP unit would be the sum for the 30 identical
units. Also, the space multiplier for this zone would be 30. Finally, zone 30 would represent a
combination of the 25 identical WSHP units in north facing rooms. Its space multiplier would be 25.

If the alternate approach of defining one typical south room WSHP and one typical north room WSHP
had been used, these two WSHP units would have to be put into separate air systems so the total number
of WSHP units in the building could be accounted for using system multipliers when linking to the
building. But placing the WSHP units in separate systems disconnects them from the common water loop
used by the 28 unique WSHP units which invalidates the system analysis for the water loop. Therefore
modeling single "typical" units is not valid approach for analyzing WSHP loop systems.

6.11 SIMULATING CHILLED WATER PLANTS

This section explains how to model chilled water plants in energy simulations. The program simulates
two types of chilled water plants. In a chiller plant, a group of one or more chillers operate to provide
chilled water to cooling coils in one or more air handling unit or fan coil systems. In a remote chilled
water system, chilled water is supplied to air systems from an external source, such as a district cooling
system. Modeling procedures are described below.

1. Air Systems. Define one or more air systems containing chilled water cooling coils using the
procedures described in the previous sections.

2. Plants. Define a chilled water plant serving these air systems. Modeling tips:

»  Specify the Plant Type as "Chiller Plant" or "Remote Chilled Water".

o  Chillers and cooling towers (if used) should be defined prior to entering data for a chiller plant.

« If steam absorption chillers are used, users have a choice of modeling a boiler to generate steam
for the chillers, or using steam from a remote source such as waste steam. When using a boiler, it
must be defined prior to entering data for the chiller plant.

o Use the Systems tab in the Plant form to link the plant to the set of air systems in the building
which use chilled water cooling coils. The plant will serve the combined load of all these cooling
coils.

» For chiller plants, use the Configuration tab in the Plant form to define the configuration and
control of the plant. Use the Schedule of Equipment tab to link the necessary chillers, cooling
towers and boilers to the plant.

o For both types of chilled water plants use the Distribution Tab to define characteristics of the
chilled water distribution system and its pumps.
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3. Building. Link the chilled water plant to the building. This will include its energy use in energy cost
calculations.

6.12 SIMULATING HOT WATER AND STEAM PLANTS

This section explains how to model hot water and steam plants in energy simulations. The program
simulates two types of each heating plant. In a boiler plant, a boiler operates to provide hot water or
steam to heating coils in one or more air handling unit or fan coil systems. In a remote source plant, hot
water or steam is supplied to air system coils from an external source, such as a district heating system.
Modeling procedures are described below.

1. Air Systems. Define one or more air systems containing hot water or steam heating coils using the
procedures described in the previous sections.

2. Plants. Define a hot water plant or a steam plant serving these air systems. Modeling tips:

For hot water, specify the Plant Type as "Hot Water Boiler Plant" or "Remote Hot Water".

For steam, specify the Plant Type as "Steam Boiler Plant" or "Remote Steam".

Boilers should be defined prior to entering data for a boiler plant.

Use the Systems tab in the Plant form to link the plant to the set of air systems in the building

which use hot water heating coils or steam coils. The plant will serve the combined load of all

these heating coils.

o For boiler plants, use the Configuration tab in the Plant form to define link the boiler to the plant.

o For hot water plants use the Distribution tab to define characteristics of the hot water distribution
system and its pumps.

« For steam plants use the Distribution tab to define the pipe heat loss factor.

3. Building. Link the heating plant to the building. This will include its energy use in energy cost
calculations.

6.13 MODELING UTILITY RATE STRUCTURES

This section explains how to use the program to model utility rate structures in energy simulations. The
term "utility rate" refers to the pricing structure a utility uses when billing for electric energy use or fuel
use in a building. Utility rate data is used by HAP when calculating energy costs. HAP deals with two
distinct types of utility rates:

» Electric Rates define pricing structures for electric energy use and demand.

o Fuel Rates define the pricing structures for natural gas, fuel oil, propane, remote chilled water,
remote hot water and remote steam.

While data is defined in the program in two separate data categories (one for electric and one for fuel),
both types of utility rates use the same terminology and input items and the same application concepts.
The following discussions will use electric rates for examples, but the concepts apply equal to electric and
fuel rates.

6.13.1 Basic Concepts

Individual utility companies charge for energy use, fuel use and demand in widely different ways and use
vastly different terminology in stating their pricing structures. This presents a challenge for developing
one consistent approach to modeling utility rate structures in the program. HAP uses a modular approach
to meet this challenge. The program provides building blocks representing the common billing
mechanisms for energy, demand, demand determination and miscellaneous charges. The user is able to
pick and choose among these building blocks to assemble a utility rate model that best represents the
pricing structure used for their building.

The key elements in successfully using the utility rate modeling features in HAP are:

6-10
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1. Recognizing the separate billing mechanisms used in your utility rate structure and matching them to
the corresponding building blocks offered by HAP.

2. Understanding the common terminology used by HAP and relating this to the specific terminology
used by your utility company.

The following subsections discuss terminology and building blocks involved with the three common
components of a commercial building utility bill: energy or fuel charges, demand charges, demand
determination. Each subsection below will define terms, provide examples of the common billing
mechanisms and show examples of how data would be input in HAP. Further information on these
subjects can be found in the program's on-line help system in the sections dealing with utility rate inputs
and energy cost calculations.

6.13.2 Energy and Fuel Charges

An "energy charge" is the component of the electric bill that charges for energy consumption measured in
kWh. In a fuel bill, it is the component that charges for fuel consumption measured in units defined by
the utility. Nearly all utility rates include an energy or fuel charge; many include nothing but an energy
or fuel charge.

HAP is able to model the five most common types of energy and fuel charges. Ultility rates will never
refer to the charges using the names shown below. Instead these are simply descriptive names that are
handy when explaining the pricing structures. To decide which kind of energy or fuel charge you have,
match the charge defined on your utility rate sheet with one of the following.

Flat Price. This pricing structure uses a flat cost’/kWh price for all times, or specific periods such as
seasons or time-of-day periods.

Sample Utility Rate Statement:

All kWh during summer billing months ..............c............ 0.077 $/kWh
All kEWh during winter billing months.................c..c......... 0.049 $/kWh
Example: During one summer billing month 40000 kWh is used. The energy charge is calculated as:
kWh Range Block Size X Price = Cost
All 40000 kWh x  0.077$kWh = $3080
Total Energy Charge = $3080

Program Input: Use the "Standard" energy charge type. For fuel rates, all fuel charges are "standard".
Specify one step for each fixed price item. For this example, the inputs would be as follows. Note that in
HAP the energy or fuel quantity "9999999" is used to designate "all".

Season Period Block Size Block Units Price
Summer All 9999999 kWh 0.07700
Winter All 9999999 kWh 0.04900
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Declining Block. This pricing structure uses different energy or fuel prices for different "blocks" of
energy or fuel that are consumed. Generally the price declines with each succeeding block, hence the
name "declining block".

Sample Utility Rate Statement:

For the first 8000 kWh............cccccoovevivioioiiniiiincncnn, 0.101 $/kWh

Forthe next 15000 kWh........ccccocooviiiiioiiiiieiiieee 0.063 8/kWh

For all remaining kWh............ccccoovvevieveniiaieieiieeeenn 0.044 $/kWh

Example: During one billing month 40000 kWh is used. The energy charge is calculated as:

kWh Range Block Size X Price = Cost
1-8000 8000 kWh X 0.101 $kWh = $808
8001-23000 15000 kWh X 0.063 $kWh = $945
23001-40000 17000 kWh x  0.044$kWh = $748
Total Energy Charge = $2501

Program Input: Use the "Standard" energy charge type. For fuel rates, all fuel charges are "standard".

Specify one step for each block in the pricing structure. For this example, the inputs would be:

Season Period Block Size Block Units Price
All All 8000 kWh 0.101
All All 15000 kWh 0.063
All All 9999999 kWh 0.044

Demand Block. This pricing structure is the same as "Declining Block" above, except that the block
sizes vary each month based on the billing demand for that month. Therefore the block sizes have units
of energy/demand such as kWh/kW. In some cases the units are referred to as “hours use”. This pricing
structure is rarely seen for fuel charges

Sample Utility Rate Statement:

For the first 150 kWh/kW demand .....................c..co....... 0.085 $/kWh
For the next 100 kWh/kW demand............cccooovvvvenn.... 0.062 $/kWh
For all additional kWHh...........ccccoveeeiiiiiieeeiiiieieeeee 0.038 $/kWh

Example: During one billing month the billing demand is 200 kW and 60000 kWh is used. The energy
charge is calculated as:

kWh Range Block Size X Price = Cost
1-30000 30000 kWh x  0.085%kWh = $2550
30001-50000 20000 kWh X 0.062 $/kWh = $1240
50001-60000 10000 kWh X 0.038 $/kWh = $380
Total Energy Charge = $4170

Program Input: Use the "Standard" energy charge type. For fuel rates, all fuel charges are "standard".

Specify one step for each block in the pricing structure. For this example, the inputs would be:

Season Period Block Size Block Units Price
All All 150 kWh/kW 0.085
All All 100 kKWh/kW 0.062
All All 9999999 kWh/kW 0.038
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Mixed Block. The "Mixed Block" charge combines elements of both "Declining Block" and "Demand

Block".

It contains a mixture of blocks of fixed size and blocks with size varying based on billing

demand. Therefore, in an electric rate, some blocks have kWh units and others have units of KkWh/kW or
“hours use”. This pricing structure is sometimes used for electric energy charges but is uncommon for

fuel charges.

Sample Utility Rate Statement:
For the first 150 kWh/kW demand ...............ccccoceeeencnnn 0.075 $/kWh
For the next 15000 kWh.........ccccooovvoiiiieniiiieiiiiee 0.050 $/kWh
For the next 100 kWh/kW demand..................ccccocoen... 0.047 $/kWh
For all additional kWh...........ccc.cooovvviiiiniiiiiiiieee 0.042 $/kWh

Example: During one billing month the billing demand is 120 kW and 50000 kWh is used. The energy
charge is calculated as:

kWh Range Block Size X Price = Cost
1-18000 18000 kWh x  0.075%kWh = $1350
18001-33000 15000 kWh x  0.050 $/kWh $750
33001-45000 12000 kWh x  0.047 $/kWh = $564
45001-50000 5000 kWh x  0.042$kWh = $210
Total Energy Charge = $2874

Program Input: Use the "Standard" energy charge type. For fuel rates, all fuel charges are "standard".
Specify one step for each block in the pricing structure. For this example, the inputs would be:

Season Period Block Size Block Units Price
All All 150 kWh/kW 0.075
All All 15000 kWh 0.050
All All 100 kWh/kW 0.047
All All 9999999 kWh 0.042

Compound Block. The "Compound Block" charge uses a two-tier block structure shown in the example
below. The first tier contains demand blocks which are used with the billing demand each month to
establish a series of large energy blocks. These first tier blocks are subdivided into smaller energy blocks
each with a separate price. Compound Block charges are infrequently seen in electric rate structures.
They are currently not used for fuel charges.

Sample Utility Rate Statement:
For the first 125 kWh/kW demand

For the first 3000 kWh.......c..ccocovoveevieiacieiaeeenn. 0.087 $/kWh

For the next 87000 kWHh ......ccccvooeeeeeeeeeeieeeeeeeeeaa, 0.043 $/kWh

For the all additional kKWh ..........cccocvoveeveiieeeeeeean. 0.034 $/kWh
For the next 200 kWh/kW demand

For the first 6000 kKWh..........ccccooovveeieieicieiaaeennn. 0.060 $/kWh

For the next 85000 kWHh .......cccveveeeeeeeeeeieeeeeeeeee, 0.044 $/kWh

For the all additional kKkWh ...........ccccovveecciiiiiiiean. 0.042 $/kWh

For all over 325 kWh/kW demand

For all kKWh.....ccccocoviiiiiiiiiiiiiiiiiiie 0.039 $/kWh
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Example: During one billing month the billing demand is 500 kW and 200000 kWh is used. The energy

charge is calculated as:

kWh Range Block Size X Price = Cost
First 125 62500 kWh
kWh/kw
1-3000 3000 kWh 0.087 $kWh = $261.00
3001-62500 59500 kWh 0.043 $/kWh = $2558.50
Next 200 100000 kWh
kWh/kw
1-6000 6000 kWh x  0.060 $kWh = $360.00
6001-100000 94000 kWh 0.044 $/kWh = $4136.00
All Above 325 37500 kWh
kWh/kw
1-37500 37500 kWh x  0.039%kWh = $1462.50
Total Energy Charge = $8778.00

Program Input: Use the "Compound Block" energy charge type. Specify one step for each first tier and
second tier line item in the in the pricing structure. For this example, the inputs would be:

Block Type Season | Period Block Size Block Units Price
Demand All All 125 kWh/kW -
Energy All All 3000 kWh 0.087
Energy All All 87000 kWh 0.043
Energy All All 9999999 kWh 0.034
Demand All All 200 kWh/kW -
Energy All All 6000 kWh 0.060
Energy All All 95000 kWh 0.044
Energy All All 9999999 kWh 0.042
Demand All All 9999999 kWh/kW -
Energy All All 9999999 kWh 0.039

6.13.3 Demand Charges

A "demand charge" is imposed for the peak power use during a month rather than for total energy
consumption. Utility companies typically impose a demand charge in addition to the energy charge.
While nearly all electric and fuel rate structures contain an energy or fuel charge, only certain rates
include a demand charge. Demand charges are simpler than energy charges in that there are only two
types. Each is described below

Flat Price. This demand charge structure uses a flat cost/demand price for all times, or specific periods
such as seasons or time-of-day periods.

Sample Utility Rate Statement:

All kW of on-peak demand during summer months ........... 10.45 $/kwW
All kW of mid-peak demand during summer months ........... 8.65 $/kW
All kW of on-peak demand during winter months................ 7.40 $/kW
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Example: During one summer billing month the demand for on-peak hours is 370 kW and demand for
mid-peak hours is 207 kW. The demand charge is calculated as:

kW Range Block Size X Price = Cost
All 370 kW X 10.45 = $3866.50
All 207 kW X 8.65 = $1790.55
Total Demand Charge = $5657.05

Program Input: The number of steps entered in the demand charge is determined by the number of flat
price periods. In this example, three steps are required:

Season Period Block Size Block Units Price
Summer Peak 9999999 kW 10.45
Summer Mid-Peak 9999999 kW 8.65

Winter Peak 9999999 kW 7.40

Stepped. This pricing structure uses different demand prices for successive "blocks" of demand. This
pricing structure is similar to the declining block energy charge.

Sample Utility Rate Statement:

For the first 50 kW of billing demand............................... 10.18 $/kW
For the next 100 kW of billing demand................................ 7.00 $/kW
For all remaining billing demand...............c...c..ccccovvvunn.. 5.44 $/kw

Example: During one billing month the billing demand is 400 kW. The demand charge is calculated as:

kW Range Block Size X Price = Cost
1-50 50 kW X 10.18 $/kW = $509
51-150 100 kW X 7.00 $/kW = $700
151-400 250 kW X 5.44 $/kW = $1360
Total Demand Charge = $2569

Program Input: The number of steps entered in the demand charge is determined by the number of "steps"
or "blocks" in the demand charge. In this example, three steps are required:

Season Period Block Size Block Units Price
All All 50 kW 10.18
All All 100 kW 7.00
All All 9999999 kW 5.44

6.13.4 Demand Determination

Whenever demand charges or demand block energy charges are used in a rate structure, the peak demand
must be determined for each billing period. For electric rates the integrated power use over a 15, 30 or 60
minute period is typically used. For fuel rates, the peak hourly fuel consumption, or peak daily fuel
consumption is used. In the simplest cases the measured peak demand is used directly to compute the
demand charge. In other cases, however, the measured demand is adjusted by one or more clauses to
determine a "billing" demand used to calculate the charge. For example, some rate structures impose a
minimum demand clause. The billing demand is either the measured demand or the minimum demand,
whichever is larger.

Clauses used to derive "billing" demand from the measured demand are referred to as "Demand
Determination" clauses. Usually the utility rate sheet will include a "Demand Determination” section that
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spells out these clauses. In other cases the clauses are provided as fine print below the demand charge
statement

Each utility company defines clauses in different ways, but most fall into one of the following five
categories:

Minimum demand clauses

Rachet clauses

Trailing window clauses

Demand multiplier clauses

Power factor multiplier clauses (electric rates only).

Utilities will never refer to the clauses by these names. Instead, these are simple descriptive names that
make explaining the clauses easier. To determine which kind of demand clauses are used in your rate
structure, match the clause defined on your utility rate sheet with the following descriptions.

Minimum Demand Clause. Utilities often specify that billing demand may not be less than a certain
demand level.

Sample Demand Clause:

The billing demand shall be the larger of:
a. The maximum 30-minute integrated demand measured, or
b. 50 kWw.

Example: In a particular month the measured demand is 35 kW. Using the sample clause above, billing
demand would be determined as:

Measured Demand Minimum Demand Billing Demand
35kW 50 kW 50 kW

Program Input: To model this clause in HAP, select the Minimum Demand Clause option and specify the
minimum demand value.

Rachet Clause. A rachet clause introduces a penalty for large swings between monthly demands. The
key to recognizing the rachet clause is that it compares measured demands with a percentage of the
highest demand found during a fixed set of months.

Sample Demand Clause:

The billing demand shall be the larger of:
a. The maximum 30-minute integrated demand measured, or
b. 75% of the highest demand determined during the billing months of June through August

Example: The measured demand for November is 100 kW. The highest measured demand during the
months of July through August was 200 kW. Using the rachet clause above billing demand is determined
as follows:

Measured Demand Rachet Demand Billing Demand
100 kW 0.75x 200 = 150 kW 150 kW

Program Input: To model this clause in HAP select the Rachet Clause option and then specify the months
during which the rachet peak is determined ("peaking months"), the months in which the rachet applies
("Applies In") and the multiplier factor. For the sample rachet clause the following inputs would be used:

» Peaking months = June to August
o Applies in months = January to December
o Multiplier = 75%.
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Trailing Window Clause. A "trailing window" clause also introduces a penalty for large swings between
monthly demands. The key to recognizing the trailing window clause is that it compares the measured
demand in the current month with a percentage of the highest demand found within a series of preceding
months. This series of months is referred to as the "trailing window".

Sample Demand Clause:

The billing demand shall be the larger of:
a. The maximum 30-minute integrated demand measured, or
b. 50% of the highest demand measured during the preceding 6 months.

Example: The measured demand for November is 100 kW. The highest measured demand during the
previous 6 months was 250 kW in July. Using the trailing window clause above billing demand is
determined as follows:

Measured Demand Rachet Demand Billing Demand
100 kW 0.50 x 250 = 125 kW 125 kW

Program Input: To model this clause in HAP select the Trailing Window Clause option and then specify
the size of the trailing window and the multiplier factor. For the sample rachet clause the following
inputs would be used:

« Window = 6 months
«  Multiplier = 50%.

Demand Multiplier Clause. This clause provides a discount on demand measured during certain times
of day or times of year to encourage shifting of demand to those periods.

Sample Demand Clause:

Billing demand during the winter months shall be 60% of the maximum 30-minute integrated demand
measured.

Example: The measured peak demand for one of the winter billing months is 140 kW. Using the demand
multiplier clause shown above, the billing demand would be determined as follows:

Measured Demand Demand Multiplier Billing Demand
Adjustment
140 kW 140 kW x 0.60 = 84 kW 84 kW

Program Input: To model this clause in HAP, select the Demand Multiplier option and specify the
multiplier factor and the season and period in which the multiplier applies. For the example clause above
the inputs would be:

o  Multiplier = 60%
o Season = Winter
e Period = All

Power Factor Multiplier Clause. This clause introduces an indirect charge for excessive reactive power
use. It is only used in electric rate structures. Power used in alternating current circuits is classified as
"working" and "reactive". "Apparent" power is the vector sum of working and reactive power. Working
power can be measured by a wattmeter. Reactive power is used to generate the magnetic flux in inductive
machinery such as electric motors. It must be measured with separate metering equipment. Rather than
measure it directly, utilities sometimes spot check buildings and impose a penalty if reactive power use is
excessive. The reference value for the penalty is the "power factor" which is the ratio of working power
to apparent power and therefore indirectly indicates the magnitude of the reactive power component. The
lower the power factor, the larger the reactive power use.
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Sample Demand Clause:

Customers shall maintain a lagging power factor of 90% or higher. For each 1% by which the
average power factor lags below 90%, the demand charge shall be increased by 1%.

Example: For a certain month the measured peak demand is 200 kW. A spot check indicates the building
power factor is 80% lagging. Using the demand clause above, the building would be penalized by
increasing the demand charge by 1% for each 1% the power factor is below 90%, or a total of 10%.

Measured Demand Power Factor Multiplier Billing Demand
Adjustment
200 kW 200 kW x 1.10 =220 kW 220 kW

Program Input: To model this clause in HAP, select the Power Factor Multiplier option and then specify
the multiplier factor. For the example clause above the multiplier would be 110%.

HAP Quick Reference Guide



Appendix A Performing Common Tasks with HAP

This appendix describes procedures used to perform common tasks in HAP such as entering or editing
data and generating reports. This information may be useful for new users learning the program and for
occasional users who need a refresher on operating procedures.

While designing and analyzing HVAC systems with HAP, a common set of procedures is used to enter
data, modify data and generate reports. Using common procedures to operate the program makes the
program easier to learn and simpler to use. Whether you are working with walls, spaces or systems, for
example, the same basic procedures are used.

A. 1 BASIC PROCEDURES FOR PERFORMING COMMON TASKS

Common tasks such as entering, editing or deleting data use the same basic procedure which is explained
in this section. This basic procedure will be applied to each common task discussed in the subsequent
sections in this Appendix.

The procedure for performing many common tasks involves the following steps.

1. Select the Data Category by clicking on the desired item in the tree view panel on the left-hand side
of the HAP main window. For example, if you need to work with Space data, first click on the
"Space" item in the tree view panel. This will cause a list of spaces in your project to appear in the
list view panel on the right side of the HAP main window.

2. Select One or More Items from the list view panel on the HAP main window. For example, when
working with spaces, select one or more space items from the list of spaces in your project. There are
four ways to select items:

a. Selecting a Single Item - Click once on the name of the item you wish to select. The name will
be highlighted indicating is has been selected.

b. Selecting Multiple, Consecutive Items - While pressing the [Shift] key on the keyboard, click
on the name of the first and last items in the group you wish to select. The names of all items in
the group will be highlighted to indicate they are selected.

c. Selecting Multiple, Non-Consecutive Items - While pressing the [Ctrl] key on the keyboard,
click on the name of each item in the group you wish to select. Each name will be highlighted to
indicate it is selected.

d. Selecting All Items in the Category - Choose the Select All option on the Edit Menu (on the
menu bar). The names of all items shown in the list view will be highlighted indicating they are
selected.

3. Perform the Task on the selected items. Particular tasks such as entering or editing data can usually
be performed by several different methods. Users are free to choose the method that is most
convenient. These methods include the following. Which methods can be used for each task will be
explained in subsequent sections of this appendix.

a. Menu Bar. Often an option on the Edit Menu or Report Menu on the main window menu bar
can be used to perform the task.
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b.

Toolbar. In many cases one of the buttons on the main window toolbar can be used to perform
the task.

Item Pop-Up Menus. Right-clicking on the group of selected items will display the item pop-up
menu which usually will contain an option for performing the task.

Category Pop-Up Menus. Right-clicking on the selected category in the tree view panel will
display the category pop-up menu. Note that selecting an option on this pop-up menu will
perform the task on ALL items in the category, not just those currently selected. Therefore,
category pop-up menus should be used carefully.

Direct Use of the Keyboard. In some cases the keyboard keys can be used to directly perform a
task.

Special Features. There are also cases where special additional methods are provided for
performing tasks. These will be explained in the subsequent sections where they apply.

A.2 CREATING A NEW ITEM

There are three ways to create new items in HAP. The example below deals with wall data, but the
procedure can be used for any category of data in HAP. Simply substitute your category name for "wall"
in the following description.

To create a new wall item:

1. Select the Wall category in the tree view pane on the left side of the main window. A list of walls in
the project will appear in the right-hand list view pane.

2. Use one of the following three methods to create a new item.

a.
b.

C.

Select the "New Default..." item in the list view pane.

Right click on the Wall item in the tree view panel to display the category pop-up menu. Then
select the "New" option in this pop-up menu.

Use a special feature to create a new wall from within one of the program input forms. See
details below.

3. After creating the new wall, the input form will appear. Enter data for the wall and then press OK to
save the data and return to the HAP main window.

Special Feature. Certain categories of data can be created from within other input forms. For example,
while entering space data on the space form, you can create a new wall as follows:

1. While editing data in the Space Input Form on the “Walls, Windows Doors” tab, choose the “create
new wall” item in the wall drop-down list. The wall input form will then appear.

2. Enter the desired wall data including the wall name.

3. Click the OK button to save the wall and return to the space input form. When you return to the
space form, the wall you created will automatically be selected for use in the space.
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Note that this special feature can only be used to create the following kinds of new items:

While Entering Data You Can Create the Following

In the Following Form: | Kinds of New Data Items:

Spaces Schedules (Fractional)

Spaces Walls

Spaces Roofs

Spaces Windows

Spaces Doors

Spaces External Shading

Systems Schedules (Fractional)

Systems Schedules (Fan/Thermostat)

*Electric Rates Schedules (Time-Of-Day Utility Rate)
*Fuel Rates Schedules (Time-Of-Day Utility Rate)
*Buildings Schedules (Fractional)

*[tems marked with an asterisk are available in HAP but not HAP System Design Load.

A.3 EDITING AN EXISTING ITEM

There are three ways to edit existing items in HAP. The example below deals with editing an existing
schedule, but the procedure can be used for any category of data in HAP. Simply substitute your category
name for "schedule" in the following description.

To edit an existing schedule item:

1. Select the Schedule category in the tree view pane on the left side of the main window. A list of
schedules in the project will appear in the right-hand list view pane.

2. Use one of the following three methods to edit a schedule item.

a. Double-click on the schedule item in the list view pane.

b. Right-click on a schedule item in the list view pane to display its pop-up menu. Then select the
"Properties" item on this menu.

c. Use a special feature to edit an existing schedule from within one of the program input forms.
See details below.

3. After displaying the data to edit, make the necessary changes. Then press OK to save the changes
and return to the HAP main window.

Special Feature. Certain categories of data can be edited from within other input forms. For example,
while entering space data on the space form, you can edit data for any schedule linked to that space as
follows:

1. While editing data in the Space Input Form on the "Internals" tab, press the "Schedule" button next to
any one of the Schedule drop-down lists. The input form for the currently selected schedule will
appear and changes can be made to that schedule.

Make changes to the schedule.

Click the OK button to save the changes and return to the space input form.

bl
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Note that this special feature can only be used to edit the following kinds of items:

While Entering Data You Can Edit the Following

In the Following Form: | Kinds of New Data Items:

Spaces Schedules (Fractional)

Spaces Walls

Spaces Roofs

Spaces Windows

Spaces Doors

Spaces External Shading

Systems Schedules (Fractional)

Systems Schedules (Fan/Thermostat)

*Electric Rates Schedules (Time-Of-Day Utility Rate)
*Fuel Rates Schedules (Time-Of-Day Utility Rate)
*Buildings Schedules (Fractional)

*[tems marked with an asterisk are available in HAP but not HAP System Design Load.

A.4 USING THE ON-LINE CALCULATOR TO ENTER DATA

While entering data, you may encounter situations in which you don’t have data for an input item, but
you have related information. For example, when entering the space floor area you may know the length
and width of the floor but not its area. Rather than calculate the floor area by hand, you can use an
on-line calculator to calculate the value and insert it into the input item.

For HAP users, most numeric inputs in the energy analysis portions of the program (plants, buildings,
chillers, cooling towers, boilers, electric rates and fuel rates) provide an integrated on-line calculator. To
use this calculator, simply enter an equation followed by the equal sign. For example, if you want to
multiply 20 by 9, type the equation 20*9=. When you press the [=] key the equation will be calculated
and the result (180) will be inserted into the input item. The calculator recognizes the following
mathematical symbols:

o Multiplication: * Example: 20¥9=

o Division:/ Example: 100/5=

o Addition: + Example: 46.1+85.9=

o Subtraction: - Example: 100-84=

In addition, compound equations can be entered if necessary. For example: 100-9*8+12=

For both HAP and HAP System Design Load users, the system design portions of the program (weather,
spaces, systems, walls, roofs, windows, doors, external shades) do not yet offer this integrated on-line
calculator feature. Until these portions can be upgraded to include the integrated calculator, the Windows
On-Line Calculator must be used instead. The following example illustrates how to use the Windows
calculator.

Example: You need to enter the floor area for a space, but you only know the floor dimensions are 17 ft
by 32 ft. The Windows Calculator can be used to compute the floor area and then insert it into HAP as
follows:

1. Start the Windows Calculator: From the Windows desktop, press Start. On the Start Menu choose
Programs. On the Programs Menu choose Accessories. On the Accessories Menu choose Calculator.
If you don’t need the calculator right away, minimize the Calculator window by pressing the
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minimize button on the Calculator title bar. The calculator will be available for use whenever you
need it.

The Windows Calculator is a program supplied with the Windows operating system. For typical
Windows installations it is placed in the Accessories program group.

2. While running HAP and entering space data, display the Calculator by pressing the Calculator button
that appears on your taskbar. The Calculator will appear.

3 Calculate the floor area by pressing the calculator keypad buttons for the equation 17 * 32 = . The
result (544) will appear in the calculator display.

4. Copy the result to the clipboard: Choose the Edit option in the Calculator menu bar. Then choose the
Copy option on the Edit Menu. This copies the result of your equation (544) to the Windows
clipboard.

5. Return to HAP and place the cursor in the floor area text box by clicking once on this text box so the
default floor area is highlighted.

6. Finally, on your keyboard, hold the [Shift] key down and press [Ins]. This inserts the contents of the
Windows clipboard into the input field. The value 544 will appear as your floor area, replacing the
previous floor area value.

A.5 DUPLICATING AN EXISTING ITEM

While entering data, it is often useful to create new items using defaults from an existing item. For
example, a series of spaces in a building might use the same wall and window constructions and the same
lighting levels and schedules. Defining this series of spaces with each new space based on the last
space’s data can yield a tremendous increase in productivity. You only need to change a handful of space
inputs for each successive space, rather than specifying every input item for each space.

The Duplicate feature in HAP is used for this purpose. For example, when you duplicate a space, a new
space is created using input data from the original space as defaults. Many readers will be familiar with
the Copy and Paste features commonly offered in Windows software. HAP’s Duplicate feature combines
Copy and Paste into one function. So in one step, Duplicate lets you make a copy of an item and paste it
into your project.

There are three ways to make a duplicate of an existing item in HAP. The example below deals with
duplicating an existing space, but the procedure can be used for any category of data in HAP. Simply
substitute your category name for "space" in the following description.

To duplicate an existing space:

1. Select the Space category in the tree view pane on the left side of the main window. A list of spaces
in the project will appear in the list view pane.

2. Select the desired space in the list view pane by clicking on it once.
3. Use one of the following three methods to duplicate a space:

a. Use the "Duplicate" option on the Edit Menu.

b. Press the "Duplicate” button on the Toolbar.

c. Right-click on the selected space item to display its pop-up menu. Then select the "Duplicate"
item on this menu.

4. After the space has been duplicated its data will be displayed in the space input form. Edit data as
necessary and then press OK to save the changes and return to the HAP main window.

A.6 COPYING ITEMS

Please see section A.5, Duplicating an Existing [tem.

HAP Quick Reference Guide A-5



Appendix A Performing_; Common Tasks with HAP

A.7 REPLACING SPACE DATA

During the course of a design project, specifications for the building sometimes change. For example, the
wall construction characteristics change or lighting levels are adjusted. In such a situation, its useful to be
able to globally change all space data rather than modifying the spaces one at a time.

The Replace feature in HAP is used for this purpose. For example, the Replace feature can be used to
change the overhead lighting wattage for 45 spaces all in one step. This provides a vast time savings over
modifying the 45 spaces one at a time. A Replace can be performed in two ways:

o The first is using a “search and replace” approach in which you define a “value to replace” and a
“replace with” value. For example, if “value to replace” is 2.0 W/sqft of overhead lighting, and
“replace with” is 1.8 W/sqft, the program will search for all occurrences of 2.0 W/sqft of overhead
lighting in the spaces you choose, and will replace these with 1.8 W/sqft.

o The second is using a “replace all” approach in which you only specify a “replace with” value; the
“value to replace” specification is left blank in this case. For example, if the “value to replace” is
blank and the “replace with” value is 1.8 W/sqft of overhead lighting, the program will replace all
overhead lighting inputs in the spaces you designate with 1.8 W/sqft, regardless of what the original
overhead lighting values are.

There are four methods for globally replacing space data in HAP. The example below deals with
changing the overhead lighting W/sqft in a group of spaces from 2.0 to 1.8. The same general procedure
can be used for replacing many other types of space input data.

1. Select the Space category in the tree view pane on the left side of the main window. A list of spaces
in the project will appear in the list view pane.

2. In the list view pane select the spaces whose data is to be modified
3. Use one of the following four methods to replace the data:

a. Use the "Replace" option on the Edit Menu.

b. Press the "Replace" button on the Toolbar.

c. Right-click on the group of selected spaces to display its pop-up menu. Then select the "Replace”
item on this menu.

d. Right-click on the Space category name in the tree view pane on the left side of the main window
to display the Space category pop-up menu. Then select the "Replace" option on this menu.
Note that this will apply changes to ALL spaces in the project, so this method should be used
carefully.

4. After the Replace option is selected, the Replace Data form will appear.

5. On the Internals tab of this form choose "Overhead Lighting W/sqft" as the category to be changed,
specify a "value to replace" of 2.0 and a "replace with" value of 1.8.

6. Then click on the OK button to run the search and replace process. The program will notify you of
the number of spaces searched and the number of items replaced before returning to the HAP main
window.

A.8 ROTATING SPACES

During the course of a design project, the orientation of the building is sometimes adjusted by the
architect. In such a situation, it is useful to be able to globally change the orientations of wall exposures
and roof exposures in all your spaces rather than modifying the spaces one at a time.

The Rotate feature in HAP is used for this purpose. For example, suppose a building contains 100 spaces.
Midway through the design process, the architect changes the building orientation by shifting it 45
degrees clockwise. The rotate feature can be used to adjust the wall and roof orientations in one step.
This provides a vast time savings over modifying the 100 spaces one at a time.
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There are four ways to rotate space data in HAP. The example below deals with rotating the orientation
of wall and roof exposures by 45 degrees clockwise. The same general procedure can be used for rotation
by other amounts.

1. Select the Space category in the tree view pane on the left side of the main window. A list of spaces
in the project will appear in the list view pane.

2. In the list view pane select the spaces to be rotated.
3. Use one of the following four methods to rotate the spaces:

a. Use the "Rotate" option on the Edit Menu.

b. Press the "Rotate" button on the Toolbar.

c. Right-click on the group of selected spaces to display its pop-up menu. Then select the "Rotate"
item on this menu.

d. Right-click on the Space category name in the tree view pane on the left side of the main window
to display the Space category pop-up menu. Then select the "Rotate" option on this menu. Note
that this will rotate ALL spaces in the project, so this method should be used carefully.

4. After the Rotate option is selected, the Rotate Data form will appear. On this form specify the
amount of rotation (45 degrees in this example). Then press the OK button to begin the rotation. The
program will report the number of wall and roof exposures that were rotated before returning to the
HAP main window.

A.9 DELETING ITEMS

There are five ways to delete existing items in HAP. The example below deals with deleting air systems,
but the procedure can be used for any category of data in HAP. Simply substitute your category name for
"system" in the following description. Note: If you ever accidentally delete data, you can often undo the
deletion. A paragraph at the end of this section explains how.

To delete two air systems from a project:

1. Select the System category in the tree view pane on the left side of the main window. A list of
systems in the project will appear in the list view pane.

2. In the list view pane select the two air systems to be deleted.
3. Use one of the following five methods to delete the air systems:

Press the Delete key on the keyboard.

Use the Delete option on the Edit Menu.

Use the Delete button on the Toolbar.

Right-click on the selected systems in the list view pane to display the item pop-up menu. Then
select the "Delete" item on this menu.

e. Right-click on the System category in the tree view pane to display the pop-up menu for the
system category. Then select the "Delete" item on this menu. Note that this will delete ALL
systems in the project, so this option should be used carefully.

oo

4. HAP will display a warning message listing the number of systems to be deleted and asking you to
confirm the deletion before it erases the data.

How to Undo Accidental Deletion of Data: When data is deleted, it is permanently erased from the
working copy of your project. However, if you ever mistakenly delete data and have not yet saved the
project, you can undo the deletion by re-opening the project. Use the Open option on the Project Menu.
When you choose the Open option, HAP will ask if you want to save changes to your current project data.
Make sure you DO NOT save the project data at this point. Then reopen the project. Data from your
most recent project/save will be restored. While this will successfully undo your accidental deletion of
data, any other changes you made to the project since the last project/save will also be lost.
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A.10 GENERATING INPUT DATA REPORTS

HAP provides four ways to print or view input data for your project. When printing data, it is sent
directly to your printer. When viewing data, information appears in the HAP Report Viewer. The
Viewer allows you to quickly browse the data. The Viewer also provides a button for printing the data.
Further information on the Report Viewer can be found in section A.16.

The example below deals with viewing or printing input data for a group of spaces, but the procedure can
be used for any category of data in HAP. Simply substitute your category name for "space" in the
following description.

To view or print input data for a group of spaces:

1. Select the Space category in the tree view pane on the left side of the main window. A list of spaces
in the project will appear in the list view pane.

2. In the list view pane select the spaces whose input data is to be viewed or printed.
3. Use one of the following four methods to view or print the input data:

a. Choose the "View Input Data" or "Print Input Data" options on the Reports Menu.

b. Press the "View Input Data" button on the Toolbar.

c. Right-click on the selected spaces in the list view pane to display the item pop-up menu. Then
select the "View Input Data" or "Print Input Data" option on this menu.

d. Right-click on the Space category in the tree view pane to display the pop-up menu for the space
category. Then select the "View Input Data" or "Print Input Data" option on this menu. Note that
this will view or print input data for ALL spaces, so this option should be used carefully.

A.11 GENERATING SYSTEM DESIGN REPORTS

System design reports provide information about loads and the required sizes of air system components
such as coils, fans, and supply terminals. HAP provides four ways to generate these reports, all utilizing
the same basic procedure.

1. Select the System category in the tree view pane on the left side of the main window. A list of
systems in the project will appear in the list view pane.

2. In the list view pane select the desired systems.
3. Use one of the following four methods to view or print system design reports:

a. Choose the "Print/View Design Data" option on the Reports Menu.

b. Press the "Print/View Design Data" button on the Toolbar.

c. Right-click on the selected systems in the list view pane to display the item pop-up menu. Then
select the "Print/View Design Data" option on this menu.

d. Right-click on the System category in the tree view pane to display the pop-up menu for the
system category. Then select the "Print/View Design Data" option on this menu. Note that this
will generate design reports for ALL systems in the project, so this option should be used
carefully.

4. The System Design Reports Selection dialog will appear. Select the reports to be generated.

5. To view the reports, press the Preview button on the System Design Reports dialog. If system design
calculations must be run before the reports can be generated, HAP will run these calculations
automatically. If no calculations are needed, the reports will be displayed immediately. Reports are
displayed in the HAP Report Viewer (see section A.16). After viewing the reports you can print the
reports by pressing the Print button on the Report Viewer. However, as explained in A.16, you print
one report document at a time from the Viewer. If you wish to print all reports in one batch, it is
more efficient to use the Print button on the System Design Reports dialog.
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6.

To print the reports directly, press the Print button on the System Design Reports dialog. If system
design calculations must be run before the reports can be generated, HAP will run these calculations
automatically. If no calculations are needed, the reports will be printed immediately.

A.12 GENERATING PLANT DESIGN REPORTS

Plant design reports provide sizing information for chiller plants and boiler plants. HAP provides four
ways to generate these reports, all utilizing the same basic procedure.

1.

Select the Plant category in the tree view pane on the left side of the main window. A list of plants in
the project will appear in the list view pane.

In the list view pane select the desired plants.
Use one of the following four methods to view or print plant design reports:

a. Choose the "Print/View Design Data" option on the Reports Menu.

b. Press the "Print/View Design Data" button on the Toolbar.

c. Right-click on the selected plants in the list view pane to display the item pop-up menu. Then
select the "Print/View Design Data" option on this menu.

d. Right-click on the Plant category in the tree view pane to display the pop-up menu for the plant
category. Then select the "Print/View Design Data" option on this menu. Note that this will
generate design reports for ALL plants in the project, so this option should be used carefully.

The Plant Design Reports Selection dialog will appear. Select the reports to be generated.

To view the reports, press the Preview button on the Plant Design Reports dialog. If plant or system
design calculations must be run before the reports can be generated, HAP will run these calculations
automatically. If no calculations are needed, the reports will be displayed immediately. Reports are
displayed in the HAP Report Viewer (see section A.16). After viewing the reports you can print the
reports by pressing the Print button on the Report Viewer. However, as explained in A.16, you print
one report document at a time from the Viewer. If you wish to print all reports in one batch, it is
more efficient to use the Print button on the Plant Design Reports dialog.

To print the reports directly, press the Print button on the Plant Design Reports dialog. If plant or
system design calculations must be run before the reports can be generated, HAP will run these
calculations automatically. If no calculations are needed, the reports will be printed immediately.

A.13 GENERATING SYSTEM SIMULATION REPORTS

System simulation reports provide information about system operation and energy use during a typical
year. These reports are offered in HAP but not HAP System Design Load. HAP provides four ways to
generate these reports, all utilizing the same basic procedure.

1.

4,

Select the System category in the tree view pane on the left side of the main window. A list of
systems in the project will appear in the list view pane.

In the list view pane select the desired systems.
Use one of the following four methods to view or print system simulation reports:

a. Choose the "Print/View Simulation Data" option on the Reports Menu.

b. Press the "Print/View Simulation Data" button on the Toolbar.

c. Right-click on the selected systems in the list view pane to display the item pop-up menu. Then
select the "Print/View Simulation Data" option on this menu.

d. Right-click on the System category in the tree view pane to display the pop-up menu for the
system category. Then select the "Print/View Simulation Data" option on this menu. Note that
this will generate simulation reports for ALL systems in the project, so this option should be used
carefully.

The System Simulation Reports Selection dialog will appear. Select the reports to be generated.
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5.

To view the reports, press the Preview button on the System Simulation Reports dialog. If system
calculations must be run before the reports can be generated, HAP will run these calculations
automatically. If no calculations are needed, the reports will be displayed immediately. Reports are
displayed in the HAP Report Viewer (see section A.16). After viewing the reports you can print the
reports by pressing the Print button on the Report Viewer. However, as explained in A.16, you print
one report document at a time from the Viewer. If you wish to print all reports in one batch, it is
more efficient to use the Print button on the System Simulation Reports dialog.

To print the reports directly, press the Print button on the System Simulation Reports dialog. If
system calculations must be run before the reports can be generated, HAP will run these calculations
automatically. If no calculations are needed, the reports will be printed immediately.

A.14 GENERATING PLANT SIMULATION REPORTS

Plant simulation reports provide information about plant operation and energy use during a typical year.
These reports are offered in HAP but not HAP System Design Load. HAP provides four ways to generate
these reports, all utilizing the same basic procedure.

1.

Select the Plant category in the tree view pane on the left side of the main window. A list of plants in
the project will appear in the list view pane.

In the list view pane select the desired plants.
Use one of the following four methods to view or print plant simulation reports:

a. Choose the "Print/View Simulation Data" option on the Reports Menu.

b. Press the "Print/View Simulation Data" button on the Toolbar.

c. Right-click on the selected plants in the list view pane to display the item pop-up menu. Then
select the "Print/View Simulation Data" option on this menu.

d. Right-click on the Plant category in the tree view pane to display the pop-up menu for the plant
category. Then select the "Print/View Simulation Data" option on this menu. Note that this will
generate simulation reports for ALL plants in the project, so this option should be used carefully.

The Plant Simulation Reports Selection dialog will appear. Select the reports to be generated.

To view the reports, press the Preview button on the Plant Simulation Reports dialog. If plant or
system calculations must be run before the reports can be generated, HAP will run these calculations
automatically. If no calculations are needed, the reports will be displayed immediately. Reports are
displayed in the HAP Report Viewer (see section A.16). After viewing the reports you can print the
reports by pressing the Print button on the Report Viewer. However, as explained in A.16, you print
one report document at a time from the Viewer. If you wish to print all reports in one batch, it is
more efficient to use the Print button on the Plant Simulation Reports dialog.

To print the reports directly, press the Print button on the Plant Simulation Reports dialog. If plant or
system calculations must be run before the reports can be generated, HAP will run these calculations
automatically. If no calculations are needed, the reports will be printed immediately.

A.15 GENERATING BUILDING SIMULATION REPORTS

Building simulation reports provide information about annual energy use and energy cost. These reports
are offered in HAP but not HAP System Design Load. HAP provides four ways to generate these reports,
all utilizing the same basic procedure.

L.

Select the Building category in the tree view pane on the left side of the main window. A list of
buildings in the project will appear in the list view pane.

In the list view pane select the desired buildings.
Use one of the following four methods to view or print building simulation reports:

a. Choose the "Print/View Simulation Data" option on the Reports Menu.

A-10
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b. Press the "Print/View Simulation Data" button on the Toolbar.

c. Right-click on the selected buildings in the list view pane to display the item pop-up menu. Then
select the "Print/View Simulation Data" option on this menu.

d. Right-click on the Building category in the tree view pane to display the pop-up menu for the
building category. Then select the "Print/View Simulation Data" option on this menu. Note that
this will generate simulation reports for ALL buildings in the project, so this option should be
used carefully.

4. The Building Simulation Reports Selection dialog will appear. Select the reports to be generated.

5. To view the reports, press the Preview button on the Building Simulation Reports dialog. If building,
plant or system calculations must be run before the reports can be generated, HAP will run these
calculations automatically. If no calculations are needed, the reports will be displayed immediately.
Reports are displayed in the HAP Report Viewer (see section A.16). After viewing the reports you
can print the reports by pressing the Print button on the Report Viewer. However, as explained in
A.16, you print one report document at a time from the Viewer. If you wish to print all reports in one
batch, it is more efficient to use the Print button on the Building Simulation Reports dialog.

6. To print the reports directly, press the Print button on the Building Simulation Reports dialog. If
building, plant or system calculations must be run before the reports can be generated, HAP will run
these calculations automatically. If no calculations are needed, the reports will be printed
immediately.

A.16 USING THE REPORT VIEWER

This section describes the features and operation of the HAP Reports Viewer. The Viewer is used to
display all input, design and simulation reports in HAP. It appears when you press the Preview button on
any of the Report Selection dialogs in the program.

Overview of Layout and Features. The Report Viewer consists of four key components.

1. The Title Bar appears across the top of the Report Viewer window. At the right-hand end of the title
bar is a close button which is used to close the viewer and return to the HAP main window.

2. The Menu Bar appears beneath the title bar. It contains two menus which provide options for
performing useful tasks with reports.

The first menu is the File Menu. Options on this menu are as follows:

« Save Report As is used to save the report as a disk file. Only the report document currently
visible in the viewer is saved. The report is saved in Rich Text Format (RTF). This option is
useful for incorporating report material in other documents. RTF files can be read by many
popular word processor programs.

o Print Setup is used to adjust settings for your default printer. This option is typically used prior
to printing a report.

o Print is used to print the report document that is currently visible.
« Exit is used to close the Report Viewer and return to the HAP main window.
The second menu is the Help Menu. It contains one option:

« How to Use the Report Viewer displays an overview help topic for the Viewer.
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3. The Toolbar appears beneath the menu bar. It contains buttons for performing useful tasks with the
reports. Many of these tasks are the same as provided by options on the Menu Bar. Working from
left to right across the toolbar the buttons perform the following functions:

« The Save Report As button serves the same function as the Save Report As option on the File
Menu, described above.

o The Print button prints the report document that is currently visible in the viewer.

o The Load Previous Report button is used to display the previous report in a batch of reports.

o The Load Next Report button is used to display the next report in a batch of reports.

e The Zoom In and Zoom Out buttons are used to enlarge or reduce the magnification for the
currently displayed page. Zoom In increases the magnification for the page. Zoom Out decreases
the magnification for the page.

4. The Report Viewing Area appears below the toolbar. It displays all pages for the current report.
Since only a portion of one page of the current report is visible at one time, you will need to use the
scroll bar or the [PgUp] and [PgDn] keys to view all portions of that page. You will also need to
scroll to view additional pages in the report if a report contains multiple pages.

Key Organizational Principles. In order to effectively use the Report Viewer it helps to understand how
the program organizes and displays reports. There are four key principles:

1. Each report is a separate document much like separate documents used by a word processor. To view
the contents of one report you will need to scroll or use the [PgUp] and [PgDn] keys to view the
contents of a single page and to view different pages in a multi-page report.
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When generating reports of input data, a single report document contains data for all items you
choose except when dealing with systems, plants and buildings. For these three exceptions, a
separate report document is generated for each item you choose.

Example #1: If you request an input data report for 5 schedules, data for all 5 will be placed in a
single report document.

Example #2: If you request an input data report for 3 air systems, data will be placed in three separate
report documents.

When generating weather, design and simulation reports, a separate report document is generated for
each report option you select.

Example #3: If you request the Air System Sizing Summary, Zone Sizing Summary and Air System
Design Load Summary reports, three separate report documents will be generated.

2. If you generate a group or "batch" of reports, each is a separate document. You must use the "Load
Next Report" and "Load Previous Report" buttons on the toolbar to move from one report document
to the next.

3. The "Print" option in the Report Viewer will only print the report document that is currently
displayed. Therefore if you have several reports in a batch and wish to print them all, you must print
them one by one in the Viewer. This is usually inefficient. Therefore, if you wish to print a group of
reports quickly, we recommend exiting the Viewer, regenerating the reports and pressing the "Print"
button on the Report Selection dialog rather than the "Preview" button. Or, when generating input
reports, choose the “Print Input Data” option rather than the “View Input Data” option.

4. The "Save Report As" option in the Report Viewer will only save the report document that is
currently displayed. If you wish to save multiple reports in a batch, you must display and save the
reports one by one.

A.17 CHANGING THE LIST VIEW FORMAT

The list view in the main program window provides a list of items, such as spaces, walls, roofs, etc.., that
you have entered and stored in your project. This list of items can be displayed in four different formats:
List, Details, Large Icons and Small Icons You can change from one format to another using options on
the View Menu and buttons on the toolbar. Each of the four list view formats is described below.

A. List Format

In List Format each item is shown as a small icon with the item name to the right of the icon. Items
are listed in a column format. Once items fill the first column, additional items are shown in a second
column. To switch to this list view format, choose the “List” option on the View Menu, or press the
“List” toolbar button.
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B. Details Format

In Details Format each item is shown as a small icon with the item name to the right of the icon.
Additional descriptive details are listed opposite the item, as shown in the following table. Items are
shown in column format. Once items fill the available display area, the list view must be scrolled to
display additional items. To switch to this list view format, choose the “Details” option on the View

Menu, or press the “Details” toolbar button.

Data Category Details Item #1: Details Item #2: Details Item #3:
Weather Design City Simulation City

Spaces Floor Area

Systems System Type Sizing Status Simulation Status
Plants Plant Type Sizing Status Simulation Status
*Buildings Simulation Status

Schedules Schedule Type

Walls Overall U-Value Overall Weight

Roofs Overall U-Value Overall Weight

Windows Overall U-Value Shade Coefficient

Doors Door U-Value Glass U-Value

Ext. Shading (none)

*Chillers Chiller Type Full Load Capacity

*Cooling Towers Cooling Tower Type

*Boilers Boiler Type Full Load Capacity

*Electric Rates (none)

*Fuel Rates (none)

*Items marked with an asterisk are available in HAP but not HAP System Design Load.

C. Large Icons Format

In Large Icon format, each item is shown as a large icon with the name positioned below the icon.
Items are listed in rows from left to right across the list view panel. Once icons fill the available
display area, the list view must be scrolled to view additional icons. To switch to Large Icon format,
choose the “Large Icons” option on the View Menu, or press the “Small Icons” toolbar button.

D. Small Icons Format

In Small Icon format, each item is shown as a small icon with the item name to the right of the icon.
Items are listed in rows from left to right across the list view panel. Once icons fill the available
display area, the list view must be scrolled to see additional items. To switch to Small Icon format,
choose the “Small Icons” option on the View Menu, or press the “Small Icons” toolbar button.
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A.18 SETTING USER OPTIONS

The Options item on the View Menu is used to assign a variety of settings influencing program operation.
When the Options item is selected, the Options form appears. This form contains two tabs.

A.18.1 General Tab
Y |

T Gen aI5| gtheertinnsl
—Measurement Units————— 1~ Toolbar and Statusbar
o Sl ¥ Show ToolTips
[+ Show Date
= 5l Metric ¥ Show Time

k. I Cancel Help

The General Tab contains the following settings:

o Measurement Units - Choose whether program input data and results are displayed using English
units or SI Metric units.

+ Show Tooltips - Tooltips are the small messages that appear when you position the mouse cursor
over toolbar buttons and various other portions of the main program window, or certain input forms.
Tooltips will be shown when this box is checked.

o Show Date - When this box is checked, the current date will be shown in the right-hand portion of
the status bar.

o Show Time - When this box is checked, the current time will be shown in the right-hand portion of
the status bar.
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A.18.2 Options Tab

s 5|

—Yalidation
v Audible beep on salidation emar

¥ Setbackaround colan bered an s alidation ermar

r Always show ermor message & require "0E" on
walidation error

— Operating kode

¥ Enable Enengy Analysiz Features

k., I Cancel Help

The Other Options Tab contains settings involving validation of input data. Also, for HAP users this
tab provides an option for switching the program from full HAP mode to HAP System Design mode and
vice versa.

Validation Options. Each time you enter a value on an input form, HAP checks the input value to make
sure it is within maximum and minimum limits. If it is not, HAP will inform you of the problem in a
number of ways: a beep, highlighting the input item and/or a message box. The settings on this tab
govern how problems are communicated. Typically, these settings are adjusted because a user finds the
audible signal, the highlighting or the message boxes to be distracting.

« Audible Beep on Validation Error - When this box is checked, HAP will beep when a problem with
an input value is found. When the box is not checked, there will be no audible signal when a problem
is found.

+ Set Background Color to Red On Validation Error - When this box is checked, HAP will display
the input item which exceeds maximum or minimum limits with a red background. When this box is
not checked, the item will not be highlighted in red.

« Always Show Error Message & Require “OK” on Validation Error - When this box is checked,
HAP will display a message box describing the problem. Example: “Value too high (max 32.00)”.
When the box is not checked, no message box will appear.”

Please note that any problems identified while you are entering data do not have to be corrected right
away. When you press the OK button to save your changes and exit from an input form, HAP rechecks
all the data on the form. If problems still exist, HAP will ask you to correct the problems before exiting
from the input form.

Switching HAP Modes. Users of HAP have the option of switching the program from full HAP mode to
HAP System Design mode and vice versa. Switching to HAP System Design mode turns off all of the
inputs and features for energy analysis. When using the program only for system design work, users may
find it more efficient to hide the unneeded energy analysis features from view. Users can switch between
operating modes at any time and for any project. For example, if you created a project while in HAP
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System Design mode you can later switch it to full HAP mode. All of the original project data will
remain. You will only have to supply the extra energy analysis data to run energy studies. Modes are
switched as follows:

o To switch to HAP System Design mode, uncheck the box for "Enable Energy Analysis Features".
o To switch to full HAP mode, check the box for "Enable Energy Analysis Features".

A.18.3 Command Buttons

Finally, the form contains three buttons in the lower right-hand corner:

o  Press the OK button to exit and apply any changes you’ve made to the settings.
o Press the Cancel button to exit without applying changes you’ve made to the settings.

»  Press the Help button to display information about the Options form and its input items.
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Appendix B Performing Common Project Mgt Tasks

This appendix describes procedures used to perform various project management tasks. As noted in
Chapter 1, a project is a container for data from HAP and other Carrier programs. HAP provides a wide
variety of options _for managing this data.

B.1 CREATING A NEW PROJECT

A new project is typically created when starting a design job. The project will serve as the container for
all your input and calculation data for the job. To create a new project:

Choose the New option on the Project Menu.

If changes to the current project have not yet been saved, HAP will ask you if you want to save the
current project before creating a new one.

Then a new “Untitled” project will be created. No data for this project will be permanently stored
until the first time you use the Save option on the Project Menu.

When you choose the Save option on the Project Menu, you’ll be asked to name the project.

B.2 OPENING AN EXISTING PROJECT

Before you can enter data, edit data and generate reports for an existing project, you first need to open the
project:

Choose the Open option on the Project Menu.

The Open Project dialog will appear. It contains a list of all existing projects arranged in alphabetical
order. Select the desired project from this list.

If changes to the current project have not yet been saved, HAP will ask you if you want to save the
current project before opening another one.

Then the project you selected will be loaded into memory. When you are returned to the HAP main
program window, data for the project you selected will be displayed.

B.3 SAVING A PROJECT

The Save option on the Project Menu is used to permanently store data you entered or changes you’ve
made to a project. While working with a project, its data is stored in temporary copies of the project data
files. Saving the project copies your new data and your modified data to permanent storage. To save a
project, simply choose the Save option on the Project Menu. Note that when you save a new project for
the first time, you will be asked to name the project. Thereafter, when you save the project data will be
saved under this project name automatically.

By default the program will save data under \E20-INPROJECTS in a folder whose name is the same as
the project name. Many users elect to accept this storage convention. However, for those who wish to
save the data elsewhere, the software provides a feature to save the project in any folder on any drive
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accessible to your computer. The only requirement is that when the project is first saved the storage
folder must be empty.

As a sound data management practice, we recommend saving the project periodically as you work with it.
If you ever need to undo a mistake you’ve made, you can re-open the project without saving it. This
restores the project data from your last project save, but any changes made since the last save will be lost.
If project data is saved frequently, undoing a mistake will only cause a small amount of data to be lost.

B.4 SAVING A PROJECT AS A NEW PROJECT

The Save As option on the Project Menu is used to store changes to your current project data in a new
project rather than the existing project. Typically this feature is used when making a copy of a project.
To save a project as a new project:

« First choose the Save As option on the Project Menu.

« You will be asked to specify a name for the new project. By default the project will be saved under
\E20-IIN\PROJECTS in a folder whose name is the same as the project name. However, users may
override this default and save the data in any other folder. The only requirement is that when the
project is first saved the folder must be empty.

+ HAP then saves your current project data in the new project folder and closes the old project. All
subsequent changes to project data and saving of project data will affect the new project you created.

B.5 DELETING A PROJECT

To delete a project:
« First, choose the Delete option on the Project Menu. The Delete Project dialog will appear.
o On the Delete Project dialog choose the project you wish to delete.

« HAP data files for the selected project will then be erased. If the project only contained HAP data,
the project itself will be erased. However, if the project contained data from other programs, the
project will remain in existence along with the data from these other programs.

Example: A project contains HAP and AHUBuilder data. You choose the Project/Delete option from
within HAP. Only the HAP data will be erased. The project will continue to exist and will contain
only data for AHUBuilder.

The Project/Delete option should be used with care. When project data is deleted it is permanently lost
and cannot be recovered.

B.6 EDITING PROJECT PROPERTIES

The Properties option on the Project Menu is used to enter or change the descriptive information for a
project. When this menu option is selected the Project Properties dialog appears. It contains the
descriptive items listed below. Of these the Project Name is the only item that must be defined since it is
used throughout HAP for various purposes. All of the other items are for the user’s own reference and
are therefore optional.

« Project Name: A reference name for the project. It appears on all HAP reports, in the title bar of the
HAP main program window and on selection lists when opening and deleting projects. It is important
to use a descriptive name for the project so you can easily determine what data the project contains.
Note that after a project has been saved for the first time its project name cannot be changed, except
by using the Save As option on the Project Menu.

o Job Number: A reference number for the project. Users often enter the internal billing number or
company reference number for the project here.

B-2

HAP Quick Reference Guide



Performing_; Common Project Management Tasks Appendix B

o Contact Type: An item that defines who the client for the project is: a contractor, owner, architect,
etc...

« Contact Name: The name of the client or a person in the client’s firm who is the contact for this
project.

o Salesperson: The name of the salesperson working with you on the project to supply HVAC
equipment information.

« Date: A significant date for the project. Some users specify the date the project was created. Others
specify the contract date or a delivery date.

« Notes: Notes concerning the status of the project or any other pertinent information.

Press the OK button on the Project Properties dialog to exit and save the changes you made. Press the
Cancel button on the Project Properties dialog to exit without saving changes.

B.7 ARCHIVING A PROJECT

The Archive option on the Project menu saves project data in one compressed file for safekeeping. A
project is typically archived when saving it for backup storage, for future reference, or when transferring
data from one computer to another. In order to archive data for a project:

« First open the project you wish to archive. When you choose the Archive option, HAP data for the
currently open project will be archived.

o Choose the Archive option on the Project Menu.

« You will then be asked to specify the name of the archive file and the destination drive and folder
where the archive file will be written. Use a descriptive name for the archive file so you will be able
to recognize it easily when you need to use it in the future. The destination folder you specify can be
on a hard disk drive or on removable media such as a zip drive or floppy disks. When using floppy
disks, it is helpful to have a set of formatted floppies ready. While the archive software will
automatically format disks, the archive runs faster if you use pre-formatted floppies. Once a file
name and folder has been specified, press the Save button.

o The program then compresses the HAP data files for the current project, placing the data in a single
ZIP-format file in the destination folder you specified. When archiving to floppy disks, the archive
file will be spanned across multiple floppies if this is necessary.

Note: Archiving data does not remove it from the project. It merely stores a copy of the data for
safekeeping. You can continue working with the current project data after it has been archived.

B.8 RETRIEVING A PROJECT

The Retrieve option on the Project menu restores data that was previously archived using the
Project/Archive option. The Archive option saves project data in one compressed file for safekeeping.
The Retrieve option uncompresses the archive data and makes it available for use again. A project is
typically retrieved when receiving archive data from another computer, when referring to an old project
that was archived for safekeeping, or when restoring backup data after a hard disk failure. In order to
retrieve data for a project:

« First create a new project or open the project you want to retrieve data into. Data is always retrieved
into the currently open project. Often users create a new project to receive retrieved data so existing
data will not be overwritten. For example, if the current project contains HAP data, when you
retrieve archived HAP data it will replace all of the current data. Thus, if you do not want to lose data
in the current project, you must create a new project before retrieving,.

o Choose the Retrieve option on the Project Menu. The program will display a dialog asking you to
identify the archive file you wish to retrieve data from.
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o Once a file is identified, the program will display its vital statistics. These statistics include the name
of the archived project and the data contained in the archive. You are asked to confirm that this is the
archive data you want to retrieve. Press the Retrieve button to begin retrieval, or the Browse button
to select a different archive file.

o The selected data will then be retrieved from the archive file and placed in the current project. When
you return to the HAP main program window, the HAP data you retrieved will be displayed.

B.9 RETRIEVING DATA FROM THE PREVIOUS VERSION

The Retrieve Previous Version options on the Project Menu are used to convert data from prior versions
of HAP for use in the current version. Typically these options are used when you started a project with a
previous version of HAP and want to complete the work using the new version. The procedure for
retrieving previous version data varies depending on whether the previous version is a DOS-based
program or a Windows-based program. Each procedure will be discussed below.

Retrieving When Previous Version is a DOS-Based Program. This scenario applies when retrieving
HAP v3.2 data into HAP v4.x, or when retrieving System Design Load v1.2 data into HAP v4.x. To
retrieve data:

o First, make sure the data you wish to retrieve has been loaded into a project folder for the DOS
program. For example, when retrieving from HAP v3.2, the data being retrieved must be stored in
one of the HAP v3.2 data folders. Note that it is not possible to retrieve data directly from a HAP
v3.2 archive file. The archive file must first be retrieved into a HAP v3.2 project folder.

» Next, while running HAP v4.x, open the project you want to retrieve data into. In many cases, users
will create a new project and retrieve data into this project to avoid overwriting and destroying data in
an existing project.

o Then choose the Retrieve From HAP v3.2 option on the Project Menu. A dialog will appear. It is
used to identify the data folder containing previous version data you want to retrieve. HAP v3.2 and
System Design Load v1.2 stored data in a rigid tree structure. Therefore, if you are looking for HAP
v3.2 data folders, they will be found beneath the \E20-INHAP32 folder. If you are looking for
System Design Load v1.2 data folders, they will be found beneath the \E20-IINSDL12 folder.

« Choose the data folder containing the data you wish to retrieve.

o Then the program retrieves data from the HAP v3.2 or System Design Load v1.2 data folder, converts
it to a format compatible with HAP v4.x and saves the data in the current project. When the
conversion is finished, the program displays a message indicating whether the data translation was
successful or failed. Press the Help button in this message window for further information about the
translation process and for tips on how to work with the data once it is available in the current version
of HAP.

Note that the following categories of data are retrieved from HAP v3.2 and System Design Load v1.2:
design weather, spaces, air systems, schedules, walls, roofs, windows, doors and external shades. The
following categories of data are not retrieved because of significant compatibility issues: simulation
weather data, calendar data, electric rates, fuel rates, plants and buildings.

« Finally, when you return to the HAP main program window, the data you retrieved will be displayed.

Retrieving When Previous Version is a Windows-Based Program. This scenario applies when
retrieving data from HAP v4.x into a subsequent version. In these scenarios, the previous version of HAP
is a Windows-based program which stores data in the standard project format.

» First, make sure the project containing data from the previous version of HAP exists on one of your
hard disk drives. Note that this data must be in an unarchived format. It is not possible to retrieve
data directly from an archive file.
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o Next, while running HAP, open the project you want to retrieve data into. In many cases, users will
create a new project and retrieve data into this project to avoid overwriting and destroying HAP data
in an existing project.

o Then choose the Retrieve From HAP v4.x option on the Project Menu. This will display a dialog
listing all active projects on your computer which contain data from the previous version of HAP.

» Choose the project containing the data you wish to retrieve.

o Then the program retrieves data from the project you selected, converts it to a format compatible with
HAP v4.x and saves the data in the current project. When the conversion is finished, the program
displays a message indicating whether the data translation was successful or failed. Press the Help
button in this message window for further information about the translation process and for tips on
how to work with the data once it is available in the current version of HAP. The help topic also
explains which categories of data are transferred from one version to the next in this process.

o Finally, when you are returned to the HAP main program window data you retrieved will be
displayed.

How Previous Version Data is Converted. When data from the previous version of HAP is converted
to be compatible with the current version, it is “translated” rather than “transferred”. It is important to
make a distinction between “translation” of data and “transfer” of data:

o “Data Transfer” refers to the simple, verbatim movement of data. The result of a data transfer is an
exact copy of the original data. No data is added, deleted or modified.

o The result of “Data Translation” is the original data with missing items added, unusable items
discarded and other items reorganized.

Fortunately translation of data from one version of HAP to the next preserves the vast majority of your
data. To view information about items adjusted during translation and about which categories of data are
converted, press the Help button in the status message window that appears at the end of the translation
process.

HAP Quick Reference Guide B-5



[This page has been left blank intentionally]



Appendix C

Index

Air Systems

Design Applications................... 5-1,5-2,5-3,5
Energy Applications .................. 6-1,6-3,6-5,6
Definition .......ccceeevveevveeeeneennnn. 1-2,1-4
Deleting Data .........cccoevevvvennnennne A-7
Duplicating Data.........c.ccceenueee. A-5
Editing Data .........ccoccvviveeenn, A-3
Entering Data..........cccoeeevveennen. 2-2,2-4, 3-8, 4-6, A-2
Input Data Report....................... A-8
System Design Reports.............. A-8
System Simulation Reports........ A-9
Application Information
Air Handlers.......c.cccoooeeniinnnnen. 5-3, 6-7
Boilers......ccooieiiiniiiiiiicee, 5-4, 6-10
Chillers.....ccccoveereninieicieeees 5-4, 6-9
DX Fan CoilS .....cceeeeveeeeriennnns 5-2,6-7
Energy Analysis.......c.cccccvveeunnnn. 1-3, 4-1, 6-1
Entering Data...........cccoeeevveennenn. 1-2, 1-4, 2-1, 2-3, 3-6, 4-4
Gathering Data.........cccccevevennnnnns 1-2,1-3,3-2,4
Generating Reports ...........c....... 1-3, 1-5, 2-3, 2-5, 3-8, 4-8
Hydronic Fan Coils.................... 5-2, 6-8
Packaged DX Equipment........... 5-1, 5-3, 6-5
Selecting Equipment................... 1-3, 3-9
Single-Zone Units.........c.ccee...... 5-1
Split DX Equipment................... 5-1, 5-3, 6-6, 6-7
System Design .........ccceevvvennennee. 1-2, 3-1
Troubleshooting Strategies ........ 5-6, 6-3
Water Source Heat Pumps ......... 5-2, 6-8
Boilers
Applications........cceeeveeerveennnnns 5-4, 6-10
Deleting Data ........cccccevevveenennnne A-7
Duplicating Data.........c..cceeueee. A-5
Editing Data .........ccoccvveveeennns A-3
Entering Data.........ccceevveeennennns 2-4, A-2
Input Data Report...........c.cc........ A-8
Buildings
Definition ......cccceeeveecenenceeenne. 1-5
Deleting Data.......c.cccoevveveennenn. A-7
Duplicating Data......................... A-5
Editing Data.........ccccvvveveereennnn, A-3
Entering Data.......c..cccoeevverieennnns 2-5,4-7, A-2
Input Data Report........cceeenen. A-8
Simulation Reports..................... A-10

HAP Quick Reference Guide



Appendix C

Index

Calculator Feature ........................ A-4
Chillers
Applications........cceeeveeerveennenns 5-4, 6-9
Deleting Data ........ccccceveeveennnennne A-7
Duplicating Data.........c..cceeneee. A-5
Editing Data .........ccoocvveiveeenns A-3
Entering Data.........ccceevveennnnnns 2-4, A-2
Input Data Report............cc........ A-8
Common Program Tasks
Changing List View Format....... A-13
Changing Units of Measure ....... A-15
Copying Items...........ccccveeeneennee. A-5
Creating a New Item.................. A-2
Deleting an Existing Item .......... A-7
Duplicating an Existing Item..... A-5
Editing an Existing Item............ A-3
Enabling Energy Features.......... A-16
Generating Input Data Reports .. A-8
Generating Design Reports........ A-8, A-9
Generating Simulation Reports..A-9, A-10
OVEIVIEW..couveeiieniienieeieeeeene 1-1
Replacing Space Data................. A-6
Rotating Spaces........ccccccveveenenns A-6
Selecting Items in List View......A-1
Setting User Options.................. A-15
Using the Report Viewer ........... A-11
Cooling Towers
Deleting Data.......c.cccoevveveennenn. A-7
Duplicating Data......................... A-5
Editing Data.........ccccvveveeieennnns A-3
Entering Data.......c..cccveevverivenenns 2-4, A-2
Input Data Report........ccccenen. A-8
Doors
Deleting Data.........ccceeevveennnnnns A-7
Duplicating Data............ccueennen. A-5
Editing Data.........ccccvvvevvnieennnns A-3
Entering Data........ccccoevveveenens 2-1, 3-7, A-2
Input Data Report....................... A-8
Electric Rates
Applications.........cceeeveevreereennnnns 6-10
Deleting Data.......c..ccovevvereeennens A-7
Duplicating Data..........ccccuenen. A-5
Editing Data...........ccceeeeuvvennenns A-3
Entering Data.........ccoeevveennennne 2-5,4-6, A-2
Input Data Report.........cccceeenee. A-8
Energy Analysis
Example .......ccooovvvivniiiiiiien, 4-1
Procedure .........ccoocueeiiiiieniaenn, 1-3
| 0E] 010) 4 £ A-9, A-10
Tutorial......coccovevieninieiieee, 2-3

HAP Quick Reference Guide



Index

Appendix C

English Units...............cccoceinnn. A-15
Example Problems
Energy Analysis.......c.cccccveeeunnnn. 4-1
System Design ........cccccvveveennenne. 3-1
External Shades
Deleting Data.......c..cccveevverieennnnns A-7
Duplicating Data.........cccccueenen.. A-5
Editing Data ...........cccoeeevveennennns A-3
Entering Data.........ccceeeveennnenns 2-1,3-7, A-2
Input Data Report.........cccceueennee. A-8
Fuel Rates
Applications........cccceevvervenennnne. 6-10
Deleting Data.........cccceeeeeveennnnnns A-7
Duplicating Data............ccueennee. A-5
Editing Data.........ccccvvevvnvieennnns A-3
Entering Data ........ccccoevvereenen, 2-5,4-7, A-2
Input Data Report....................... A-8
Help System..........c....cccoeecvvrenneennnnn. 1-12
Program Operation
Input Forms........ccceoevvveeveennnnnns 1-9
List VIEW..ooooeiiiieiiiieeeeeeee 1-8, A-13
Main Program Window.............. 1-6
Menu Bar .......cccocevvecieeeiniieenns 1-6
Toolbar.......ccovevveerierierieiieeans 1-6
Tree VIEW ..ocoveeviiieieeeceee, 1-7
Plants
Applications..........cceeevrereeeenen. 5-4,6-9, 6-10
Definition .......cccceevvvevvvveeeneennnn, 1-3,1-4
Deleting Data .........cccceveeveennnennne A-7
Duplicating Data.........cccceeneee. A-5
Editing Data.........ccocceveiveeennn, A-3
Entering Data..........cccceeeevveennnnn. 2-2,2-4,2-5, A-2
Input Data Report.............cc........ A-8
Plant Design Reports.................. A-9
Plant Simulation Reports ........... A-10
Projects
ATChiVINg oo, B-3
Creating.....cccceveeveeneenvieenieenenn 2-1, 2-3, 3-6, 4-5, B-1
Data Management...................... 1-12
Definition .......ccceeeevecieeieenieeienn, 1-11
Deleting........ccocveveveeecieenveeeinenns B-2
Editing Properties ............cceu.... B-2
Opening........cccceeveerververcvennennns B-1
Retrieving.........ccoeevecveneeneennenn, B-3
Retrieving from Previous Vrsn..B-4
SAVING ..cvvveivecirieiieiee e B-1, B-2
Reports
Energy Analysis......c.cccoceveeenne. A-9, A-10
Input Data .......ccoceeeviiiniiiiiens A-8
System Design .........cccceeeeeveennen. A-8, A-9

HAP Quick Reference Guide



Appendix C Index

Roofs
Deleting Data .........cccceeeeveeennnnne A-7
Duplicating Data...........cccueenen. A-5
Editing Data.........ccccevvevvevreennnns A-3
Entering Data........ccccoeeveveenens 2-1,3-7, A-2
Input Data Report....................... A-8
Schedules
Deleting Data ........ccccvvevveenennnne A-7
Duplicating Data.........cccceeneee. A-5
Editing Data.........ccoccvvevenenn, A-3
Entering Data..........cccoeeevveennnen. 2-1, 2-3, 3-7, 3-8, 4-5, 4-6, A-2
Input Data Report.............c......... A-8
SI Metric Units..............cceeevvennnenns A-15
Spaces
Definition ........ceeevevvvceneieeeeeennn. 1-2,1-4
Deleting Data........c.cccoevveveeennen. A-7
Duplicating Data......................... A-5
Editing Data.........ccccvveveeieennnn, A-3
Entering Data.......c..cccveevverivenenns 2-1,3-7, A-2
Input Data Report........ccceneen. A-8
Replacing Space Data................. A-6
Rotating Space Data................... A-6
System Design
Example ......cccooevvveiieciiniieiienn, 3-1
Procedure .........cooovveeviiieiiinn, 1-2
Reports....cceveeveiiieieiieeeieeee A-8, A-9
Tutorial.......ccooveeeieiieieeeeee 2-1
Tutorials
Energy Analysis.......c.ccccverveenenne 2-3
System Design .........ccoceerveennenne. 2-1
Units of Measurement.................... A-15
Walls
Deleting Data .........cccceeevveennnnnne A-7
Duplicating Data............ccueenen. A-5
Editing Data.........ccccvvevveieennnns A-3
Entering Data........ccccoevveneenens 2-1, 3-7, A-2
Input Data Report..............c........ A-8
Weather Data
DefInition ........coovvvevevveeeeiinnnennne 1-2,1-4
Entering Data........cccccvvvvvrvennnn. 2-1, 2-3, 3-6, 4-5, A-2
Input Data Report........ccceeenee. A-8
Windows
Deleting Data ..........ccceeeeveennnnnn. A-7
Duplicating Data............ccueennee. A-5
Editing Data.........ccccvvevvnrieennnns A-3
Entering Data........ccccoeevereenens 2-1, 3-7, A-2
Input Data Report..............c........ A-8
Windows Software Basics .............. 1-13

C-4 HAP Quick Reference Guide



Appendix D Input Sheets

This appendix contains input sheets used to organize input data for spaces. Four different input sheets are
provided which are useful for different applications:

1. Standard Space Input Sheet - English Units - (3 pages) - This sheet provides entries for all possible
space inputs. Input prompts and headings are provided using English Units. This sheet should be
used with the Quick input sheet is not detailed enough.

2. Quick Space Input Sheet - English Units - (1 page) - This is an abbreviated space input form that
fits on a single page. A shortened form is useful because it can be filled out faster and reduces the
volume of paper required when dealing with large numbers of spaces. This input form can be used as
long as:

The space contains no more than two wall exposures, each using one window type.
The space contains no more than one roof exposure.

The space does not contain partitions adjacent to unconditioned regions.

The floor type is “slab floor on grade” or “floor above unconditioned space”.

If a space does not meet these requirements, the standard space input sheet should be used instead of
the quick input sheet.

3. Standard Space Input Sheet - SI Metric Units - (3 pages) - Same as #1 but in SI Metric units.
4. Quick Space Input Sheet - SI Metric Units - (1 page) - Same as #2 but in SI Metric units.
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STANDARD SPACE INPUT SHEET

1 of 3 - ENGLISH UNITS

GENERAL
Name ......ccoovevvvvvvnenennn, :
Floor Area..................... : sqft
Avg Ceiling Height...... : ft
Building Weight........... : L M H or Ib/sqft
OVERHEAD LIGHTING PEOPLE
Fixture Type................. : Occupancy........ccueee... : sqft/per
Wattage .......cccveeeeveeneee. : Wi/sqft : people
: \\Y Activity Level .............. :
Ballast Multiplier ......... : Sensible .....covuveeeeeeee. : BTU/hr
Schedule......covuuuunnnn.... : Latent .cooeeeeeeeeeeeeeennnnnn, : BTU/hr
TASK LIGHTING Schedule.......ccouuueeeeee.... :
Wattage ......cocceeevneenne : W/sqft MISCELLANEOUS LOADS
: w Sensible......cvuuueeeeeneen. : BTU/hr
Schedule.......ccovuuuuennn.... : Sensible Schedule ........ :
ELECTRIC EQUIPMENT Latent .....eeeeeeeeeeeeeenennn. : BTU/hr
Wattage .....ccccvevvneenne : W/sqft Latent Schedule............ :
: w
Schedule.......cccuunn....... :
WALLS, WINDOWS, DOORS
Exposure Gross Window | Window Door Construction Types
Area 1 2 Quantity
(sqft) Quantity | Quantity
Wall.....cc.....i
Window 1.......:
Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:
Door................
Wall.....oooooni:
Window 1.......:
Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:
Door ...t
Wall....coounni
Window 1.......:
Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:
Door.....coeeeeunit

Lighting Fixture Types:
Recessed, Unvented
Recessed, Vented
Free-Hanging

User Defined

Seated At Rest (230 S, 120 L)
Office Work (245 S, 205 L)
Sedentary Work (280 S, 270 L)

People Activity Levels

Medium Work (295 S, 455 L)
Heavy Work (525 S,925 L)
Dancing (305 S, 545 L)
Athletics (710 S, 1090 L)




STANDARD SPACE INPUT SHEET

2 of 3 - ENGLISH UNITS

WALLS, WINDOWS, DOORS (continued)

Gross | Window | Window
Area 1 2
(sqft) | Quantity | Quantity

Exposure

Door
Quantity

Construction Types

Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:

Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:

Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:

ROOFS, SKYLIGHTS

Gross
Area

(sqft)

Exposure Slope

(deg)

Skylight
Qty

Construction Types

Roof................:
Skylight..........:

Roof..............
Skylight..........:

RoOOf.eeeeeeenii:
Skylight..........:

Roof....ccouunnnni:
Skylight..........:




STANDARD SPACE INPUT SHEET

3 of 3 - ENGLISH UNITS

INFILTRATION
CFM CFM/sqft Air Changes Per Hour
Design Cooling
Design Heating
Energy Analysis
Infiltration Occurs: Only When Fan Off All Hours
FLOORS
FLOOR ABOVE CONDITIONED SPACE SLAB FLOOR ON GRADE
(No Inputs) Floor Area.......ccceue. : sqft
Total floor U-value ...... :
TASK ABOVE UNCONDITIONED SPACE Exposed Perimeter ....... T H
Floor Area............c....... : sqft Edge Insulation Rvalue :
Total fl -value ...... :
Ugﬁond?%gi;;;p e . SLAB FLOOR BELOW GRADE
Ambient at Max Temp. : F Floor Area.........cccoeuee. : sqft
Uncond. Min. Temp......: F Exposed Perimeter ....... : ft
Ambient at Min Temp.. : F Total Floor U-value......:
Floor Depth................... : ft
Basement wall U-value :
Wall Insulation R-value:
Depth Wall Insulation... : ft
PARTITIONS
Type Ceiling Wall Ceiling Wall
Area (sqft)

Unconditioned Space Max Temperature (F)

Ambient at Space Max Temperature (F)

Unconditioned Space Min Temperature (F)

Ambient at Space Min Temperature (F)




QUICK SPACE INPUT SHEET

1 of 1 - ENGLISH UNITS

GENERAL
Name ......ccoovevvvvvvnenennn, :
Floor Area..................... : sqft
Avg Ceiling Height...... : ft
Building Weight........... : L M H or Ib/sqft
OVERHEAD LIGHTING PEOPLE
Fixture Type................. : Occupancy........ccueee... : sqft/per
Wattage .......cccveeeeveeneee. : Wi/sqft : people
: w Activity Level .............. :
Ballast Multiplier ......... : Sensible........ccccvveenneen. : BTU/hr
Schedule......covuuuunnnn.... : Latent .c..ooveeeeeeeeeeeennnnn, : BTU/hr
TASK LIGHTING Schedule.......ccouuueeeeee.... :
Wattage .......cocevveenennee : W/sqft MISCELLANEOUS LOADS
: w Sensible......cvuuueeeeeneen. : BTU/hr
Schedule.......ccovuuuuennn.... : Sensible Schedule ........ :
ELECTRIC EQUIPMENT Latent .....eeeeeeeeeeeeeenennn. : BTU/hr
Wattage .....c.cccevveenennne : W/sqft Latent Schedule............ :
: w
Schedule.......cccuunn....... :
Wall Gross | Window Door Construction Types
Exposure Area 1 Quantity
(sqft) Quantity
Wall.....c....i
Window 1.......:
Door................
Wall.....coooooi
Window 1.......:
Door ...t
Roof Gross Slope | Skylight Construction Types
Exposure Area (deg) Qty
(sqft)
Roof................:
Skylight..........:
INFILTRATION SLAB FLOOR ON GRADE
Design Cooling ............ : Floor Area.................... : sqft
Design Heating............. : Total floor U-value ...... :
Energy Analysis........... : Exposed Perimeter ....... : ft
Infiltration Occurs........ : Fan Off / All Hrs Edge Insulation Rvalue :

Lighting Fixture Types:
Recessed, Unvented

People Activity Levels
User Defined

Recessed, Vented

Free-Hanging

Seated At Rest (230 S, 120 L)
Office Work (245 S, 205 L)
Sedentary Work (280 S, 270 L)

Medium Work (295 S, 455 L)
Heavy Work (525 S,925 L)
Dancing (305 S, 545 L)
Athletics (710 S, 1090 L)




STANDARD SPACE INPUT SHEET

1 of 3 - SI METRIC UNITS

GENERAL
Name ......ccoovevvvvvvnenennn, :
Floor Area..................... : sqm
Avg Ceiling Height...... : m
Building Weight........... : L M H or kg/sqm
OVERHEAD LIGHTING PEOPLE
Fixture Type................. : Occupancy........ccueee.... . sqm/per
Wattage .......cccveeeeveeneee. : W/sqm people
: w Activity Level ..............
Ballast Multiplier ......... : Sensible........ccccvveenneen. : \W
Schedule......covuuuunnnn.... : Latent .cooeeeeeeeeeeeeeennnnnn, : w
TASK LIGHTING Schedule.......ccouuueeeeee.... :
Wattage .......cocevveenennee : W/sqm MISCELLANEOUS LOADS
: W Sensible......cvuuueeeeeneen. : W
Schedule.......ccovuuuuennn.... : Sensible Schedule ........ :
ELECTRIC EQUIPMENT Latent .c...ovueeeeeeeeeeennnnnn, : W
Wattage .....c.cccevveenennne : W/sqm Latent Schedule............ :
: w
Schedule.......cccuunn....... :
WALLS, WINDOWS, DOORS
Exposure Gross | Window | Window Door Construction Types
Area 1 2 Quantity
(sqm) Quantity | Quantity
Wall.....cc.....i
Window 1.......:
Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:
Door................
Wall.....oooooni:
Window 1.......:
Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:
Door ...t
Wall....coounni
Window 1.......:
Ext. Shade 1 ...:
Window 2
Ext. Shade 2 ..
Door.....coeeeeunit
Lighting Fixture Types: People Activity Levels
Recessed, Unvented User Defined Medium Work (86.5 S, 133.3 L)
Recessed, Vented Seated At Rest (67.4 S,35.2 L) Heavy Work (153.9 S,271.1L)
Free-Hanging Office Work (71.8 S, 60.1 L) Dancing (89.4 S, 159.7 L)

Sedentary Work (82.1 S, 79.1 L) Athletics (208.1 S, 319.4 L)




STANDARD SPACE INPUT SHEET

2 of 3 - SI METRIC UNITS

WALLS, WINDOWS, DOORS (continued)

Gross | Window | Window
Area 1 2
(sqm) | Quantity | Quantity

Exposure

Door
Quantity

Construction Types

Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:

Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:

Ext. Shade 1 ...:
Window 2.......:
Ext. Shade 2 ...:

ROOFS, SKYLIGHTS

Gross
Area

(sqm)

Exposure Slope

(deg)

Skylight
Qty

Construction Types

Roof................:
Skylight..........:

Roof..............
Skylight..........:

RoOOf.eeeeeeenii:
Skylight..........:

Roof....ccouunnnni:
Skylight..........:




STANDARD SPACE INPUT SHEET

3 of 3 - SI METRIC UNITS

INFILTRATION
L/s L/s/sqm Air Changes Per Hour
Design Cooling
Design Heating
Energy Analysis
Infiltration Occurs: Only When Fan Off All Hours
FLOORS
FLOOR ABOVE CONDITIONED SPACE SLAB FLOOR ON GRADE
(No Inputs) Floor Area.......ccceue. : sqm
Total floor U-value ...... :
TASK ABOVE UNCONDITIONED SPACE Exposed Perimeter ....... T m
Floor Area............c....... : sqm Edge Insulation Rvalue :
Total fl lue ...... :
Ugﬁond?%gi;;;p e c SLAB FLOOR BELOW GRADE
Ambient at Max Temp. : C Floor Area.........cccoeuee. : sqm
Uncond. Min. Temp..... C Exposed Perimeter ....... : m
Ambient at Min Temp.. : C Total Floor U-value......:
Floor Depth................... : m
Basement wall U-value :
Wall Insulation R-value:
Depth Wall Insulation... : m
PARTITIONS
Type Ceiling Wall Ceiling Wall
Area (sqm)

Unconditioned Space Max Temperature (C)

Ambient at Space Max Temperature (C)

Unconditioned Space Min Temperature (C)

Ambient at Space Min Temperature (C)




QUICK SPACE INPUT SHEET

1 of 1 - SI METRIC UNITS

GENERAL
Name.....ccocoeevviieninenns :
Floor Area..................... : sqm
Avg Ceiling Height...... : m
Building Weight........... : L M H or kg/sqm
OVERHEAD LIGHTING PEOPLE
Fixture Type................. : Occupancy........ccueee.... . sqm/per
Wattage .......cccveeeeveeneee. : W/sqm people
: w Activity Level ..............
Ballast Multiplier ......... : Sensible........ccccvveenneen. : \W
Schedule.........ccceenneeen. : Latent ......ccoooeevveeneennne. : W
TASK LIGHTING Schedule..........cccceenee. :
Wattage .......cocevveenennee : W/sqm MISCELLANEOUS LOADS
: w Sensible.........cccveenneee. : \W
Schedule............cc......... : Sensible Schedule ........ :
ELECTRIC EQUIPMENT Latent ......cccecveveveeennnne. : 'Y
Wattage .....c.cccevveenennne : W/sqm Latent Schedule............ :
: w
Schedule.........ccceeueneee :
Wall Gross | Window | Door Construction Types
Exposure Area 1 Quantity
(sqm) | Quantity
Wall............
Window 1.......:
Door...............:
Wall.............
Window 1.......:
Door ...............:
Roof Gross Slope | Skylight Construction Types
Exposure Area (deg) Qty
(sqm)
Roof...............
Skylight..........:
INFILTRATION SLAB FLOOR ON GRADE
Design Cooling ............ : Floor Area........c..c........ : sqm
Design Heating............. : Total floor U-value ...... :
Energy Analysis........... : Exposed Perimeter ....... : m
Infiltration Occurs........ : Fan Off / All Hrs Edge Insulation Rvalue :
Lighting Fixture Types: People Activity Levels
Recessed, Unvented User Defined Medium Work (86.5 S, 133.3 L)

Recessed, Vented
Free-Hanging

Seated At Rest (67.4 S,35.2 L)
Office Work (71.8 S, 60.1 L)
Sedentary Work (82.1 S, 79.1 L)

Heavy Work (153.9 S, 271.1 L)
Dancing (89.4 S, 159.7 L)
Athletics (208.1 S, 319.4 L)
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